
Hey, new folks! Read this first
New to TEN? Welcome aboard! Julie, our cruise director will be with you shortly…

You're just moments away from a whole slew of kick-butt multiplayer games over the Internet. But, 
how do you get on and play?

That's where this Help file comes in.

We'd love it if you read this whole file from cover to cover, but you're gamers. ("Documentation? We 
don't need no steenkin' documentation!") So, here are the basics—just click on a link for details about
that subject…

· What is the Total Entertainment Network? Here's the hype. You probably know it if you got this 
far.

· TEN's Terms of Service. Legal crap. It's the same stuff that you read in new user registration, 
here for your handy reference!

· TEN's Community Guidelines. All the TENetiquette you ever needed to know.

· Select a registration method and new user registration. If you haven't already signed on to 
TEN, here's what you should do.

· Signing on to TEN. The nitty-gritty. Your first step into a larger world.

· TEN's system requirements and game software & enabler files. You have to have the right 
equipment, and game software don't grow on trees!

· The     Game Selector  , Arena Selector and Game Arena screens. These three areas are where 
you're gonna spend most of your time. Live 'em and learn.

· Creating a game. Ah, the good stuff. It's all done from Game Arenas.

· Cancelling your account . If you really want to do the unthinkable, check here.

Technical questions must be handled through our Web site at http://www.ten.net/support. 
You can access it by going to the Support menu from within TEN and choosing "Send Support 
Question Via Web"



What's new in version 1.3.3?
Wizards and sorcerers of all types will love this new TEN update! With v1.3.3 of TEN, we've 
introduced two new exclusives to our service.

Magic: The Gathering from MicroProse is the official computer version of the worldwide popular 
collectible card game from Wizards of the Coast. With Magic: The Gathering and MicroProse's 
ManaLink software, you can play Magic on TEN...FOR FREE! Here are the system requirements you 
need and a brief intro to the Arena screen on TEN.

We also have another TEN-only game materializing on the scene. Wiz-War, the computer version of 
Tom Jolly's popular mini-board game is also available to play. This 2–4 person game pits crafty 
wizards against each other to grab treasure and defeat each other within a dark labyrinth. The game 
software is free for downloading from our Web site, and only requires the following system 
requirements. The create game screen is pretty straightforward as well.

Enjoy, mystic adventurer...

Miscellaneous junk
As usual, click these links if you want information on general system requirements, software you need
for certain games, and game creation screens for the various games on TEN.

Haven't been on in a while? What's wrong with you!?! Anyway, if you missed the previous version of 
our software (version 1.2), here's what was new. It's good to go over it just for safety's sake. Step to 
it.



What's new in version 1.2?
What's new in 1.2? Well, the whole look and feel, for one. If you're an experienced TEN person, you 
might just want to cruise through the following topics to get acquainted with the new schtuff. Of 
course, the best way to see what's new is to experiment while you're online!

· The Menu Bar: Belly up for a shot or two. This contains a global navigation system to other parts 
of TEN and replaces all functions of the old Support area. It's also the way you access this Help 
file.

· Page and Locate: With these nifty features you can have a private chat with another person on 
TEN and if you just need to find someone, use the Locate feature.

· E-mail, newsgroups and Web browsing: In version 1.2, everyone on TEN has their own e-mail 
address. You can also access TEN-specific newsgroups and surf the Web.

· New game creation abilities: Now, when you create a game, you're taken to a special "pre-
launch panel" before the game actually starts. Here, you can dismiss players and have a private 
chat with folks who've joined your game.

· Zone redesign: We still have same Zone structure, but instead of getting a specific Zone rating, 
we're categorizing them into Your Best Zone, Playable Zones and Chat-only Zones. Your Best 
Zone is the place where you'll get the best gameplay.

· News area on the Web: News@TEN has moved to more lavish digs! You'll still get the headlines 
from the Game Selector screen, but now you can just click MORE NEWS or pull down "News@TEN 
Web Site" from the Go menu to get complete details about TEN news, tournaments and other 
upcoming events.

· Pop-up help: Woo! (Well, it's a big deal to us.) Just hit the ? icon on any game screen or dialog 
box and then click on something to get instant pop-up help. Exciting, huh?



What is the Total Entertainment Network?
Well, if you really must know.

The Total Entertainment Network (a.k.a. TEN) is an Internet entertainment service providing quality 
content and high action to gamers everywhere.

What does it take to be part of TEN?

With your computer, a high-speed modem, this software and one or more of the games we support, 
you can sign on immediately. TEN allows you to use your own Internet service provider (ISP) to 
connect to our service, or use one of our local access numbers and let TEN do the work. Flexibility is 
our watchword.

Once on board, you'll see we support some of the hottest current games around: NASCAR Racing 2 
(in the NASCAR Racing Online Series), Myth: The Fallen Lords, Shadow Warrior, EF2000 V2.0, and 
Quake to name a few. We'll also have the inside scoop on new releases, including Quake II, Dark 
Reign and Falcon 4.0. Not to mention all our online-only exclusives like Twilight Lands, AD&D Dark 
Sun Online, Magic: The Gathering and Wiz-War. And there's much, much more to come.

TEN is devoted to provide you with the ultimate experience in multiplayer online gaming. We believe 
that there is nothing quite like the thrill of human competition. Defeating a computer opponent doesn't 
have nearly the satisfaction of creaming your pal across town (or across the country!). With the TEN 
service, our goal is to reduce latency (the bane of the Internet) to give you the quickest, cleanest, 
most immersive gameplay possible.

TEN is an Internet gaming service, made by and for gamers.

Welcome to the community.



TEN mutterings and philosophies
The evolution will not be televised.
The evolution of entertainment will happen right here,
on your computer screen.
If you've spent any time at all online, you've probably sensed something big happening at the 
crossroads where technology and society meet. You can feel it in the passion for MUDs and MOOs, 
hear it in the chat rooms and IRC channels of the Internet, see it in the sudden fascination with 
multiplayer games and the Web. Something new is evolving in the realm of information and 
entertainment.

The Total Entertainment Network (TEN) is a group of people who are a part of that evolution. We are 
a company of gamers, programmers, net surfers, and chat room junkies who have a sense for just 
how cool the online world could be. For over 12 years, we have been creating bulletin board systems,
playing games, and creating online gaming platforms—mucking about in the primordial ooze of a 
nascent medium. Now, we are developing the technology and ideas that will raise it to the next rung 
of the ladder.

Our initial goal is to become the best online gaming platform with the hottest multiplayer games 
around. Period. But supporting retail multiplayer games is only the starting point. We believe that 
everything we know about the online world today—games, chat spaces, e-mail, electronic publishing
—will change quickly and drastically, in ways that no one can predict. Whichever way it evolves, we 
will be there.

We also believe that YOU will be an essential force in this evolution. We are not a broadcasting 
company that feeds its users what the Nielson ratings say. We are not a magazine or newspaper 
handing down our editorial opinions from on high. We are an interactive medium, and "interactive" 
means you play a big role.

The beauty of the online world is that in our electronic space there is so little distance between 
publisher and reader, producer and consumer—us and you. We will be online playing games and in 
the chat spaces with you; we will be talking, listening, and learning as we all explore the possibilities 
of online entertainment.

And we want to take your participation one step further. As we grow, we want to give you the tools to 
build it yourself. We will give you the power to create experimental chat experiences, to design add-
ons to games, to publish your own ideas, and build your own worlds. The next best thing in online 
entertainment may not be handed to you, you may hand it to the world.

Something new is on the rise. A strange new beast is forming somewhere in the middle of games, 
people, tools, and technology. TEN will be there as it learns to crawl, walk, run, fly…



A brief history of TEN
The Total Entertainment Network was the result of a cataclysmic collision between two rising stars 
in the world of online entertainment: Planet Optigon and Outland, Inc.

Planet Optigon was formed by Daniel Goldman in 1990. A longtime bulletin board system (BBS) 
user and online fanatic, Goldman spent several years working with Maxis, porting Sim City and other 
popular titles to various platforms, before returning to his dreams of online world domination. Together
with designer Janice Linden-Reed, Goldman founded Planet Optigon and began developing a 
sophisticated, DOS-based service that would come to be known as the Total Entertainment Network 
(TEN).

Outland, Inc. was founded in 1991 by Three Guys From Palo Alto—Bill Lipa, Dave King and Alex 
Beltramo. The company specialized in developing tools for gaming across the Internet. In 1993, 
Outland established the Internet's first commercial gaming service, featuring the popular strategy 
game, Spaceward Ho!

In June of 1995, Planet Optigon and Outland were united in corporate matrimony. Together, they 
hatched plans for the conquest of cyberspace and began developing a Windows 95-based version of 
the network, which is what you see before you.

Late in September, 1996, we blasted onto the scene and instantly became the online gaming service 
leader—imitated, but never duplicated. One year later, we remain the games, community and 
features leader in the online gaming space.

We have tens of thousands of active members in our virtual community, and we'll continue to bring 
you the highest quality games and communication features. Welcome to the future...



TEN's Community Guidelines
We at TEN have one goal in life—to create the ultimate gaming hangout. That means getting the best
games, creating a fast network and doing the geewhiz techno stuff necessary to make games work 
on the Internet. It also means creating a gaming community where players can meet people with 
similar interests or skill levels, play hard, and have a good time. After all, who'd want to run a place 
where people ran into jerks, had a lousy time, and were miserable? Not us. And who'd pay to go 
there? Not you. That's what high school was for, and it was free. To make sure TEN is a place 
everybody wants to be a part of, we've put together some general community guidelines and a 
system to enforce them.

Since TEN is primarily a place for playing games, we've based our guidelines on the idea of 
sportsmanship, the traditional ideal of the good game player. We all know what makes good sports: 
they play fair, they're good losers (or at least restrained ones), and they don't pull a "high-n-mighty" bit
when they win. In general, being a good sport on TEN is no different than anywhere else, but the 
virtual life does present some unique situations that can pose problems to the uninitiated or careless. 
Here are some tips on how to avoid online faux pas and unsportsmanlike situations.

Virtual Sportsmanosity
Let the Score Tell the Tale: The best players are those that can beat the snot out of you in a game 
and shake your hand afterward (after wiping their hand, of course). They don't gloat after they've 
given a whuppin', and they don't make excuses when they get whupped. Sure, good-natured taunts 
and competitive BS can be a fun part of the game, but taunting another player and bragging after a 
win makes the winner look not unlike a jerk. On the flip side, if you lose and move on, you've got a 
healthy attitude; if you lose and gripe about it, well, you're just a noisy loser.

Keep Your Perspective: It's only a game! If you find yourself losing control, taking your gaming too 
seriously, and taking it out on other people, it might be time to take a walk, recite a mantra, take your 
Ritalin, clear your head…

Finish What You Start: You're likely to seriously cheese off someone if you quit in the middle of a 
long game because you have to take Foofoo for walkies or watch your fave 60s sitcom. (Just have 
Foofoo tape it; it'll take his mind off things.) Of course, quitting a game just because you're losing 
makes you not just a loser, but a total LUZ3R. If you must quit, let your opponent know before you do,
and officially resign or otherwise end the game so your opponent gets the win.

Play at Your Own Level: The best games are those played against players of equal skill. Wailing on 
new players might pump up an expert player's frail ego, but it doesn't make the expert any better, it's 
no fun for the rookie, and the expert comes off looking like a weasel. New players can help the 
fragile-of-ego avoid temptation by practicing with other new players before wandering into the 
veteran's areas.

Respect the Spirit of the Game: Some of the games on TEN have special codes of conduct and 
require special effort from their players. The point of role-playing games, for instance, is to don a 
persona and play a character in a fantasy setting—kinda like acting in a movie but without a script 
and a seven-digit salary. In these games it's considered bad form for someone to willfully behave 
"out-of-character" and destroy the fantasy vibe. This type of game often has its own guidelines, so be 
sure to read them before jumping in.

Be Careful Wit Dat Wit: Sarcasm and humor are the number one and two causes of "online 
violence." Sarcasm and humor rely heavily on linguistic subtleties like intonation, tone of voice, body 
language, and large red rubber noses, which don't come across in text. To avoid verbal spats and 
bruised feelings, make it clear when you're "just kidding." Little cues like the "smiley face" :-) or <g> 
for "grin" can be helpful here.

Apply the "Ripper" Rule: The anonymity of the online world can have a strange effect on people. 
Folks that are normally calm and civil in the "real world" often feel free to say things that would get 
their skull kicked in if said to someone at the local bar. To avoid problems, we suggest that you apply 
the "Ripper Rule" to your conversations. Before typing, ask yourself: "Would I say what I'm about to 



say to a burly 6'4" biker named 'Ripper' at the Bubbling Blood Saloon?" If the answer is, "Hell no! He'd
use my teeth for cue chalk!" then you'll want to express your thought another way. Remember: just 
because someone can't reach across the table and smack you online doesn't mean your actions have
no consequences.

Protect Yourself!: For you and your TEN account's safety, be very careful about giving out personal 
information online. If someone ever asks you for your account password, especially someone who 
claims to be a TEN employee, just say "no!" A real TEN employee will never ask for your password 
under any circumstance. And never give out personal information (real name, phone number or 
address) unless you know the person well and your conversation is private.

General Policies
Beyond the basic principles of good sportsmanship, we've also created some rules covering general 
conduct on TEN.

You Kiss Your Mother With That Mouth?: Curses, vulgarisms, obscenities and colorful 
exclamations are a part of many adults' vocabularies. We at TEN really don't have a problem with the 
occasional flurry of cussing (you can't live in the real world and feel otherwise). However, excessive, 
chronic vulgarity or obscenity offends some people and bores others. To ensure that players aren't 
put off by "dirty" language, we ask that players curb their tongue and avoid excessive obscenity in 
public chat spaces and game Arenas. We're a little more uptight about this when it comes to 
obscenity in "public" venues like game names and screen names, so please be extra careful there.

Hate Speech Just Ain't Cool: While we're moderately indulgent when it comes to colorful language, 
TEN has zero tolerance toward "hate speech." Hate speech is language that demeans, insults or 
otherwise attacks a person based upon his or her race, national origin, religion, sex or sexual 
orientation. Bigotry has no place on TEN (or anywhere else) and we'll have no patience for those who
use racist, sexist, or otherwise hateful language, even if meant in a "joking" way.

Harassment: Harassment is another type of misconduct for which we don't have patience. Online 
harassment can include many actions, such as: unsolicited sexual come-ons or innuendoes; personal
threats; "stalking" (continuously following a player around the service); and incessant, unprovoked 
insults or taunts in chat, paging, e-mail or newsgroups.

Cheaters Sometimes Win, But They're Always Losers: Cheaters suck, frankly. Cheating by 
hacking, misleading people, or exploiting loopholes in game or contest rules destroys the honest 
competitive atmosphere that we're trying to create on TEN, and cheapens the experience for the 
majority of people who play fair and square. Players who are found to be cheating may have their 
rankings wiped from the TEN rankings boards and will be disqualified from official TEN tournaments 
and contests. If players continue cheating after they've been warned, their account will be blocked 
and their screen names will be thrown into the stinky corner of Hell reserved for dishonest dillweeds.

Hacking: Although many people at TEN understand and appreciate the spirit of exploration in the 
"hacker ethic," we're not too keen on people monkeying with our computers and software. Hacking 
into our system, even if done without malicious intent, poses a serious threat to the community we're 
trying to build. Hackers will be booted from TEN as fast as you can type "#rm -rfi username".

Random Acts of Lameness: There are a bunch of other things we'd rather you not do. Things like 
"screen scrolling" (typing continuous streams of garbage text into chat rooms); intentionally disturbing
a chat Arena or tournament with inappropriate chat; taunting other players; and making fun of, or 
intentionally misleading, new players. Common sense stuff. Don't be a weenie and you'll avoid the 
roast.

Abuse of Power is the Biggest Crime: This isn't a rule for you—it's a rule for us, the employees and
Guides of TEN. We're very sensitive about power's tendency to be abused, and make it very clear to 
ourselves and our TENguides that we are all expected to deal with players fairly and communicate 
clearly, to the best of our ability. If you ever feel that you are being dealt with unfairly, arbitrarily, or 
abusively by a staff person, send e-mail to customersupport@ten.net and let us know.

Newsgroup and E-mail Policies



Aside from game arena chat, TEN's newsgroups and e-mail systems are the primary ways that TEN 
players exchange information and ideas. To ensure that our newsgroups and e-mail systems provide 
a quality experience, we ask that you follow these rules of the road.

Advertisements: There's enough advertising in the world—we don't need more in TEN's newsgroups
or e-mail. The posting or e-mailing of any advertisement or any other type of commercial solicitation is
a no-no. This includes "get-rich-quick" schemes, pyramid scams and other "marketing opportunities." 
TEN reserves the right to determine whether a post or e-mail constitutes an ad or solicitation.

Flames: Spirited debate between smart people can be one of the best things about newsgroups. 
Unfortunately, people sometimes cross the line between impassioned debate and petty, mean-spirited
personal attacks—otherwise known as "flames." In order to maintain some semblance of civility on 
our newsgroups, TEN reserves the right to delete or move posts if a flame-war should erupt. The 
General Policies apply to both newsgroups and e-mail, and abusive e-mails or posts are subject to 
the same restrictions. If you are victim of an abusive, harassing or otherwise bothersome e-mail or 
newsgroup posting, please send the text of the e-mail or post to customersupport@ten.net.

Cross-Posting and Spamming: "Cross-posting" consists of posting a message across several 
newsgroups (i.e., posting your "Kewl new Quake Website" announcement across the role-playing, 
strategy game and sheepdog-training newsgroups). Cross-posting creates a lot of clutter, and will 
invoke the ire of your fellow newsgroupies. Spamming is the malicious flooding of a newsgroup or e-
mail address with messages and is a no-no.

Copyrighted Material: Posting copyrighted text or software to any newsgroup, or exchanging such 
data via e-mail, without the explicit approval of the copyright holder is a violation of federal law and 
international treatise and is bad juju. Please don't feed the lawyers.

Impersonating Other Members: Impersonating another member or falsifying your screen name in a 
newsgroup post or in the address of an e-mail (or anywhere else for that matter) is also a no-no.

All of the other General Policies apply to our newsgroups and e-mail. These include our policies on 
harassment of other members, hate speech and use of excessive profanity.

Consequences of Naughtiness
If a player crosses the boundaries defined in these Guidelines, they can expect some combination of 
the following actions from TEN's Naughtiness Police:

1) If a TENguide or employee is present, the player may be given a warning. If the player's behavior 
is reported by other players, that report will be logged and the offending player "tagged" as 
someone to keep an eye on.

2) If the annoying player doesn't mellow out after being warned by a TENguide, or racks up a bunch 
of player complaints, the player will receive a letter from our Customer Service department via 
mail and/or e-mail. Note: We expect that the address on your account is valid and up-to-
date. If a letter is returned to us because of an invalid or outdated address, we may be 
forced to block an account until the account holder calls Customer Service and provides a
valid address.

3) If the player continues to be a pest after receiving a warning, the player's account may be 
blocked. Note that a blocked account is not a canceled account. When an account is blocked, a 
player will not be able to sign on to TEN, but the account will still exist and will continue to be 
charged until the player cancels the account from our Web site at 
http://www.ten.net/support. Why do we block and not cancel? When an account is 
canceled, it and any associated rankings and profiles are completely nuked and gone for good. 
Blocking an account gives a player one last chance to talk to our Customer Service team and 
convince them of the player's intention to stop the abusive behavior before the screen name and 
rankings are sent into the great digital beyond.

If the offense is extremely serious, TEN reserves the right to skip some of these steps and 
immediately block or cancel an account.



If You Have a Problem With a Player…
If you are annoyed by someone or are the victim of abusive behavior, we ask that you do a few things
to help us. First, if the behavior is simply annoying, do your best to avoid the annoyer. Use the 
"Muzzle" command to block the player's chat text (right-click on the player's screen name in the 
"Who's Here" list and select "Muzzle"). If you feel comfortable doing it, ask the player to stop what 
they're doing. If the player is cheating, refuse to play the player.

If the problem persists, find a Guide or TEN employee (they're usually in the Help Arenas—TEN 
employees have the word "TEN" in front of their name, and TENguides have the word "Guide" in front
of their name) and ask them to help. If you can, try to copy offending chat text from the screen (select 
the text with the mouse and hit Control-C) and send the text to Customer Service at 
customersupport@ten.net. If you have trouble copying the text, or the behavior is not made 
apparent in chat, report the problem as clearly as you can via e-mail.

If you have questions or comments about these guidelines, please send us e-mail at 
customersupport@ten.net. Thanks and good gaming!



TEN's Terms of Service
Total Entertainment Network ("TEN") Terms of Service Agreement
You should carefully read the terms of this Agreement. If you selected the “Accept” button (when first 
creating a TEN account), you indicated your acceptance of the terms of this Agreement and you 
subscribe to, or become a “Member” (defined below) of, the Total Entertainment Network service (the
“Service”) and may use the TEN software (the “Software”) under these terms. If you selected the 
“Do Not Accept” button (during TEN's new user registration), you may not become a Member of the 
Service or use the Software. 

1.Membership. By accepting the terms of this Agreement, you have become a Member of the 
Service with the privilege to use the Service and the obligations set forth in these terms. As a 
“Member,” you must be the person who authorizes his or her credit card account to be used to 
subscribe to the Service and you must be at least 18 years of age. As a parent or guardian of a minor
(i.e., someone under 18 years of age), you may authorize the minor to use your account, but the 
minor must act responsibly while on the Service and abide by the TEN Terms of Service and 
Community Guidelines.

2.License. As a Member, you may use the Software solely for purposes of accessing and using the 
Service. You may copy the Software in order to use the Software on more than one computer, to 
provide copies to another person (subject to acceptance of these terms by the other person) or to 
make backup copies, provided that you reproduce the copyright notice on any copy of the Software. 
You may not use, copy, modify or distribute the Software other than as set forth in this paragraph 2. 
You may not decompile, reverse engineer or disassemble the Software.

3.Ownership. TEN is the owner of the Service and the Software and the copyrights, trade secrets, 
patents and other intellectual property rights in the Software. 

4.Membership Requirements. Your membership in the Service and use of the Software are subject 
to following membership requirements, and your membership and license are subject to termination 
by TEN in its discretion (at any time and without notice) for violation of these terms:

(a) You must provide TEN with your full real name along with your current valid address and valid 
telephone numbers during the registration process.

(b) The Service is intended to be an enjoyable place for as many members as possible. To achieve
this goal, TEN has developed a set of Community Guidelines. You agree to cooperate with TEN in its 
efforts to create generally accepted standards for the Service and to comply with the Community 
Guidelines. TEN reserves the right to determine, in its sole discretion, the generally accepted 
standards for the Service and the Community Guidelines. 

(c) If you contribute any material (including level designs, mods and characters), you represent 
that all material you contribute to the Service does not violate anyone else’s rights (including 
copyright, trademark, privacy and publicity rights). Furthermore, you grant to TEN the nonexclusive 
right to use, copy, modify, distribute and otherwise make available the material in connection with the 
Service. 

(d) You will not disseminate material or engage in behavior on the Service that is obscene, 
abusive, deceptive, defamatory, hateful or otherwise inappropriate (as determined by TEN). 

(e) You will not engage in behavior which disrupts the performance of the Service or the 
experience of its members, including behavior such as hacking, cheating, impersonation, harassing, 
spamming, or spreading of computer viruses. 

(f) Your acknowledge that the Service is intended for an audience of 18 years of age or older. 
Certain games, editorial material provided by TEN, and materials created by TEN members (e.g., 
chat) may not be suitable for minors. If you permit minors to use your account, you will be responsible
for the minor's behavior on TEN and for any charges incurred by such minors. Furthermore, you 
acknowledge that TEN is not responsible for, and has no liability arising out of or related to, such 
minors' exposure to any material made available on the Service. As in most things, parental guidance



and responsibility is suggested and encouraged. 

5.Bills. You agree to pay TEN the charges for your subscription and use of the Service in accordance
with the terms set out in the Billing Information area (available by clicking on the icon on the New 
Account screen or, after enrollment, in the online Account Information area). TEN reserves the right to
modify the Billing Information at any time and the modifications will become effective immediately 
upon the posting by TEN of the modifications in the Billing Information area.

6.Telephone Charges. You are responsible for all phone charges incurred while you access the 
Service, including but not limited to long distance charges (and the determination of whether the dial-
in phone number you select is subject to local or long distance charges). Any disputes about phone 
charges are strictly between you and your telephone provider.

7.Modification of this Agreement. You understand and agree that TEN may modify this Agreement 
at any time and in any manner. Any modification is effective immediately upon posting on the Service.
By continuing to use of the Service following modification to this Agreement, you accept the 
modification. If any modification to this Agreement is not acceptable to you, you may immediately 
terminate your Membership as explained below.

8.Termination. You may terminate your membership at any time by notifying TEN by phone, TEN's 
online cancellation page on the Web at http://www.ten.net/support or U.S. mail; your 
termination will be effective once TEN has actually received the notice. TEN may terminate or 
suspend your membership in its discretion (at any time and without notice) if you breach any of the 
terms of this Agreement (including failure to act in accordance with the generally accepted standards 
established by TEN) or fail to make any payments when due or if any of the representations you 
make in this Agreement turn out to be false. You acknowledge that you will continue to incur charges 
even after you account is suspended, and you agree that you are responsible for all charges incurred 
up until the time termination is effective. 

9.Limited Warranty; Limitation of Remedies. 

THE SOFTWARE AND THE SERVICE ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. TEN 
DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE PROGRAM WILL MEET 
YOUR REQUIREMENTS OR THAT THE OPERATION OF THE PROGRAM OR OF THE SERVICE 
WILL BE UNINTERRUPTED OR ERROR-FREE.

IN NO EVENT WILL TEN BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING BUT NOT 
LIMITED TO ANY LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE OR THE SERVICE, EVEN IF TEN HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. IN NO EVENT WILL TEN BE 
LIABLE FOR ANY DAMAGES IN EXCESS OF THE STANDARD MONTHLY MEMBERSHIP FEE 
FOR THE SERVICE.

Some states do not allow the exclusion of implied warranties or the limitation or exclusion of liability 
for incidental or consequential damages, so the above exclusions may not apply to you.

10. General. This agreement is the complete and exclusive agreement between you and TEN and 
supersedes any proposal or prior agreement, oral or written, and any other communications between 
you an TEN relating to the subject matter hereof. This Agreement will be governed by the laws of the 
State of California.

BY USING THE SERVICE OR THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ 
AND UNDERSTAND THIS AGREEMENT AND AGREE TO BE BOUND BY ITS TERMS.

You may contact TEN at 500 Howard Street, Suite 400, San Francisco, CA    94105.



Da basics of TEN
TEN is pretty easy to get the hang of, but it might seem a little daunting at first. (I mean, jeez, look at 
all those help topics!) Here's an overview of all the sections in bite-sized, manageable chunks:

· Creating a TEN account: If you're reading this, you've probably already registered! If not, this'll 
give you all the info up front before you even get to the reg process. And as always, please feel 
free to pass this valuable info on to your friends, neighbors, pets, passing strangers…

· Entering and exiting TEN: How to sign on to the service, how to sign off and how to <shudder> 
uninstall the TEN software.

· Getting started on TEN: TEN's system requirements, what games we support and how to set 
them up.

· Bellying up to the Menu Bar: The delicious, all-you-can-eat feast. Get unlimited refills at this 
Menu Bar.

· Chatting, paging, surfing and more: Learn all about communications on TEN. Chatting, the 
Page and Locate features, profiles, rankings, e-mail and plenty more.

· Choosing a game to play (Game Selector screen): TEN's main screen. Here's how to choose 
games using our nifty Game Selector.

· Selecting a Zone and Arena (Arena Selector screen): Once you've picked a game, use the 
Arena Selector to pick a Zone and Arena.

· Playing games on TEN (Game Arena screen): The good stuff. Chat with your buds and start up
a new game in a Game Arena.

· Meeting Mr. Bandwidth: Our perennial mascot, Mr. B is there to explain the wonders of the TEN 
world.



Select a registration method
There are two ways you can connect to TEN to start registration:

1. Dial TEN's toll-free registration number. When you click on CONNECT, your modem will dial an 
800 number so you can register without paying for the call. After selecting this option, you will be 
prompted to choose one of our local access numbers for future connections to TEN.

NOTE: After the registration process, using one of our local access numbers to connect to TEN 
will incur a surcharge, so read the Billing Policy carefully.

2. Use my existing Internet connection. Use this method if you already have a connection to the 
Internet established, (i.e., via your own Internet service provider (ISP) or an Internet connection at
work). If you are using your own ISP to register, make sure you establish your connection before 
hitting the CONNECT button. 

After you've chosen one of the two registration methods, click the CONNECT button to begin the new 
user registration process. For more information on ways to connect to TEN, see the connection 
settings section of this file.

Important note: Once your account has been created, you can change your method of connection 
anytime by hitting the SETTINGS button on the Sign On screen.



New user registration
Registration for TEN takes place online to ensure that the latest pricing and product information is 
available. There are four steps involved in creating a new account:

1. Read Terms of Service. You must read and ACCEPT TEN's Terms of Service to establish a 
membership account on TEN. Declining the Terms of Service will cancel the registration process.

2. Enter Name and Address. Please enter all the information requested on this dialog box. Hit the 
Tab key to move between fields.

3. Select a Rate Plan. You can pay for TEN with any of these credit cards: Visa, MasterCard, 
Discover, and American Express. In addition to your credit card number and expiration date, we 
ask that you provide us with your name as it appears on your card, as well as your current billing 
address. We use an ultra-secure method for transmitting your account information, so never fear.

4. Create a Screen Name. The last part of the registration process involves creating a screen name
and password for your TEN account. Your screen name is the name by which you will be known 
to other TEN members online. (For example, joebob.) Follow these guidelines when creating a 
screen name:

· Your screen name must be at least 3 characters in length and no more than 10.

· Your screen name is not case sensitive (e.g., a screen name of JOEBOB is the same as joebob 
is the same as JOEbob, etc.).

· You can't use any spaces in your screen name.

· You can use any alpha-numeric characters, including the "_" symbol and the "-".

Exceptions:
· You can't use any spaces in your screen name.

· You also can't use "TEN", "Guide" or "Magna" as the beginning of your name.

· The first character of your name must be a letter (not a space, dash or number).

· Finally, you can't use a "-" character for the fourth character of your screen name.

Once you've got a name, you'll need to create a password for your account. Follow these guidelines 
when choosing a password:

· Your password must be at least 6 characters in length and no more than 10.

· Your password is CaSe sEnSiTiVe, so if part of it is in CAPITAL LETTERS, you've gotta type it in 
that way (e.g., a password of WONKEY is different than a password of wonkey).

· You can use any printable keyboard characters.

· We advise using a mix of numbers, letters, and funky symbols so you can't be hacked. 
Remember, your password is your responsibility. It's best not to give it out to anyone. We can't be
accountable for bills incurred with a hacked password. Make sure it's a difficult one to hack!

· Be sure your password won't be easy for others to guess. In other words, don't use your real 
name as a password, please.

When you're done, hit OK to cruise on over to the Sign On screen.



Signing on to TEN
Signing on to TEN is way easy.

Just type your screen name and password in the blanks, then hit CONNECT. (Make sure you don't 
have your Caps Lock key on when typing in your password—your password is case-sensitive.)

What? You haven't registered yet? What'cha waitin' for! Whack the NEW USER button.

If you've got other issues, click the pic below:



?-help
Once you click the ? button, clicking on anything else on this screen will pop up some instant help on that 
subject. For complete details, you'll probably want to review this Help file, though.



Screen Name
If your moniker is "joebob", type it in. Your screen name's not case-sensitive, so you can be joebob, JOEBOB, 
JoEbOb, whatever.

(TEN will remember your screen name for future sign-ons.)



Password
Type in your password here. Make sure your Caps Lock key isn't on, since the password is extremely case-
sensitive.



HELP
Brings up this Help file. And probably sticks you right here.



SETTINGS
Here, you can change the way you connect to TEN. You'll have already set this up in the registration process, but
if you need to make a change, this is the place. Check out the specifics on connection settings for complete 
information.

If you choose to use one of our local access numbers, pick a number from our list.

Remember, if you decide to connect through one of our local access numbers, you will incur an additional hourly
charge for use of the number. The Billing Policy has all the info. Check your Billing Policy once you sign on by 
going to the Support menu and choosing "Display Billing Policy" to get all the details.



NEW USER
If you've already registered, you don't need to click this. But feel free to point your friends here if they want to 
start their own TEN membership. They'll get to go through the account creation process.



CONNECT
If your name and password are correct, then go, man, go!



Connection settings
There are two different ways you can connect to TEN: through your own Internet service provider 
(ISP) or through one of TEN's local access numbers.

When you first select a registration method, you—wittingly or unwittingly—chose your default 
connection setting. If you chose "Dial TEN's toll-free registration number," you elected to use one of 
TEN's local access numbers to connect. If you chose "Use my existing Internet connection," you 
chose to connect via your own ISP. Don't worry, you're not stuck with this decision for life. You can 
change your connection setting by clicking the SETTINGS button on the Sign On screen.

Enough background. Here's some info.

Select one of TEN's local access numbers—This option allows you to use TEN's preferred ISP 
(Concentric Network) to make the connection to TEN. In general, this should provide a clean, reliable 
connection. When you click this option, you'll be prompted to select one of our local access numbers 
from a list. Choose the one nearest you.

If you're using our local access numbers, you'll probably want to choose one of our "!enhanced 
performance" numbers if one of those numbers is local to you. You should experience better 
gameplay when connecting through one of these numbers.

Important note: if you choose one of TEN's local access numbers to connect, you will incur additional 
charges to your account. Check out the billing information online from the Support menu by choosing 
"Display Billing Report."

Use my direct Internet connection—Select this option if you plan to use your own ISP (or direct 
connection from school or work) to connect to TEN. Make sure you have a quality ISP that provides 
reliable service! Remember, you must establish your Internet connection before signing on to TEN.

Note: If you use Concentric Network as your Internet service provider, you should chose this option. 
Concentric customers use the same quality for their dial-in numbers as we use for our local access 
numbers, so there's no reason for Concentric customers to use our local access numbers.



Signing off from TEN
Hey, wait! Don't leave.

But, if you must, get out of whatever game you're playing, go to the File menu and choose "Sign 
Off...". (You can also click on that little X in the upper right-hand corner of the window, but that would 
be telling!) You'll get a sign off confirmation and then you're gone.

Remember: if you're involved in a game, be sure to properly quit out of it so you don't mess up your 
score or get your online buds pissed at you in the process. So, show some consideration and exit 
quietly. Close the door before you leave.

We know you'll be back.



Uninstalling the TEN software
Now, why would you want to do that?

But, seriously. If you have a problem with the TEN and need to reinstall it from scratch, follow these 
directions:

1. Go to Start --> Programs --> TEN and select "Remove TEN."

2. Answer "Yes" to the dialog box that appears.

3. Once it finishes removing files <sniff, sniff>, open the Program Files folder on your hard drive and 
manually delete the folder "TEN". That'll remove all the rest of the necessary files.

It's really important to remove the TEN files in this way (rather than just tossing the TEN folder into 
the Recycle Bin), 'cause otherwise you'll upset stuff in the ever-fragile "program registry." That just 
might send the poor registry into a series of expensive counseling sessions!

And if you're really serious about terminating your membership to TEN, you'll need to visit our Web 
site at http://www.ten.net/support and hit the "How do I Cancel" link to avoid further 
charges to your account.



TEN's system requirements
Here are the system requirements you gotta have and the ones we highly recommend:

Minimum Recommended
Computer 80486 66MHz DX2 Pentium 90 (or higher)
Operating system Windows 95 Windows 95
RAM 8MB 16MB
Modem 14.4k bps 28.8k bps
Serial port 16550 UART 16550 UART
CD-ROM drive * Double speed Double speed (or faster)
Video card* 16-color 256-color

* A CD-ROM drive is only required if you are installing the TEN software from a CD-ROM, but may 
be necessary for any number of games supported by TEN. Check the system requirements in 
your game software package for more information. Same goes for the video card. If your game 
requires 256 colors, you gotta have it.

Additional system requirements
Each game on TEN also has its specific system requirements. These requirements are more 
stringent than when the game is played in single-player mode, because TEN and the game software 
must run at the same time. Check out the readme.txt file for the most up-to-date information (find it
under Start --> Programs --> TEN --> TEN Read Me).



Game software and enabler files
To play a game on TEN, you must either buy or download the supported version of that game and 
install that game to your hard drive as per the game publisher's instructions. Some games are 
exclusive to TEN, others are commercial products or shareware. In the future, TEN will even have 
some games built right into its software, so you won't have to do any work to get up and running on 
those puppies.

Occasionally, games on TEN need special software called "game enablers" or simply "enablers." 
These files are generally placed directly into the root directory of the game they're designed for. You 
can grab enabler files from the File menu by choosing "Download Files…" or from any game's 
DataSphere.

If you should ever move the game's files or directories, or install a new version of the game, you'll 
have to update the path to the game's executable or enabler file. To do this, go to the File menu and 
choose "Preferences... ". Once there, click the Games tab. From there, you'll need to hit the Browse 
button and find the location of the game executable or game enabler.

Game system requirements and install instructions
While the following list was complete when we created the Help file, it's ever-changing as we add 
more and more games. For the latest game system requirements and installation information, check 
out the readme.txt file that came with your TEN software.

Many game files and patches are available from the File menu by choosing "Download Files…". If 
you can't find what you need here, maybe it doesn't exist. Files can also be found on our Web-based 
DataSpheres by clicking the DataSpheres button on any TEN screen or from the Go menu by 
choosing "DataSpheres Web Site" (and then picking a game).

Warning! It's a really, really bad idea to install games in the TEN directory on your hard drive (c:\
Program Files\TEN). All files under the TEN directory are subject to eradication during a TEN 
upgrade.
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AD&D Dark Sun: Crimson Sands
System requirements:
· 486 66MHz

· 8MB RAM

· VLB or PCI SVGA video card

AD&D Dark Sun: Crimson Sands is a fantasy role-playing game set in TSR's Advanced Dungeons & 
Dragons world of Dark Sun. This game is a TEN online-only exclusive. You can purchase the game at
your local software store (you'll get some nifty stuff in the package) or you can download the latest 
version from either the File menu by choosing "Download Files…" or from the Dark Sun DataSphere. 
Watch out, it's HUGE!

The first time you play Dark Sun, you'll be asked to locate the mdark.exe file in your Dark Sun 
directory.

More info about   AD&D     Dark Sun: Crimson Sands  …  



Blood retail
System requirements:
· Pentium 75MHz

· 16MB RAM

In order to play the retail version of Blood on TEN, you'll need the latest retail version installed on 
your hard drive. (You can purchase Blood retail at your favorite software store.) You can download a 
patch to the latest version from either the File menu by choosing "Download Files... " or from the 
Blood DataSphere.

The first time you play the retail version of Blood, you'll be asked to locate the blood.exe file in your
retail Blood directory.

More info about creating and joining retail   Blood   games...   



Blood shareware
System requirements:
· Pentium 75MHz

· 16MB RAM

To play shareware Blood on TEN, you'll need the latest shareware version installed on your hard 
drive. You can download shareware Blood (or a patch to the latest version) from either the File menu 
by choosing "Download Files... " or from the Blood DataSphere.

The first time you play the shareware version of Blood, you'll be asked to locate the blood.exe file 
in your shareware Blood directory.

More info about creating and joining shareware   Blood   games...   



Command & Conquer
System requirements:
· 486 66MHz

· 12MB RAM

· VESA Local Bus (VLB) or PCI SVGA video card

First off, you must have the retail version of Command & Conquer already installed on your hard 
drive. You'll also need to download the Command & Conquer game enabler file ccrunme.exe (this is
the compressed form to save space) from either the File menu by choosing "Download Files…" or 
from the Command & Conquer DataSphere. Once downloaded and extracted, place the ccten.exe 
enabler in your Command & Conquer directory. Remember, you'll need to have a Command & 
Conquer CD in your CD-ROM drive. After that, you can hit the ground running.

The first time you play Command & Conquer, you'll be asked to locate the ccten.exe game enabler 
in your Command & Conquer directory.

More info about creating and joining   Command & Conquer   games…  



Command & Conquer: Red Alert
System requirements:
· Pentium 75MHz

· 16MB RAM

· 1MB VLB or PCI SVGA video card

Special note: TEN only supports the Windows 95 version of Command & Conquer: Red Alert.

To begin with, you must have the retail version of Command & Conquer: Red Alert already installed 
on your hard drive. You'll also need to download the Command & Conquer: Red Alert enabler file 
ra95zip.exe (this is the compressed form to save space) from either the File menu by choosing 
"Download Files…" or from the Command & Conquer DataSphere. Once downloaded and extracted, 
place the raten95.exe enabler in your Red Alert directory. Additionally, you'll need to have a 
Command & Conquer: Red Alert CD in your CD-ROM drive. Once you have these things in order, 
you're ready to go.

The first time you play Command & Conquer: Red Alert, you'll be asked to locate the ra95ten.exe 
game enabler in your Command & Conquer: Red Alert directory.

More info about creating and joining   Command & Conquer: Red Alert   games…  



Deadlock
System requirements:
· 486 66MHz

· 8MB RAM

· VLB or PCI SVGA video card

You must first have either the demo version or the full retail version of Deadlock installed on your hard
drive. Download the demo version from either the File menu by choosing "Download Files…" or from 
the Deadlock DataSphere. The full retail version of Deadlock is available at your local software store.

The first time you play Deadlock, you'll be asked to locate the deadlock.exe file in your Deadlock 
directory.



Diablo
System requirements:
· Pentium 60MHz

· 16MB RAM

· VLB or PCI SVGA video card (with DirectX 3 drivers)

First off, you need to have the retail version of Diablo installed on your hard drive and ready to go. 
Next, be sure you have the DirectX 3 drivers installed on your machine. Once these two are set, you'll
need to download the Diablo enabler file diabtzip.exe (this is the compressed form to save space)
from either the File menu by choosing "Download Files…" or from the Diablo DataSphere. Once 
downloaded, double-click this file to extract three files (Diablui10.dll, ten.snp and 
diablo10.exe) to your Diablo directory (if your Diablo directory isn't c:\diablo, you'll need to 
change the destination path).

The first time you play Diablo, you'll be asked to locate the diablo10.exe game enabler in your 
Diablo directory.

More info about creating and joining   Diablo   games…  



Duke Nukem 3D retail
System requirements:
· Pentium 60MHz

· 12MB RAM

· VLB or PCI SVGA video card

You'll need the full retail version of Duke Nukem 3D installed on your hard drive if you want to play it 
on TEN. You can buy the retail version at your favorite software store.

The first time you play Duke Nukem 3D, you'll be asked to locate the duke3d.exe file in your Duke 
Nukem 3D directory.

More info about creating and joining   Duke Nukem 3D   games…  



Duke Nukem 3D shareware
System requirements:
· Pentium 60MHz

· 12MB RAM

· VLB or PCI SVGA video card

To play the shareware version of Duke on TEN, you must have the latest shareware version installed 
on your hard drive. You can download shareware Duke from either the File menu by choosing 
"Download Files…" or from the Duke Nukem 3D DataSphere. After you download the self-extracting 
archive, double-click it to extract the game to your hard drive. You'll need to run the setup.exe 
program to configure the sound and control options. Make sure to turn music OFF.

The first time you play Duke Nukem 3D shareware, you'll be asked to locate the duke3d.exe file in 
your Duke Nukem 3D shareware directory.

More info about creating and joining   Duke Nukem 3D   games…  



Duke Nukem 3D Atomic Edition/Plutonium Pak
System requirements:
· Pentium 60MHz

· 12MB RAM

· VLB or PCI SVGA video card

Duke Nukem 3D Atomic Edition is an enhanced version of original Duke with a new weapon, new 
levels, and some new baddies. (The Plutonium Pak is an upgrade to original Duke Nukem 3D that 
converts the original Duke Nukem 3D to the Atomic Edition.) To play in the Duke Plutonium/Atomic 
Arenas on TEN, you'll need to purchase either the Duke Nukem 3D Atomic Edition or the original 
Duke Nukem 3D plus the Duke Nukem 3D: Plutonium Pak. You'll then need to install either Atomic or
original Duke + Plutonium to your hard drive.

Note: Duke Atomic and original Duke are incompatible with each other. You'll need two separate 
installations of Duke Atomic and original Duke if you want to play in both the Plutonium/Atomic 
Arenas and the Retail or Shareware Arenas.

Make sure you have the latest version of Duke Plutonium or Duke Atomic installed on your hard drive.
A patch to the latest version is available from either the File menu by choosing "Download Files…" or 
from the Duke Nukem 3D DataSphere.

The first time you play Duke Nukem 3D Atomic Edition/Plutonium Pak, you'll be asked to locate the 
duke3d.exe file in your Duke Nukem 3D Atomic Edition/Plutonium Pak directory. You'll need to have
the Atomic/Plutonium CD in your CD-ROM drive while you play.



Magic: The Gathering
System requirements:
· 486 100MHz

· 16MB RAM

· DirectX 5 drivers

To play Magic: The Gathering on TEN, you'll first need a few things on your computer. You must have 
the retail version of Magic: The Gathering and the ManaLink software installed on your computer. You
can buy Magic: The Gathering at your local software store. Once the game and the ManaLink 
software is ready to go, you'll also need to have the DirectX 5 (or later) drivers installed on your 
computer.

We highly recommend you read and print out the ManaLink readme.txt included with your 
ManaLink software for complete details on playing Magic: The Gathering on TEN.

The first time you play Magic: The Gathering, you'll be asked to locate the manalink.exe file in your
Magic: The Gathering directory.

More info about creating and joining   Magic: The Gathering   games...   



Master of Orion II
System requirements:
· Pentium 60MHz

· 16MB RAM

· 1MB VLB or PCI SVGA video card (with DirectX 2 or DirectX 3 drivers)

In order to play Master of Orion II on TEN, you'll need to have the latest version of the game installed 
on your hard drive and the Master of Orion II CD in your CD-ROM drive. You can buy Master of Orion 
II at your local software retailer. Once the game is ready to go, you'll also need to have the DirectX 2 
or DirectX 3 drivers installed on your computer.

The first time you play Master of Orion II, you'll be asked to locate the Orion95.exe file in your 
Master of Orion II directory.

More info about creating and joining   Master of Orion II   games…  



Myth: The Fallen Lords
System requirements:
· Pentium 100MHz

· 16MB RAM (32MB recommended)

· 4X speed CD-ROM drive

· DirectX 5 drivers

To play Myth: The Fallen Lords on TEN, you'll first need the latest version of the game installed on 
your hard drive and the Myth CD-ROM in your CD-ROM drive. You'll also have to have the DirectX 5 
drivers installed on your computer. You can purchase Myth: The Fallen Lords at your favorite software
store.

The first time you play Myth: The Fallen Lords, you'll be asked to locate the myth_tfl.exe file in 
your Myth directory.

More info about creating and joining   Myth   games...   



NASCAR Racing Online Series
System requirements:
· Pentium 100MHz

· 16MB RAM

The NASCAR Racing Online Series (NROS) is a combined effort between TEN and Papyrus to bring 
NASCAR Racing 2 on the TEN service. To play in the NROS, you first need to have NASCAR Racing
2 installed on your hard drive. In addition, you'll have to download the NROS game enabler file 
nroszip.exe (this is the compressed form to save space) from either the File menu by choosing 
"Download Files... " or from the NROS DataSphere. Once the enabler package is downloaded and 
extracted, make sure the nros.exe and nrosrend.exe enablers are in your NASCAR Racing 2 
directory.

The first time you play in the NASCAR Racing Online Series, you'll be asked to locate the nros.exe 
game enabler in your NASCAR Racing 2 directory. If you plan to play the Rendition version of 
NASCAR Racing 2, you must type in nrosrend.exe when TEN asks you to locate the executable 
file for that game.



Panzer General Online
System requirements:
· 486 66MHz

· 8MB RAM

· 1MB VLB or PCI SVGA video card (with DirectX 2 or DirectX 3 drivers)

You can download a TEN-only version of Panzer General Online from either the File menu by 
choosing "Download Files…" or from the Panzer General DataSphere. If you don't have the DirectX 2
or DirectX 3 drivers, you'll need to download those as well. Don't forget to download the Panzer 
General Online manual if you don't have the Official one from the retail game. The manual is in Adobe
Acrobat PDF format, and comes with an Acrobat reader.

The first time you play Panzer General Online, you'll be asked to locate the panzer.exe file in your 
Panzer General Online directory.



Shadow Warrior retail
System requirements:
· Pentium 75MHz

· 16MB RAM

To play Shadow Warrior retail on TEN, you'll need to have the full retail version installed on your hard 
drive. You can buy Shadow Warrior retail with all its full-on ninja action at your favorite software store.

The first time you play the retail version of Shadow Warrior, you'll be asked to locate the sw.exe file 
in your Shadow Warrior retail directory.

More info about creating and joining   Shadow Warrior   retail games...   



Shadow Warrior shareware
System requirements:
· Pentium 75MHz

· 16MB RAM

To play shareware Shadow Warrior on TEN, you'll first need the shareware version installed on your 
hard drive. Shadow Warrior shareware is available for download from either the File menu by 
choosing "Download Files... " or from the Shadow Warrior DataSphere. You can also purchase it at 
your local software store.

The first time you play the shareware version of Shadow Warrior, you'll be asked to locate the 
sw.exe file in your Shadow Warrior shareware directory.

More info about creating and joining   Shadow Warrior   shareware games...   



Total Annihilation
System requirements:
· Pentium 133MHz

· 24MB RAM (32MB or 48MB recommended)

· 28.8k bps modem (or direct Internet connection)

· VLB or PCI SVGA video card (with DirectX 5 drivers)

Steep system requirements, but worth it! To play Total Annihilation on TEN, you'll first need the game 
installed on your hard drive. You'll also have to have the DirectX 5 drivers installed on your computer. 
Then, you'll have to download the Total Annihilation game enabler file tatzip.exe (this is the 
compressed form to save space) from either the File menu by choosing "Download Files... " or from 
the Total Annihilation DataSphere. Once the enabler package is downloaded and extracted, make 
sure the taten.exe enabler is in your Total Annihilation directory.

The first time you play Total Annihilation, you'll be asked to locate the taten.exe game enabler in 
your Total Annihilation directory.

More info about creating and joining   Total Annihilation   games...   



EF2000 V2.0
System requirements:
· Pentium 90MHz

· 16MB RAM

· VLB or PCI SVGA video card (with DirectX 3 drivers)

Hoo boy, this game is Sierra Hotel! To play EF2000 V2.0 on TEN, you'll first need the game installed 
on your hard drive. You'll also have to have the DirectX 3.0 drivers installed on your computer. Then, 
you'll have to download the EF2000 V2.0 game enabler file eftzip.exe (this is the compressed 
form to save space) from either the File menu by choosing "Download Files... " or from the EF2000 
V2.0 DataSphere. Once the enabler package (containing eften.exe, eften.dat and 
ten1st.dat) is downloaded and extracted, make sure the eften.exe enabler is in the "program" 
directory in your EF2000 V2.0 directory.

The first time you play EF2000 V2.0, you'll be asked to locate the eften.exe game enabler in the 
"program" directory of your EF2000 V2.0 directory.

More info about creating and joining   EF2000 V2.0   games...   



Quake
System requirements:
· Pentium 90MHz

· 16MB RAM

To play Quake on TEN, you must first install either the shareware or retail version of the game to your
hard drive. You can download the shareware version from either the File menu by choosing 
"Download Files…" or from the Quake DataSphere. The retail version of the game allows you to play 
all four episodes. If you don't have the retail version, you can purchase it at your favorite software 
store. (Shareware and full retail folks can play in the same game, as long as they play in Episode 1 
levels.)

You'll also need to download the Quake enabler file qtenzip.exe (this is the compressed form to 
save space) from either the File menu by choosing "Download Files…" or from the Quake 
DataSphere.  Once downloaded and extracted, place the quaketen.exe enabler in your Quake 
directory.

The first time you play Quake, you'll be asked to locate the quaketen.exe game enabler in your 
Quake directory.

More info about creating and joining   Quake   games…  



Warcraft
System requirements:
· Pentium 60MHz

· 8MB RAM (16MB recommended)

While you don't need to buy a retail version of Warcraft, you must download a special TEN version to
play the game on TEN. This TEN-only version of Warcraft can be downloaded from either the File 
menu by choosing "Download Files…" or from the Warcraft DataSphere.

After you've downloaded the self-extracting archive, double-click it to extract the game to your hard 
drive. You'll need to run the setup.exe program to configure the sound and control options.

The first time you play Warcraft, you'll be asked to locate the war.exe file in your Warcraft directory.



Wiz-War
System requirements:
· 486 66MHz

· 16MB RAM

Wiz-War is a TEN-only exclusive based on the immensely-popular beer 'n' pretzels board game by 
Tom Jolly. To play Wiz-War on TEN, you'll need to download the free game software from either the 
File menu of TEN by choosing "Download Files…" or from the Wiz-War Web site at 
http://www.ten.net/games/wizwar. Once downloaded, just double-click the wizwar10.exe 
self-extracting package to install Wiz-War to your computer.

The first time you play Wiz-War, you'll be asked to locate the wizwar.exe file in your Wiz-War 
directory.

More info about creating and joining   Wiz-War   games...   



Twilight Lands
System requirements:
· Pentium 75MHz (133MHz recommended)

· 16MB RAM

· DirectX 3 drivers

Twilight Lands is an exclusive TEN-only fantasy role-playing game created by ICE Online. To play 
Twilight Lands on TEN, you'll first need to download the free client software from either the File menu 
by choosing "Download Files…" or from the Twilight Lands Web site at 
http://www.ten.net/games/twilightlands. Once downloaded and installed, you'll be ready 
to create a character and play!

The first time you play Twilight Lands on TEN, you'll be asked to locate the twilight.exe file in 
your Twilight Lands directory.

More info about   Twilight Lands  ...   



The Menu Bar
TEN's Menu Bar contains a ton of delicious features not found in any store! You can refill from the 
Menu Bar from anywhere in TEN and it doesn't have one of those annoying sneeze guards.

There are six categories on the Menu Bar to tickle your palate (click a menu name to pop up that 
menu's tasty options):

· File menu. Download files (like game enablers and shareware games), system Preferences and 
the Sign Off option.

· Edit menu. All the standard editing tools like Cut, Copy, Paste and Select All.

· Go menu. Takes you to other places on TEN and to Web parts unknown.

· People menu. Everything related to the people experience: page, locate, mail and more.

· Support menu. Important personal data and billing information. Also links to support Web sites.

· Help menu. What you probably used to get here! Primarily points to areas in the Help file.



File menu
Download Files... 
-------------------------------
Preferences... 
-------------------------------
Sign Off... 



Edit menu
Cut, Copy, Paste and Select All



Go menu
Game Selector
Arena Selectors
Chat Arenas
-------------------------------
DataSpheres Web Site
File Factory Web Site
News@TEN Web Site
-------------------------------
Open Newsgroup Reader
-------------------------------
Open URL... 



People menu
Page... 
Locate... 
View a Profile... 
View Rankings... 
-------------------------------
Open Mail Reader



Support menu
Display Billing Policy
Display Billing Report
-------------------------------
Change Rate Plan... 
Change Payment Method... 
Change Address... 
Change Password... 
Cancel My Account...
-------------------------------
Contact Information... 
FAQ Web Site... 
Support Web Site... 
-------------------------------
Send Feedback Via Web
Send Support Question Via Web



Help menu
Help About Current Screen
Help Topics
-------------------------------
About TEN



Download Files... (File menu)
Here's the most convenient place to download TEN-related files, game enablers and shareware 
games from within TEN itself. When you click on a file to download, details and download time will be 
displayed in the lower window.

We've broken down the files into major categories: ENABLERS (enabler files for games on TEN), 
TENFILES (miscellaneous TEN-software and enhancements), GAMES (online-only and shareware 
games), PATCHES (upgrades to games supported on TEN) and OTHER (miscellaneous files). These
categories may expand as necessary.

If you choose to download a game enabler file, TEN will automatically place the file on your hard drive
and run the self-extractor on that file. It will apply any patch (if necessary) and place the game 
enablers in the proper directory.



Preferences... (File menu)
The Preferences option on the File menu is used to change and customize settings on TEN. Here, 
you can change what sounds are associated with certain actions, choose a specific mail or news 
reader, locate games or game enablers and turn on or off your Arena announcements among other 
things.

There's plenty here to digest, so take your time. And make sure not to go swimming for 30 minutes 
after your visit.

General tab: Changes your ability to page or be paged, turns on or off the text replacement filter and 
activates (or deactivates) Arena announcements.

Sounds tab: Lets you to turn certain TEN sounds on or off as well as associate other sounds to TEN 
events.

Games tab: Allows you to find TEN-supported games on your hard drive and re-locate game enabler 
files (if appropriate for the game).

Muzzle List tab: Gives you the option to remove other TEN members from your personal muzzle list.

Web Browser tab: Sets up your default World Wide Web browser.

Mail and News tab: Selects what program you want to use to read electronic mail and for reading 
TEN's newsgroups.



General tab
The General tab in the Preferences option allows you to turn on the Page and Locate features as well
as set some Arena Chat options.

Page and Locate
When Enable Page and Locate is checked on, you are allowed to send a specific page message to 
a TEN member. It also allows others to page you, and provides others with the ability to locate you. 
(You can page people from the People menu by choosing "Page... " and you can locate people from 
that same People menu by choosing "Locate... ".)

Arena Chat
If you turn Activate text replacement filter on (by checking the box), any obvious obscenities (four-
letter words and the like) you see in Pages or in the chat area of Arenas will be replaced by @#$%&. 
Just a note before some of you out there start ranting about censorship and freedom of speech. This 
option's default is OFF, so you have to make a conscious effort to turn it on. You can also edit this list 
to include additional words or remove words that you don't object to. It's up to you.

When Show Arena announcements is checked on, you will see entry and exit announcement for 
everyone who enters or exits a Game Arena or Chat Arena. Turning this off only affects your ability to 
see announcements.

Arena announcements are presented by TEN when you enter or exit an Arena. Easy! Edit your 
proclamations in the text fields at the bottom of this dialog box.

Back to the Preferences description... 



Editing the text replacement filter list
It's really easy. Just open the directory where you installed TEN and then open the "TENData" 
directory. There's a file called default.spam. You can open up this file in Notepad or another 
applet. Look out! Some of you may be offended by the words contained therein. This is your first and 
only warning!

You'll see that the words we chose to replace are on the left side of the "=" sign and the replacement 
words are on the right. (For example, mealyworms=@#$%&) To add a word, just put the word you 
don't like first, then an "=" sign, then the word you want it replaced with. It's that simple! You can even
create some humorous filters—like making an Medieval filter (by replacing "would" with "wouldst" and
so forth). Just remember to name any new filter you create default.spam. (You might want to save 
your original default.spam just for reference.)

Back to the General Preferences tab... 



Sounds tab
The Sounds tab in the Preferences option lets you turn sounds on or off and customize which sounds 
you hear while you're on TEN. With very little work, you can also assign your own sounds to TEN's 
actions!

Sounds
When Play sound effects on TEN is checked on, you will hear specific sounds when you perform 
actions on TEN (connecting to TEN, paging, testing your connection and so forth). A list of the Events
tied to these sounds is in the box below. Click the check box to the left of each event to turn that 
event's sound on or off.

Click an event and hit the Preview button to hear the sound associated with it. Whack the Reset 
button to restore the sound defaults.

The Location field at the bottom shows the directory path of your selected Event sound. Clicking 
Browse will allow you to choose one of your own sounds to play for that selected event.

Back to the Preferences description... 



Games tab
The Games tab in the Preferences option shows you what games you've played on TEN and where 
those games (and game enablers) are located. If you ever change the directory for one of these 
games or game enablers, you'll need to update this list.

Games
The Games you've played on TEN list shows exactly that. Any games that TEN supports that you 
haven't played yet won't be shown here. Click on one of these games to show info in the other two 
fields.

The File TEN needs to run the game field displays the file TEN needs to run when you CREATE or 
JOIN a game. Most of the time, the file TEN looks for is the .exe file of the game itself. Occasionally, 
it's looking for a game enabler file that you can download from the Download Files  area of the File 
menu.

Location displays the current path of the file TEN needs to run the game (game .exe or game 
enabler). Hit the Browse button to change the location of the .exe or game enabler if you've changed
the path.

At the bottom, there's a checkbox to enable DOS-based joystick drivers. If you've got a DOS-based 
joystick you'd like to use, just click the checkbox. It'll look for your joystick driver and enable it. Go for 
it, joystick jockey!

Back to the Preferences description... 



Muzzle List tab
The Muzzle List tab in the Preferences option displays everyone you have currently muzzled on TEN.
(You can muzzle someone in an Arena by right-clicking on their name in the WHO'S HERE list and 
choosing "Muzzle.")

Muzzle List
It's important to mention that as long as a person remains on your Muzzle List, you will be unable to 
see any chat from them in an Arena. They also can't page you, nor can they use the Locate feature to
find you on TEN.

Select a screen name from the list and hit the Remove button to remove a person from your muzzle 
list. Unmuzzling someone in a Game Arena will also remove someone from your muzzle list.

Back to the Preferences description... 



Web Browser tab
The Web Browser tab in the Preferences option lets you choose which World Wide Web browser 
you'd like to set to view Web links from TEN. This browser will be launched when you hit any 
DataSphere button (or menu option), the News@TEN area, customer service areas and the menu 
link to the File Factory.

Web Browser
TEN supports both Netscape Navigator 3.0 and Microsoft Internet Explorer 3.0 for Web browsing. 
Earlier versions of these Web browsers are not guaranteed to work correctly with TEN.

Selecting Netscape Navigator 3.0 will make this your default Web browser. If, for some reason, you 
don't have Netscape Navigator on your hard drive, hit the Download button to retrieve the browser 
from our site. And if you ever change the location of Navigator, hit the Browse button to relocate it.

If you have Microsoft Internet Explorer 3.0 on your hard drive, TEN will automatically detect where 
it is. No muss, no fuss! Selecting this option will make Microsoft Internet Explorer your default 
browser.

Back to the Preferences description... 



Mail and News tab
The Mail and News tab in the Preferences option provides the option to change how you receive your
TEN electronic mail and read TEN-related newsgroups. All this stuff needs to be configured first 
before you can get to your e-mail account or peruse our spiffy newsgroups.

Mail
Choose Use Web browser to read mail if you plan to read your e-mail through your selected Web 
browser. (Hit the Details button for complete info on how to set up your Web browser to read your 
TEN e-mail.) We also have a few e-mail practices you gotta follow. They're fairly up front.

You can also choose Use a different mail reader if you prefer using Eudora or some third-party e-
mail reader. If you intend to use a third-party e-mail reader, you'll have to let us know where you've 
installed it by clicking the Browse... button. And, if you don't have Eudora or Eudora Lite, we've got a 
copy of the latter available to Download...

The last check box lets you set up how often TEN will check for your e-mail.

News
Click Use Web browser to read news for quick and easy reading of TEN newsgroups through your 
selected Web browser. (Whack that Details button for the low-down on how to set up your Web 
browser to read TEN newsgroups.) Also important are tips on newsgroup etiquette. The proof's in the 
reading.

If you prefer to Use a different news reader other than your Web browser, click that button. As with 
the e-mail reader, you'll have to Browse... and let us know where that mail reader is on your hard 
drive.

Back to the Preferences description... 



Sign Off... (File menu)
Hey, don't leave yet... I think hear a Quake game starting!

This menu option will sign you off TEN. You'll get one confirmation, then you is outta here. Come back
soon!



Cut, Copy, Paste and Select All (Edit menu)
Standard Windows 95 Edit menu stuff. Cut cuts. Copy copies. Paste pastes. Select All...er...Selects 
All! Use these options in the chat areas of Game Arenas and Chat Arenas.



Game Selector (Go menu)
Takes you from wherever you are in TEN to the Game Selector screen. Here you can read the 
News@TEN headlines or choose a game from the SELECT A GAME list.



Arena Selectors (Go menu)
This zips you to the Arena Selector screen for the game you choose. Serves the same function as 
clicking a game name on the Game Selector and clicking the GO button.



Chat Arenas (Go menu)
If, at the moment, you don't feel very hungry for a game, try one of our delicious Chat Arenas. Go 
ahead, fill yourself up with some quality conversation time.

Here, you can find a player for a game, or simply type up a storm with a total stranger. We've got a 
few specialized Chat Arenas if you want to take a break from the game scene. The Chat Arenas differ
from the chat in regular Game Arenas 'cause they've got a HUGE chat space to yak it up.

Choosing this option will bring you to a screen similar to the Arena Selector screen. Once you select 
an Arena from this list and hit GO, stick your cursor in the chat entry space and just start typing. Hit 
Enter when you have a complete thought.



DataSpheres Web Site (Go menu)
This option instantly launches your default Web browser and shoots you over to our handy-dandy 
DataSpheres for news and important information. If you don't have a Web browser configured, you'll 
be brought to the Preferences menu item for a dark interrogation. 



File Factory Web Site (Go menu)
Need some cool shareware or the latest game hints, tips, user levels and walkthroughs? TEN's File 
Factory is the place for you! Selecting this option will launch your default Web browser and shoot you 
right over there for the ultimate in download action.



News at TEN Web Site (Go menu)
Want the latest news and information about TEN? Looking for some killer upcoming event or 
tournament TEN is about to run? The News@TEN Web Site menu option will launch your selected 
Web browser and shoot you over to TEN's news Web pages for all the details!

You can also get to this Web site by hitting the MORE NEWS button on the Game Selector screen.



Open Newsgroup Reader (Go menu)
Need to see what the players are saying about a TEN-supported game? This menu option launches 
your selected news reader for quick and easy access to TEN's game newsgroups. Read some 
messages. Post some. Ahhh, newsgroup bliss...



Open URL... (Go menu)
This opens up a dialog box for you to enter a specific URL (Universal Resource Locator) for a Web 
site you know about. Just type in the Web address (like www.ten.net)—you don't need to type in 
the "http://" part of it.

Once you hit OK on this dialog box, your selected Web browser will open and you'll be there!



Page... (People menu)
Choose this option to bring up the Page dialog box to initiate a private chat conversation. Now, just 
enter the screen name of the TEN member you want to page (don't worry about capitalization) and hit
OK. If they're online, they'll get a page notification. If they're not, you'll know. And if they have you 
muzzled...well...



Locate... (People menu)
Select this to pop up the Locate dialog box to search for another TEN member online. Just type in the
name of the person you want to locate (proper capitalization isn't necessary) and hit OK. If TEN can 
find them online, their location will be displayed. If they're not, they won't! And, if they've muzzled you 
for some reason, their location will be kept secret.



View a Profile... (People menu)
Once you choose this menu option, just type in another TEN member's screen name (whether they're
online or not!) to bring up their user profile. SEE when they first signed on to TEN. READ their 
invigorating witticisms. KNOW their favorite URL. All this could be visible if they've filled out the info.

If you type in your own screen name, once the Profile appears, you can hit the EDIT button to change 
your own profile.



View Rankings... (People menu)
Ah yes, Rankings. TEN's equivalent of a BMW. The symbol of your gaming opulence. Choosing this 
menu item brings up a rankings area where you check out player's game ranking status. See for 
yourself who's the best of the best.



Open Mail Reader (People menu)
Selecting this option launches your selected electronic mail reader for sending and receiving e-mail. 
When you're finished, be sure to exit the reader so you have as much available memory as possible 
for playing games.



Display Billing Policy (Support menu)
This option pops open our current Billing Policy and provides current information on the various rate 
plans, billing procedures and how to cancel an account. Fun stuff, eh?



Display Billing Report (Support menu)
Choosing this option opens a window that displays how much time you've spent on TEN, what your 
previous month's usage was and a host of other clever billing information. Just our small attempt to 
keep you in the loop.



Change Rate Plan... (Support menu)
Here's where you can go to adjust your billing rate plan. Remember, any new rate plan selected won't
take effect until the END of your current billing cycle, so don't be expecting it to change right away. 
You can find out your current billing cycle from the Display Billing Report option on the Support menu.



Change Payment Method... (Support menu)
If you want to change your credit card info (billing address and so forth), here's the place to do it. Not 
to worry, we don't display your credit card number anywhere. If you decide not to change your vitals 
here, just hit the Cancel button and no changes will be saved.



Change Address... (Support menu)
Moved recently? Got a new, spiffy phone number or e-mail address? Enter it here! If you decide 
partway through that you don't want to change this stuff, just hit Cancel and none of it will be saved.



Change Password... (Support menu)
Tired of that old, run-of-the-mill password? Make a change!

Just type in your old password, and your new one twice (for confirmation!) and you're set. It's good to 
change it every so often just for safety. Remember, you're responsible for keeping your password 
safe, so don't come a-blamin' us if you change your password to the name of your Dark Sun 
character and someone hacks their way in!

There are a couple of guidelines for changing your password. First off, your password must be at 
least 6 characters long and no more than 10. Don't use any crazy control characters or nothing like 
that. Just make sure that your password won't be something that other people can easily guess. A 
wacky combination of letters and numbers is a good start.

Lastly, your password is case-sensitive, so UPPER and lower case characters make a difference.



Cancel My Account... (Support menu)
first para

second para



Contact Information (Support menu)
All those Customer Service numbers are there in full glory. Give us a ring or, better yet, e-mail us for 
ultra-fast response!



FAQ Web Site (Support menu)
Launches your selected Web browser and zips you off quickly to the latest, greatest list of Frequently 
Asked Questions (FAQs) on our Support Web site. Everything you never needed to know about the 
games we support, connection questions, general TEN questions and much, much more. We're 
constantly updating this site, so check back often!



Support Web Site (Support menu)
Need some specific help about TEN? Looking for a particular e-mail address or want some other 
service-related information? This menu selection fires up your selected Web browser and shoots you 
over to our Support Web site where all your burning questions will be dowsed.



Send Feedback Via Web (Support menu)
Think we're doing a good job? Or not. Tell us! Inquiring Bandwidth minds want to know!

Choosing this option will fire you off to a Web-based feedback form where you can rant and rave to 
your heart's content. Instant contact with the TEN Heads of State. Your voice WILL be heard!



Send Support Question Via Web (Support Menu)
Whoops! Did you find a bug we forgot to squash? Found some wacky anomaly in the TEN software? 
Have an important billing question you need answered? Whatever the reason, fire off a comment.

Hitting this selection will take you to a series of Web forms where you can report the sighting. We'll 
retrieve the info from our remote site in Roswell and send it to the proper authorities.

NOTE: This is the single most important place to submit technical and billing questions to TEN. We 
have staff ready and waiting for these questions to come in so they can lead fulfilling, productive 
lives. Won't you help by asking your questions here? Remember, technical questions won't be 
answered by the phone staff, so please don't fill their heads with confusion!



Help About Current Screen (Help menu)
This whips up TEN's Help file and plops you straight into a screen shot of the screen you're currently 
on. Clicking anywhere on the graphic will pop-up detailed info about that area. It's similar to the ?-
help, but with a lot more detail. From here, you can also cruise through the rest of the entertaining 
Help file.



Help Topics (Help menu)
With this option, you are thrust violently into the Help file's table of contents. Double-click on the 
purple books to open up groups of topics. If you're new to TEN, check out the first topic "Hey, new 
folks! Read this first".

Overview of TEN provides some TEN philosophy, a history, our Community Guidelines and the TEN 
Terms of Service.

The Total Entertainment Network explains how to use the TEN software to chat, page, play games 
and all that stuff.

Latency, Bandwidth and Everything humorously expounds on the definition of latency and 
bandwidth.

Got questions? We've got answers is a troubleshooting section that contains connection questions 
and numerous common questions about TEN.

Contacting TEN's Customer Service displays how to contact us in case of a problem (whether it's 
by phone, e-mail or on the Web).



About TEN (Help menu)
Version information for the TEN software. Exciting stuff.



Communications 101 (an overview)
Break out those notebooks, sharpen those pencils and prepare for some serious learnin'. Well, 
maybe not quite so serious.

Throughout TEN, there are a lot of different ways to communicate with other TEN folks. Just click on 
a link from the list below:

· Chat, whisper and muzzle: Learn all about our chat features and the importance of the Whisper 
and Muzzle commands.

· Page and Locate: Want a private conversation? Need to find someone online quickly? Here's the
skinny.

· Profiles: View how others see themselves, or enter a profile of your own.

· Rankings: Sierra Hotel. The best of the best. See who's who in your favorite game.

· Electronic mail: Details on setting up an e-mail reader and how others can send you e-mail.

· Web surfing: It's an ocean out there on the World Wide Web. Hang TEN, baby. 

· Newsgroups: TEN's game-specific newsgroups are the perfect forum for ongoing conversations.

· Game DataSpheres: Web sites devoted to the games you play on TEN.

· File Factory: Download the latest shareware, user maps and plenty more from our file repository.

· TEN News & Events Web pages: THE place to find out what's going on at TEN. System news 
and upcoming events are staples here. 

· TEN folks and the TENguides: Here's what we "look like" on the system and how to contact us.

TEN is your oyster. Slurp it up.



Chat, whisper and muzzle
Everyone loves to talk. Some people more than others. And some people simply just won't shut up! 
That's why we have the Muzzle command. When you want to type a sentence to one person, use the 
Whisper command. Explanations below.

Chat
The basics. Chat is the primary form of communication on TEN. All Game Arenas and Chat Arenas 
have places for you to blab to your heart's content. Of course, we want you to use a little decorum 
when yappin'. That's why we invented TEN's Community Guidelines. Free speech is all well and 
good, just remember to keep your cool.

When you're in an Arena, all the chat takes place on the right side of the screen. The screen name of 
the person talking will appear on the left side of this big window followed by what they're saying. 
Simple, huh? If you want to add something to the conversation, just type stuff in the chat entry line 
below the big window and hit the SEND button (or hit the Enter key). That'll send your message to the 
world.

Whisper
If you want to send a quick, private message to one person in an Arena, use the Whisper command. 
Just right-click on their name from the WHO'S HERE list on the left side of the screen and choose 
"Whisper." This'll stick a /w and their name on the chat entry line. Type away. When you hit SEND, that
message will appear on their screen and their screen only.

Muzzle
Sick of someone flapping their...er...typing hands? Just Muzzle Them. Right-click on their name in the
WHO'S HERE list and choose "Muzzle." Once muzzled, you'll see a little "M" next to their name and you 
won't "hear" them chat. You also won't get any pages from them and they won't be able to locate you. 
You can "Unmuzzle" them by right-clicking their name and choosing that option or going to the File 
menu under "Preferences" and removing them from your Muzzle List.



Page and Locate
Two really powerful options in TEN are the Page and Locate features. With Page, you can conduct 
top-secret conversations with another pal on TEN. And with Locate, you can find your bud anywhere 
he or she may be on TEN. Both the Page and Locate features operate in the same manner, so here 
we go...

Page
Choosing "Page..." from the People menu (or by clicking the pager icon on any screen) brings up a 
small dialog box where you can enter the screen name of the TEN member you want to talk to. If 
you've paged them before, simply go to the drop down list and pull up their name. Hit OK and your 
page is sent.

If they don't want to be paged (have their pager turned off), or aren't on TEN at the time, you'll be 
informed. Otherwise, if they accept your page (lucky guy!), you'll see the paging window. This works 
just like regular chat in an Arena—type a line of text and hit Enter or the SEND button to fire it off.

On the left side of this dialog box, you'll see a list of your active pages. Each page is a one-on-one 
experience. You can have a ton of active pages, just click the person's screen name to switch 
between page windows. Hit NEW to start a new page, or DISMISS to terminate the selected page. The

 icon means you're still connected to that person for paging (they haven't hit DISMISS to end the 
page).

If the page icon is blinking green, someone is trying to page you. If it's red, you have your pager turned 
off. Turn it back on by going to the File menu and choosing "Preferences... "

Locate
Need to find someone in a hurry so you can continue that important game? Use the handy-dandy 
Locate feature. Go to the People menu and choose "Locate..." This'll bring up a dialog box where you
can enter their screen name. If you've tried to locate them before, just go to the drop down list and 
select their name. Once you hit Enter or the OK button, you'll be shown where they are on TEN.



Profiles
When you absolutely, positively have to find out the bio information on a person, here's the place. 
Just type in the screen name of the person by going to the People menu and choosing "View a 
Profile... " that you want to run a profile check on. This'll bring up a dialog box with a ton o' gunk.

BIO shows a ton of relevant (or irreverent) stuff about someone. It shows how long they've been a 
member of TEN, any alias they might go under, birth date, a gender, their relationship status, fav Web
site and any miscellaneous junk. Remember that the user feeds all this data except the "Member 
since" line, so habius corpus and cogito ergo ludo.

RANKING displays the selected player's game ranking, so you can see just what you're getting into if 
you invite them to a game!

Click the check box next to MUZZLE to shut the selected person up for a time. You may not want to 
year their yap. It'll also make it so they can't page or locate you.

Speaking of which, you can enter your own Bio. Either right-click on your screen name from the 
WHO'S HERE window on any Game Arena and select "Profile" from the menu or go to the People menu
and choose "View a Profile..." (then enter your name. When that Profile window opens, hit the EDIT 
button. Fill in as many fields as you deem necessary and hit SAVE when you're satisfied.

Shortcut! To open a Profile in a Game Arena, just double-click on a person's name from the WHO'S 
HERE menu.



Rankings
Think you're good. Think again.

There are some awesome game players across the country, and with our ultra-detailed ranking 
system, you can see if you deserve to wear their boots or be crushed beneath them.

Pull up the rankings from the People menu by choosing "View Rankings... ".

When the dialog box opens, select which game you want to view from the pull-down box at the top 
and then choose one of the options below. You can see the ranks for everyone, yourself (plus/minus 
10 other players), the top players (up to 100) sorted any way you choose or even rankings on 
individual players.

If you choose to view individual players, you can see how many times they've pasted you by selecting
"display in a victory matrix." This'll show the players you selected (including yourself) and how many 
times they've killed each other. Separate all entries by commas (e.g., "MaxxFlite, Chumpus, 
Weasel").



Electronic mail
Yes, TEN gives you e-mail as well. Conserve those stamps. Write to those long, lost friends.

There's a number of e-mail programs you can use (including the e-mail portions of Navigator or 
Internet Explorer), and we've got Eudora Light that you can download for your convenience. It's 
available by selecting "Preferences..." from the File menu and choosing the "Mail and News" tab. 
Make sure you read, understand and memorize our e-mail practices. There'll be a quiz later.

In brief, your e-mail address on TEN is your screenname@ten.net (for example, if your screen 
name is "joebob", your e-mail address would be joebob@ten.net). For those familiar with e-mail 
settings and the like, here are some specifics:

· Outgoing mail (SMTP) server: mail-out.ten.net
· Incoming mail (POP3) server: pop.ten.net
· POP3 Account: screenname@pop.ten.net
Don't get it? No prob. Here are the complete details on how to configure various programs so you can
read your TEN e-mail:

Eudora Light

Microsoft Internet Explorer 3.0

Netscape Navigator 3.0



Eudora Light
Eudora is the granddaddy of electronic mail programs. It's little nephew is Eudora Light, a freeware 
version with fewer features. The easiest way to set up Eudora Light is to download it right from our 
File menu under "Preferences..." Choose the "Mail and News" tab and hit the Download button under 
Mail.

When you first run Eudora Light, you'll probably get a dialog box staring you in the face when you first
load the program, but if you don't, enter the following info by pulling down the Tools menu and 
selecting "Options…". 

1. Click the "Getting Started" icon and on the "POP Account" line, type your TEN 
screenname@pop.ten.net for your e-mail address. (Example: joebob@pop.ten.net)

2. Check to ensure that Winsock (the default) is selected for your connection method and that 
you've entered your real name.

3. Now, click the "Hosts" icon and under "SMTP", type mail-out.ten.net
When Eudora Light prompts for your password, just use your TEN password.

To send mail, go to the Message menu and choose "New Message". Enter the person's e-mail 
address on the first line and when you've finished your message, hit the Send button.

To check your mail, go to the File menu and choose "Check Mail". Double-click on a mail message to 
read it.



Microsoft Internet Explorer 3.0
Microsoft Internet Explorer 3.0 is a full-service, all-in-one program. Web surfing. Newsgroup 
scanning. E-mail reading. And, it generally comes pre-installed on your computer! What more could 
one want?

Here's how to set up Internet Explorer to read your TEN e-mail and view newsgroups:

E-mail
After launching Internet Explorer, follow these procedures to set it up to read your TEN e-mail:

1. Pull down the Go menu and choose "Read Mail".

2. When the Internet Mail screen appears, go to the Mail menu and choose "Options".

3. Click the Server tab and enter a name on the "Name" line (you might just want to enter your TEN 
screen name here). Under "Email Address", type screenname@ten.net (where screenname is
your TEN screen name).

4. In the "Server" section of this tab, type mail-out.ten.net under "Outgoing Mail (SMTP)". 
Next, type pop.ten.net in the "Incoming Mail (POP3)" line. Finally, where it says "POP3 
Account", type your TEN screen name.

5. Now, click the Connection tab and verify that the connection method is correct. You'll generally 
want to have "I connect manually" checked so that Internet Explorer will use your existing TEN 
connection to grab your mail.

To check your mail after launching Internet Explorer, cruise to the Go menu and choose "Read Mail". 
Once the mail window opens, go to the Mail menu and choose "Send and Receive". If you have mail, 
just click the message in the top part of the window and read the message in the bottom part.

To send mail, pull down the Go menu and choose "Read Mail". Once there, open the Mail menu and 
select "New Message". Type the destination e-mail address, the subject of the mail and your 
message. Hit the Send button to fire it off.

News
First, you've gotta launch Internet Explorer. Then, follow these steps:

1. Pull down the Go menu and choose "Read News".

2. Go to the News menu and choose "Options" to begin. Make sure you've entered your name 
(probably your TEN screen name) and e-mail address

3. Click the Server tab and hit the Add button at the bottom. Under "News Server Name", type 
localnews.ten.net

To subscribe to one of TEN's newsgroups, simply click the Newsgroups icon and double-click the 
newsgroups that interest you. When you are subscribed to a newsgroup, a newspaper icon will 
appear next to it.

To view a newsgroup, just select a newsgroup from the Newsgroups drop down menu below the 
toolbar. To post a message to the newsgroup, highlight a post and click either "Reply to Group" or 
"Reply to Author". This allows you to either post a message for everyone to read, or send a private 
response to the author of the post.



Netscape Navigator 3.0
Netscape Navigator is the classic multipurpose, integrated Web browser, news viewer and mail 
reader. Nearly everyone who has used the Internet at one time or another has fired up Navigator. We 
even have a copy available for download. Just go to the File menu, choose "Preferences..." and click 
the Web Browser tab. From there, hit the Download... button. This'll grab a copy of Navigator from our
site. Be sure to register!

Below are a few details on how to set up Netscape Navigator to read your TEN e-mail and 
newsgroups (it's pretty much the same for Netscape Communicator):

E-mail
Fire up Netscape Navigator and follow these simple steps:

1. From the Options menu, choose "Mail and News Preferences..."

2. Once that opens, click the Servers tab.

3. You'll need to enter a few things in the Mail section: type mail-out.ten.net next to "Outgoing 
Mail (SMTP) Server:", type pop.ten.net next to "Incoming Mail (POP3) Server:" and then type 
your TEN screen name next to "POP3 User Name:".

4. Next, click the Identity tab and fill in the "Your Name:" field (you might just want to enter your TEN
screen name here). The next two lines ("Your Email:" and "Reply-to Address:") are the same. Just
enter your TEN screenname@ten.net

To check your mail, go to the Window menu and choose "Netscape Mail". This'll search out and 
locate any TEN mail you may have. If Navigator asks you for your password, it's the same as your 
TEN password. Once here, e-mail messages will appear on the top right of the screen. Simply click 
one to read it in the lower window. To respond to an e-mail, hit the "Re:Mail" button just below the 
menu bar. 

To send off a new e-mail, just go to the File menu and choose "New Mail Message". This'll launch the 
mail portion of Navigator and prompt you to enter an e-mail address in the "Mail to:" field. Once that's 
done, type the body of your message in the big box below and send 'er off!

News
Once you've launched Navigator, crank out these simple steps:

1. From the Options menu, choose "Mail and News Preferences..."

2. Once that dialog box opens, click the Servers tab.

3. In the News section, type localnews.ten.net next to "News (NNTP) Server:".

To subscribe to a TEN newsgroup, go to the Window menu and choose "Netscape News". When the 
list of newsgroups appears, click the square next to the newsgroup(s) you want to subscribe to. This'll
put a little yellow check mark next to those groups and they'll appear each time your launch Netscape
News. Otherwise, reading news is the same as reading mail.

To post a message to a newsgroup, click the newsgroup you want to send a post to and hit the 
"Re:News" button. This'll launch a window just like the one in news. Just type in your post and hit the 
Send button.



TEN's e-mail practices
Here they are, the quasi-legal mumbo-jumbo majorly-hyphenated e-mail practices. Don't say we 
didn't warn ya!

1. Each TEN member gets 2MB of disk space for mail storage.

2. Once the 2MB maximum mailbox capacity is reached, any new mail will be returned to its sender.

3. If a mail account is unused for 90 days, the mail account will be emptied of all mail.

4. If you cancel your TEN account, your mail account will be closed and any new mail will be 
returned to its sender.

5. Misuse of your e-mail account could result in the termination of your TEN membership. See 
TEN's Community Guidelines for more details on TEN's e-mail policies.



Web surfing
With a TEN membership, the Internet and the World Wide Web are at your feet. Be sure to wipe 
before entering. Once connected to TEN, you can go Web surfing to your heart's content. You'll have 
to use a third-party program to browse the Web, such as Netscape Navigator 3.0 or Microsoft Internet
Explorer 3.0, but that's no problem.

Need some explanation about the Web or the Internet in general? Click the link.



Newsgroups
TEN's newsgroups are general message clearinghouses about the games on TEN. Most games on 
TEN have their own newsgroup and any TEN member can feel free to post a general message on the
"board".

You can use a dedicated newsgroup reader (such as Free Agent) to read newsgroups, or scan them 
through a Web browser such as Internet Explorer or Netscape Navigator.

Newsgroups are especially handy for long-term discussions about specific game-related topics. For 
example, if you really wanted some killer Panzer General strategy for a particular scenario, you could 
post a message asking for advice. Eventually, someone will read it and respond to the group. This 
way, the entire community of that game gets in on the action.

Before waxing poetic on a newsgroup, you oughta take a look at our newsgroup tips and guidelines. 
People familiar with newsgroups and posting etiquette should just skim this as a refresher course.



Tips for being a happy newsgroupie
If you're new to the world of Internet newsgroups, there are a few things you should know before 
diving in. Over the years, a code of Net etiquette (or "Netiquette") has evolved around newsgroups. 
Working within this code will help you avoid faux pas so you'll have a kinder, gentler newsgroup 
experience.

Be Relevant: Make sure that your posts are relevant to the newsgroup you're posting to. A message 
about Tiddlywinks in the Wargames newsgroup will, at best, be ignored. At worst, you may get a 
nasty note from a grumbling grognard.

Get a Feel for Things: Before posting a message to a newsgroup, read some of the other posts to 
get a feel for the group's language, style and current topic of discussion. Asking a question that is 
answered in a message posted the day before can annoy the more irritable of Net veterans.

Read Other Replies Before Answering: If you are going to post a reply to someone's message, be 
sure to read the replies of others to ensure that you aren't duplicating someone else's efforts.

Respond by Private E-Mail When Appropriate: You may come across a newsgroup message that 
calls for a personal reply (i.e., a message like "Wanna be in my Quake clan? Send a reply."). Be sure 
that you send a private e-mail to the sender, rather than a public posting to everyone.

Never Post Personal Info: It's a really bad idea to post personal information (real name, address, 
phone number, credit card numbers, TEN account passwords) to newsgroups. Note that a TEN 
staffer will NEVER ask you for your account information in chat, e-mail or newsgroups. If someone 
claims to be a TEN staff member and asks you for your account information, they are a fraud.

For more information on Netiquette, you can search the net with the "netiquette" keyword, or check 
out your local book store for one of the many new books on the subject.



Game DataSpheres
TEN's Web-based DataSpheres are the be-all, end-all of game information about the games we 
support on TEN. To access our game DataSpheres, just click the DataSphere button at the top of a 
Game Arena or pull down the Go menu and choose "DataSpheres Web Site". That shows the current 
list of the DataSpheres we have up and running.

Within each DataSphere, we keep up to date on the latest news about the game, especially how that 
news relates to TEN. In addition, you can access the game's newsgroup, check out some spiffy other 
Web sites on that game, pour through strategies and hints and check up on the latest rankings (and 
how the rankings are calculated for that game). The DataSpheres are an invaluable tool—and they're 
free to you, our loyal TEN subscriber!



File Factory
TEN's File Factory is the ultimate repository of game-related software on the Internet. Download 
demos of upcoming games, scads of shareware titles, hints and walkthroughs for adventure games, 
and plenty, plenty more. Zip over to the File Factory by pulling down the Go menu and choosing "File 
Factory Web Site".

Once there, you can read a little ditty on how to grind through the Factory and learn how to upload 
your own files for posting. If you don't see something you think should be up there, send an e-mail to 
our File Factory Foreman. He'll get on it straight away!



News at TEN
Need the latest information about the TEN service? Missed who won the most recent TEN 
tournament? Want some more data on upcoming TEN events and promotions? The News@TEN 
Web pages are the place to be. Cruise over there by hitting the MORE NEWS button on the Game 
Selector screen or by pulling down the Go menu and choosing "News@TEN Web Site".

We've got a number of features to entice you and keep you informed. There's an events calendar for 
upcoming tournaments and special gatherings.



TEN folks and the TENguides
More often than not, there will be a number of TEN employees wandering the brightly-lit halls of TEN. 
Not to worry. We're not there to crack down on anyone or nuthin. (A lot of times, we're there to play 
some games and blow off steam!) If we're in our "TEN uniform", feel free to flag us down if you have a
question or concern. You can recognize us because we have the word "TEN-" in front of our names 
(e.g., "TEN-Chris" or "TEN-Spudly"). If you're having fun, we're having fun.

In addition to TEN employees, there may be a number of volunteers roaming around the system that 
can help you out. They're called TENguides and can be recognized by the word "Guide" or "Magna" 
in front of their name (e.g., "GuideFred" or "MagnaLuigi"). They can usually be found in Help Arenas, 
the Rookies' HQ or hanging around in the chat areas of Game Arenas. These kind, gentle people are 
our technical representatives, so don't hesitate to ask them a question if you've got one.



Game Selector screen
You'll be here if you came in directly by launching TEN. If you entered TEN through a retail game, 
you'll go directly to that game's Arena Selector.

This is the action zone. Choose a game on the list and hit PLAY to dive in the mix. Make sure you 
have that game already installed on your hard drive and the appropriate game enabler (if necessary)!

Move your mouse cursor over the screen below for more info on buttons.



SELECT A GAME
Here's the list of the current games on TEN. Double-click on a game title or select a game and click PLAY to 
enter that game's Arena Selector screen.

You must have that game installed on your hard drive and the appropriate game enablers (if necessary) for you 
to play.



GO button
Once you've chosen a game you want to play, don't delay. Hit this shiny, candy-like button.



News@TEN
Watch this space for the up-to-date, fast-breaking news about TEN. (New stories are indicated by a red bullet!) 
These teaser headlines are there to entice you cruise to News@TEN Web site for the complete news about TEN
and special online event info.



MORE NEWS
Launches your selected Web browser and surfs you on over to the News@TEN Web Site. This has the same 
function as pulling down the Go menu and choosing "News@TEN Web Site."



Mail button
Click this button to open up your selected electronic mail reader to read or send some e-mail.

If the green light's flashing, you have mail!

If the light turns red, uh oh. You probably moved your e-mail reader and TEN can't find it any more. You'll need to
let TEN know where you put that sucker.



Page button
Slap this button to open up your pager for private chat conversations.

If there's a green light flashing, you're being paged! Better see who it is.

If that light's red, you have your pager turned off. Go to the File menu and choose Preferences to turn it back on.



TEN's Menu Bar
The Menu Bar zips you off to a whole boatload of options including sound, Web and news configuration, the 
muzzle list and plenty more. Check it out for yourself.



Getting started with Dark Sun
Dark Sun: Crimson Sands is a TEN exclusive. It's an online role-playing game (RPG) world set in the 
Advanced Dungeons and Dragons Dark Sun universe. You must have the Dark Sun software to play, 
which can be found at the Dark Sun DataSphere It's a pretty fat download, so grab a bite to eat while 
the sucker gets pumped through to your drive.

Important note: As long as you're mucking about on the Web, it's best if you download and read the 
Dark Sun manual from the DataSphere. (It's available in Adobe Acrobat PDF format and a reader 
should be provided with the manual.) That'll explain everything you need to know about creating a 
character, adventuring and combat in the harsh world of Athas.

The first screen that appears is the Dark Sun Arena Selector screen. Mr. Bandwidth will pop up here 
to check your connection, but he's pretty lenient. He'll only toss you if you're really messy. FYI, this 
screen's just a waypoint for the real stuff. Hit GO to travel to the Outer Sanctum.

The Outer Sanctum is a little like the astral plane. It's a chat area where you can pick up some tidbits 
from TENguides or shoot the stuff with other Dark Sun players. Many of the commands are the same 
as on regular Arenas, so check there for the particulars.

Each player in Dark Sun has a TEN screen name and a Dark Sun character name. The Outer 
Sanctum shows a list of the TEN screen names, so don't be surprised if you fail to see these names 
deep in the world of Athas.

When you're ready to dive in, hit ENTER. Keep that sword and shield handy.



Arena Selector screen
Here's where Mr. Bandwidth, the bouncer at the gates of TEN, checks your connection so you can 
choose which Zone and Game Arena you want to play in. Arenas are the launching point for games 
on TEN.

Swipe at the screen below if you're curious about something. Otherwise, once Mr. Bandwidth is 
finished, just click an Arena (the text in green) and hit GO.

As soon as you arrive, Mr. Bandwidth will start boppin' to a funky jive. Sit back. He's evaluating your 
position on the Internet relative to TEN. When he makes his exit, your Zones and Arenas are all set 
up.

Arenas under the "Your Best Zone" rating are ones that you're more likely to have good gameplay in. 
If you choose to play in Arenas under the category "Playable Zones", you might not have quite as 
good a game. "Chat-only Zones" contain Arenas where all you can do is chat.

Each Arena (except ones in AD&D Dark Sun: Crimson Sands) can hold around 40 people. An Arena 
is full if it's got a  symbol displayed in front of it. Try another. There'll always be at least one open. 
"Unranked Arenas" are ones that don't affect your overall game rankings. Think of them as a safety 
net. Help Arenas are staffed with TENguides and are there in case you need some online help setting
up a game.



SELECT AN ARENA
These are the available Game Arenas. The number to the right of each Arena is how many people are currently 
in that Arena. A  symbol means the Arena is full and you have to choose another one.

Sometimes, the Arena names are designed to indicate what skill level of game the people therein are playing. For 
example, in this Duke Nukem 3D area, "Rookie" is an Arena for beginning-level players.



GO
Once you've picked a Game Arena, hit this button to dive on in.



Back button
Click this arrow to go back to Game Selector screen.



DataSpheres button
Selecting this button launches your selected Web browser and surfs you over to this game's DataSphere for 
news and important information.



Description box
Shows the low-down on whatever Zone, Arena or category you've highlighted above. Remember, you're only 
allowed to enter Arenas (the stuff above in the green text)



The game
It's the wild and wonderful game you're about to play!



What are Zones?
What the heck are Zones? Ethereally speaking, Zones are localized regions in cyberspace. They 
have nothing to do with physical geographic regions. You may be dialing from Seattle and get a better
connection through our router in the Midwest than through our California router.

Why are there so many Arenas, Zones and categories? Since there can be hundreds, if not 
thousands, of people on TEN at once, we needed to break up the traffic a bit. Think of Arenas and 
Zones as the equivalent of Internet traffic lights. Here's a run-down of the Zones on TEN based on 
how you connected to TEN:

· If you connected through a TEN local access number, Your Best Zone is more likely to be in 
Valhalla. If you're using your own Internet service provider, it's not worth even trying to use this 
Zone—you won't get the best results. But, you are welcome to go in and chat!

· If you're on the East Coast and are connected through your own Internet service provider 
(ISP), Your Best Zone is probably going to be in The Abyss.

· If you connected through your own ISP and are not on the East Coast, Your Best Zone should be 
in Pandemonium.

This isn't to say that all folks on the East Coast connecting with their own ISP will get a better 
connection through The Abyss (the reverse goes for Pandemonium), it depends on a number of 
factors: clean phone lines, a quality ISP, the stars aligning properly, etc.

Remember that players in one Zone won't be able to see (or play with!) players in another Zone. So, 
be sure to coordinate Zones with your pals before starting up.

Mr. Bandwidth's Zone Check
Once you enter an Arena Selector screen, your pal and mine, Mr. Bandwidth will pop up muttering 
something about "checking Zones." What he's doing is seeing how clean your connection is to the 
Internet as a whole.

When he's done, he'll arrange the Zones in a logical order. Click on a description for the definition.

Your Best Zone

Playable Zones

Chat-only Zones

Help Zones 



Your Best Zone
Your Best Zone is where you should be playing the majority of your games.

How come? Based on how you connected to TEN, Based on your connection, we've determined that 
Arenas in this Zone will give you the best gameplay. You're more than welcome to play games in 
Arenas under the Playable Zones category, but you're not as likely to have a quality game there.

Some games that don't require lighting-quick gameplay (e.g., turn-based games like Panzer General 
and Deadlock) don't actually need separate Zones based on your connection. Therefore, we tossed 
all games of that nature into the Pandemonium Zone so that everyone playing that game could see 
everyone else.. So, don't worry if you're used to getting "Your Best Zone" in Valhalla, but suddenly get
Pandemonium when you enter an Arena Selector.



Playable Zones
Based on our Zone check, we've determined that all Arenas in the Playable Zones category are 
playable with your connection—although you probably won't experience the same high-quality 
gameplay as you would in Arenas under Your Best Zone.

Even though you can only have one "Best Zone", Zones and Arenas in this category should still be 
more than good enough for you to play.



Chat-only Zones
Chat-only Zones contain Arenas where, due to your connection quality, all you can do is chat. You 
won't be able to play any games here. This is primarily due to your connection method. We've set up 
our Zones based on how you connected to TEN and in geographic regions. If you're in one 
geographic region that isn't "compatible" with one of our others, you won't be able to play in that 
Zone.

You're always welcome to come on into the Arenas in these Zones and type up a storm. Good 
conversationalists are hard to find!



Help Zones
While not technically a Zone, Help Zones contain Help Arenas where you can usually find a 
TENguide to answer your TEN- or game-specific question. Don't be shy. No question is too small.

In addition, we provide the Rookies' HQ —a place 'specially made for newcomers to the TEN service.
Here, you can meet other new folks and get assistance from the "Guide"s that staff these Arenas. 
They're more than willing to meet you, help out and get you started with TEN!

You won't be able to play games in these Arenas, but you should always get a helping hand!



Game Arenas
Game Arenas are the place to create and join games as well as chat with other players that have the
same gaming interest as yourself.

The Game Arena consists of a few things: a WHO'S HERE list in the upper left corner that shows the 
current group of people in the Arena, a large chat window that displays all chat text, a GAMES list of 
games in the creation process or already underway. Selecting a game from the GAMES list shows you 
WHO'S PLAYING in that game as well as the GAME DESCRIPTION.

Need more information? Find out more about the Game Arena screen.



Help Arenas
Help Arenas look similar to Game Arenas, but have a radically different function. Our friendly 
TENguides staff the Help Arenas just waiting for people to drop by and ask them a question. You 
wouldn't want to disappoint them now, would you?

The biggest changes from Game Arenas is that Help Arenas (and Chat Arenas) have an extra-large 
chat window for plenty of typing space and they don't have any game creation abilities. They're great 
for meeting places and gathering points from which you can head off to a Game Arena.



Rookies' HQ
The Rookies' HQ is the one-stop help shop for new folks to TEN. Here, we have a well-trained staff 
of TENguide volunteers called "Guide"s (as well as MagnaGuides) anxiously waiting for new people 
to drop by and ask questions. They'll be more than happy to engage you in witty conversation or 
perhaps engage you in a game!

Guides can normally be found in the Rookies' HQ from 5 PM to 9 PM Pacific Time.



Special Arenas
Occasionally, we'll create Special Arenas where we'll hold conferences or tournament events. 
Tournaments will be held in Game Arenas, while a conference would be held in a Chat Arena.

For tournaments and moderated conferences, a number of the normal chat rules may not apply. So, 
don't get confused if you enter one of these Arenas, start blabbing away and not seeing any of your 
chat text. We gots some speshial crowd-control tools to keep the noise level down.



Game Arena screen
At last! One small step away and the games begin. As usual, pass your pointer over an area to get 
the straight dope.

As soon as you enter an Arena, Mr. Bandwidth will begin testing your connection to this Arena. Be 
patient. He's going as fast as he can. Check out the gauge just below him to see how long he'll take. 
While you're waiting, chat a bit or see what games are being played.

After Mr. B's done, he'll present you with your connection rating du jour. If you're displeased and think
you deserve better, give Mr. B a smack on his little buggy head. He'll respond by showing you a 
Connection Report.

The list of players in this Arena appear in the WHO'S HERE list in the upper left. Want an explanation 
about the icons next to their names?  Each player's screen name will appear in this list and in ranked 
Arenas, their score will be displayed to the right of their name.

When you're ready, just select a game from the GAMES list and hit JOIN. What are those icons in the 
GAMES   list?    The first time you CREATE or JOIN a game, you'll be prompted to browse your hard drive 
for that game. And, if there aren't any other open games, CREATE   one of your own  !



GAMES list icons
Games with a  are full and you can't enter. Forbidden games 

 have too heavy a bandwidth requirement for you to join.
When you CREATE or JOIN a game and enter the game pre-launch panel, you'll see other players' connection ratings 
(as a cute Mr. B head) next to their name in the Who's Joined list.



WHO'S HERE list icons
There are only a few icons that might appear to the left of each player's screen name, but they're pretty 
important.

If a person's got a  icon, that player has been away from their computer for a while and won't be able to 
respond. When a 

 icon appears, you have muzzled that person. If the 
 icon is next to their name, they are in the process of creating a game. And, finally, the 
 icon means that player is involved in a game.



Location bar
Tells you where the heck you are. This reminds you which Zone you're playing in and what Arena you've 
selected. For example, you might be in the Pandemonium Zone in the Veteran Arena.



WHO'S HERE?
The list of TEN members currently in the Arena. Players with a  in front of their name are busy playing and 
might not be listening for their name. When they've got a 

 next to their name, they're in the pre-launch state of a game, so they may or may not be paying attention to the 
main window. Those that have a 

 before their name are muzzled so you won't hear their yap. If they've got a 
 icon in front of their name, they're probably off surfing the Web 'cause they haven't been at their computer in quite

some time.
In ranked Arenas, each player's score will be listed to the right of their name. You can sort players by name or 
score by clicking on the gray buttons at the top of this window.

Right-clicking on someone in the WHO'S HERE list will allow you to check their Profile and Latency and will let you
Page, Whisper or Muzzle them.



Back arrow
Takes you back to the Arena Selector screen to choose a new Arena.



Mr. Bandwidth
The lovable Mr. Bandwidth will test your connection and give you the high sign if your Internet connection is 
worthy. You can also scope out a couple of other tidbits. Visit Mr. Bandwidth if you are curious about our little 
friend.

Your connection rating  is displayed just below Mr. Bandwidth's head. It'll be rated either Excellent, Good, OK or
Forget It. If one of these words doesn't look right to you, get the scoop about testing your connection. When the 
gauge below Mr. B's head says "Testing," the small bar shows how long the test will take. Don't worry, you can 
still look through games and chat while he performs his little duty.

If your connection quality changes, Mr. Bandwidth's expression will get happier or even more agitated.



Chat window
Everything you and the other peoples here type will appear in this window for the world to see. Scroll up and 
down through the text so as not to miss any stimulating conversation. Click here to find out more about chat.



Chat entry space
Enter your purple prose in this space and click SEND to launch your words a-flyin'. Hitting Enter will let them 
loose as well. You've got about 200 characters to use per message, so brevity is not a concern.



SEND
This fires off your latest words of wisdom. Once sent, you can't take them back.



GAMES
Here's a list of all the current games. Games with a  are closed and those with a 

 icon are forbidden. You can't get in these games no matter how hard you try. Closed games are full up, while 
forbidden games are off limits because your bandwidth is too low for you to join.



WHO'S PLAYING?
All the folks already involved in a game appear here. Click on a game in the GAMES window and you'll see all the
names of players in that game. Just to the left of their name, you'll see a happy little Mr. Bandwidth icon which 
shows their current connection rating.



GAME DESCRIPTION
Here, you can see the charming text entered by the creator of a game. Click on a game in the GAMES window to 
highlight it and this description will appear. Since this was written by another player, the description may be 
useful, useless or a heap of barking obscenities.



CREATE
Fire up a new game. This is available only if you haven't created or joined another game. And if your connection 
is "Forget it," well…

After hitting CREATE, you'll see the Create Game dialog box. Enter the name of your game, the number of 
players you want to play with (if appropriate) and a brief description of your game. When you're finished, you'll be
sent to the game pre-launch panel.



JOIN
Select a game from the window and hit JOIN to enter it. Remember that games with a  symbol have all their 
player slots filled and you can't join. If their bandwidth requirement is too high, you'll see the Forbidden symbol 

.



Chatting with folks
Do you like striking up conversations with total strangers? Even if you don't, this area is perfect for 
finding just the right blend of players to join in your mayhem.

It's très easy. Plop your cursor in the long black area to the left of the SEND button and start pounding 
away at the keyboard. When you exhale and finish a thought, click the SEND button or just hit Enter. 
Your message will whiz through cyberspace faster than another Microsoft stock split. And there it is. 
In living green. Your message to the world on screen.

If you just want to talk to one person, you can Whisper them a message. Right-click on their name in 
the WHO'S HERE window and choose "Whisper". This will put a "/w <name>" on the chat entry line 
(where <name> is the screen name of the person you will be whispering to). Type your message and 
click SEND. No one will see it but them. Meet that special friend. Poke fun at the guy typing in ALL 
CAPS. Party hardy.

And if you get tired of listening to someone ramble on and on about the mating habits of Peruvian 
llamas, just Muzzle them and you won't hear any of their chat conversation. Right-click on their name 
in the WHO'S HERE window and choose "Muzzle". This sticks a  to the left of their name. Now, you 
can't hear them, and they can't Page or Locate you.



Creating a game
No games out there you want to play? Start one up yourself! Hit CREATE to get started. This'll bring up 
a dialog box for you to enter some specifics.

At the top, type a witty name for your game. To the right of that, enter the total number of players 
(including yourself) you'd like to have in the game. Remember that you can't have more people in 
your game than Mr. Bandwidth says you can. How many can you have? Check your connection info 
for your bandwidth rating.

You'll also see a large window within the dialog box to describe your game. Write out as detailed a 
description as you want. You can also try to deter others with lousy connections or those you don't 
deem worthy of your efforts. Be as creative as you want.

Click OK when you've set up all your options. This'll open up the game pre-launch panel where you 
can hang out while waiting for others to join your game.

For information on creating specific games, check out the following list:

AD&D Dark Sun: Crimson Sands

Blood   retail  

Blood   shareware  

Command & Conquer

Command & Conquer: Red Alert

Diablo

Duke Nukem 3D

EF2000 V2.0

Magic: The Gathering

Master of Orion II

Myth: The Fallen Lords

NASCAR Racing Online Series

Quake

Shadow Warrior   retail  

Shadow Warrior   shareware  

Total Annihilation

Twilight Lands

Wiz-War



Game pre-launch panel
Whenever you CREATE a new game or JOIN a game that hasn't started up yet, you'll enter the game's 
"pre-launch panel". The pre-launch panel takes up the bottom half of the Game Arena screen, but 
leaves you plenty of space to people watch in the WHO'S HERE list and gives you ample space to chat 
in the main Arena.

Here's what the pre-launch panel looks like when opened (click around for details):

LAUNCH starts up the game and DESTROY completely kills it. Careful, people might get pissed. Click 
the down arrow (next to the DESTROY button) to "minimize" the pre-launch panel and take a peek at 
the GAMES list and GAME DESCRIPTIONS.

The top status bar of the pre-launch panel displays the name of the game, the creator and how many 
players (out of the total number specified) have joined. There's a separate Who's joined list and 
Game description for this game and even a separate chat window that only the joined people can 
see.

If someone joins your game that you didn't want there, click their name in the Who's joined list and hit 
DISMISS. They'll get the boot and won't be able to come back.

Right next to the players in the Who's joined list you can see a mini-Mr. B icon that shows their 
current connection rating.



Game status bar
Shows the name of the game, the Creator and the number of players who have joined (e.g., the number 3/4 
means that 3 players have joined the game and the game was created for 4 players).



LAUNCH button
Starts the game with the current players.



DESTROY button
Eradicates the game you have created. Only the creator of the game can hit this button.



Pre-launch up/down button
This arrow will "minimize" or "maximize" the pre-launch panel. When you minimize it, you'll only see the game 
status bar, and the LAUNCH and DESTROY buttons.



Who's joined
Lists the people who've joined this game so far. The Mr. B icon next to their name shows their current connection
rating.



DISMISS button
Highlighting a name in the Who's joined list and clicking DISMISS will punt that person from your game, never to 
return. Only the creator of the game can DISMISS players.



Pre-launch game description
A brief description of the game you're about to play. Shows the number of players and any other pertinent info.



Pre-launch chat window
A pint-sized chat area for folks who've joined this game. Only the people who've joined your game can see this 
chat text.



Pre-launch chat entry space
Enter a thought and hit SEND. Only the folks who've joined your game will see this text.



SEND button
Sends off your chat text to everyone who's joined this game.



Playing Duke Nukem 3D
If you're playing Duke Nukem 3D and want to play using one of the many user-created levels out 
there, hit the ADVANCED button on the Create Game dialog box. You'll need to have some custom 
user-created levels already installed in your Duke directory. Where can you get user-created Duke 
levels? Why, the File Factory, of course!

When the ADVANCED box opens, click the check box next to USER MAP and then choose a custom level
from the pull-down list on the right. Hit OK when you're satisfied with the results.

Remember, all people playing this user-created Duke level must have that level installed on their own 
local machine. In addition, all user-created Duke levels must be located in the same directory/folder 
as the Duke3d.exe file.

Once you've got your game all set up, you'll go to the pre-launch panel. Now, just hang around until 
enough people join your game, then hit the LAUNCH button.

After Duke loads, the person creating the game needs to choose "Start User Map" from Duke's main 
menu to fire up the user-created level they chose.



Playing Blood (retail version)
The Blood Create Game dialog box is fairly self-explanatory, but since this is a Help file, we lay 
everything out on the table for ya.

Enter a name in the Name field then put a Description of your game in the field below. To the left of these
entries, choose the maximum number of players you want in the game by clicking the up and down 
arrows in the Max Players box. If you click the Ranked box just below that, this game of Blood will count 
toward your overall Blood ranking.

The seven pull-down menus in the middle of the box set up how your game is to be played:

On the left, the Game option allows you to play in either Bloodbath (free-for-all), Teams or Cooperative 
mode. Episode and Level allow you to choose any of the Blood levels available in the retail version of 
the game. Difficulty sets how hard (and how many) monsters will appear when the Monsters setting is 
enabled.

On the right, the Monsters setting puts creatures of various types into the game. Weapons sets how often
the various tools of destruction appear. Finally, Items allows you to control how often non-weapon 
items respawn.

If you want to play a custom Blood level (like ones available on the File Factory), click the User Map 
box and pull down a level from the drop down menu. Important: all user maps must be in the same 
directory as your bldrten.exe enabler file! 

Hit OK to launch the game!



Playing Blood (shareware version)
The Blood Create Game dialog box is fairly self-explanatory, but since this is a Help file, we lay 
everything out on the table for ya.

Enter a name in the Name field then put a Description of your game in the field below. To the left of these
entries, choose the maximum number of players you want in the game by clicking the up and down 
arrows in the Max Players box. If you click the Ranked box just below that, this game of Blood will count 
toward your overall Blood ranking.

The seven pull-down menus in the middle of the box set up how your game is to be played:

On the left, the Game option allows you to play in either Bloodbath (free-for-all), Teams or Cooperative 
mode. Episode and Level allow you to choose any levels in the first episode of Blood. Difficulty sets how 
hard (and how many) monsters will appear when the Monsters setting is enabled.

On the right, the Monsters setting puts creatures of various types into the game. Weapons sets how often
the various tools of destruction appear. Finally, Items allows you to control how often non-weapon 
items respawn.

Hit OK to launch the game!



Playing Command & Conquer
Each time you crank up a game of Command & Conquer, you need to fill out an options dialog box. If 
you've played C&C before, this box should be fairly routine. If one of the terms doesn't look right to 
you, break open the game manual. They didn't write it for their health, you know.

First off, type in a name for your game in the top slot. Next to it, type in how many players you want in
your game (from 2–4). Under SCENARIO, pick a mission, any mission. (You can even play missions 
from C&C scenario packs such as C&C: The Covert Operations.) Now, choose a SIDE from the pull-
down menu.

The next three sliders set up starting parameters for your game. CREDITS, UNIT COUNT and TECH LEVEL 
should be self-explanatory. The boxes below set on/off variables. (AI PLAYERS can be clicked if you 
want computer opponents as well as humans.) Finally, write a description of your game in the big box 
on the right where Carol Merrill is standing.

Once you hit OK, you'll be shot into the pre-launch panel. When the number of players in your game is
the same as the number of players you selected, just hit the LAUNCH button and you're off!



Playing Diablo
The Diablo Create Game dialog box is fairly straightforward, but there are a few things we can 
explain.

To begin, type a name for your game in the GAME NAME area (16 characters max). Just to the right, 
use the up and down arrows to set the MAX PLAYERS you want in the game (from 1–4). (Remember, 
only characters played in multiplayer games can be used on TEN. Single player characters won't 
work in multiplayer games.)

Next, type in a DESCRIPTION of your game in the middle box. Use this area to encourage or 
discourage types of players and characters and to generally set up the ambiance of your game.

Finally, click the PASSWORD check box if you only want to restrict your game to certain people. Once 
you click the password check box, type in a password (up to 16 characters long). Each person joining
a game must type in this exact password in this box to play your game.

Password tip: To let certain people know your password without announcing it to the entire Arena, 
right-click their name in the Who's Here part of the Arena (in the upper left) and select "Whisper." This'll 
put a "/w" in front of their name in the chat entry space. Now, go ahead and type in a private message
for them only.

When you hit OK to create the game, you'll open up the pre-launch panel. Once you get the number of
players in your game that you want, hit the LAUNCH button and your game will begin.

After a game is created...
Once a Diablo game has been created, the GAME DESCRIPTION (in the lower right part of the Game 
Arena screen) will display each character's name, level and character class.



Playing Command & Conquer: Red Alert
Whenever you fire up a game of Command & Conquer: Red Alert, you have to fill out an options 
dialog box. If you've played C&C: Red Alert before, this box should be fairly obvious. If one of the 
terms doesn't look right to you, it's time to read the manual. You know what I'm talking about. It's that 
book that everyone opens for installation and then puts on the shelf next to the moldy bean dip.

First off, type in a name for your game in the top slot. Next to it, type in how many HUMAN PLAYERS you
want in your game (from 2–8). Just below the number of players, click which VERSION you will be 
playing: WINDOWS 95 or DOS. (Make sure you have the raten95.exe file in your Red Alert directory if 
you're playing the Windows 95 version or the raten.exe file if you're playing the DOS version.)

Under SCENARIO, pick a mission, any mission. Now, choose a SIDE from the pull-down menu.

The next three sliders set up starting parameters for your game. CREDITS, UNIT COUNT and TECH LEVEL 
should be self-explanatory. The boxes below set on/off variables. (AI PLAYERS can be clicked if you 
want computer opponents as well as humans. Note that there can only be a combination of 8 humans
and computer opponents in one game.) Finally, on the right, whip out a description of your game in 
that large, overstuffed box.

Once you hit OK, you'll be fired right into the pre-launch panel. When the number of players in your 
game is the same as the number of players you selected, just hit the LAUNCH button and your game 
will begin!



Playing Magic: The Gathering
Important note: First off, the most complete information on using the ManaLink software with TEN 
can be found in the ManaLink readme.txt file. We highly recommend you read and print out this 
document before diving into ManaLink. This doc should answer most, if not all, of your questions 
about playing Magic: The Gathering on TEN.

The following instructions assume you understand the basic workings of the Magic: The Gathering 
rules and the Magic: The Gathering software. Any rules questions or questions about the Magic: The 
Gathering interface can be answered in the Magic: The Gathering instruction manual.

The Duelists' Battleground
On the left side of the screen, you'll see all the Magic players currently in this Duelists' Battleground (if
they're away from their computer, you'll see the familiar "zzz" next to their name). The large window to
the right displays all the chat text goin' on. Just below that, you can enter your chat for the "world" to 
see.

If you want to chat just with one individual, you can "Whisper" to them. Simply right-click their name, 
and choose the "Whisper" option. Now, type in a message that only they'll be able to see.

Hit the ENTER button to dive into the world of Magic: The Gathering! From here, you'll be using the 
ManaLink software to play games. Check the ManaLink readme.txt file for complete details on 
using ManaLink.



Playing Master of Orion II
First off, you need the latest version (version 1.2) of Master of Orion II before you can play. Once you 
have that installed and the CD is in the CD-ROM drive, get ready to warp!

If you want to restart a saved game, click the box next to LOAD SAVED GAME. This is also useful in case
someone gets accidentally disconnected from the game or if the game happens to crash. When one 
of these happens, the creator of the original game should CREATE a new game, click LOAD SAVED 
GAME, and then pull up the saved game file. Everyone who was previously in the game before should 
join and then choose exactly the same alien race they were playing when the game terminated. You 
might lose a turn or two, but the game should play along fine.

After you click OK, you'll open up the game's pre-launch panel. When the right number of players join 
your game, just whack the LAUNCH button and you'll be underway.



Playing Myth: The Fallen Lords
The Myth battle is about to begin...

Plunk out a name for your game in the Name field and type a detailed Description of your challenge in 
the box below. This will be the primary way for people in the Myth Arenas to see what kind of game 
you plan to set up.

Note: The Description box is the most important part of the Myth game creation. It lets others in the 
Arena know what map and scenario you plan to choose from the Game Options screen in Myth.

Just to the right oft he Name field, use the arrows next to the Max. Players box to select the maximum 
number of players you want in your game. Just under that, you can select the color scheme for your 
Coat of Arms. This should reflect your primary and secondary colors of your army (see below).

Click the Password check box if you only want to restrict your game to certain people. Once you click 
the password check box, type in a password (up to 16 characters long). Each person joining a game 
must type in this exact password in this box to play your game.

Password tip: To let certain people know your password without announcing it to the entire Arena, 
right-click their name in the Who's Here part of the Arena (in the upper left) and select "Whisper." This'll 
put a "/w" in front of their name in the chat entry space. Now, go ahead and type in a private message
for them only.

Now, choose a Team Name for your Myth squad in the field at the bottom of this box. Just below that, 
you can choose the Primary Color and Secondary Color for your army.

Myth Game Options screen
When you've made all your settings on our Create Game dialog box, you'll see the Myth Game 
Options screen. This is where you'll make all the game-related selections for your game, including 
scenario, map and other factors. Your options here should reflect the ones you described in the 
Description box when creating a game.



Playing Quake
Before you and your pals can check in to Gib City, you gotta fill out the stuff here. Options on this 
screen should be familiar to you Quake-heads, but there are a few tricky parts. (Note: players who 
JOIN a game can only choose the SHIRT and PANTS options and some COMMAND LINE PARAMETERS on 
this screen.) 

Unlike other fast action games, 14.4 modem people won't bog a Quake game down when they play 
with 28.8 or ISDN+ connections. Unfortunately, the 14.4 people will be dragging a little behind.

Tip to those of you with 14.4 modems: if you set your SERVER SPEED at a low rate, you'll bring down
the speed rate of all players in the game to your level. Good for you, but then getting people to join 
your game is another story…

To begin with, type in a NAME for your game in the first slot. To the right, enter how many people 
(including yourself), you'd like to play in the game. Below the game name slot, choose one of the 
Quake EPISODES and on the next slot down, pick a LEVEL in that EPISODE to be your starting point. The
next line is the FRAG LIMIT. Move the slider all the way to the left to turn the FRAG LIMIT OFF. Just below
that is the TIME LIMIT. Pushing the slider all the way to the left turns the TIME LIMIT OFF. Clicking 
DISABLE JOYSTICK saves a wee bit of memory by shutting down your 'stick.

Now comes the biggie—SERVER SPEED. This determines how many packets per second you want to 
send to each player. The more bandwidth you have the more packets you can send across. And the 
more packets you can send, the smoother gameplay you will experience. Here are some rules of 
thumb. If your worst bandwidth offender is using a 14.4 modem, you won't want to set the SERVER 
SPEED any higher than 10. If the lowest player is using a 28.8 modem, don't set it above 12. Finally, 
on an ISDN, T1 or T3 line, you can set SERVER SPEED as high as 15. If you find yourself sliding around
on some levels, try lowering the server speed. You'll be a little slower, but you'll gain more control.

The next two options are TEAMPLAY 1 and TEAMPLAY 2. These are mutually exclusive—you can play 
either one or the other, but not both. TEAMPLAY 1 is standard team play: when players that have the 
same color PANTS shoot each other, they won't do any damage (they'll just shred away the other guy's
armor). TEAMPLAY 2 is a different story. With TEAMPLAY 2, you can do damage to all team members 
(folks with the same color PANTS), and if you happen to kill one of your pals, you'll lose 1 frag. Ouch! 
(TEAMPLAY 2 may not work with some Quake C mods, so be warned.)

If NO EXIT is checked, all the fragging action will take place only on the specified level. COOP PLAY, 
when checked, indicates that all players in the game are cooperating to finish the level, whereupon 
they will go to the next level of the episode. (This is the only mode where monsters will be in the 
game.) DEATH MATCH is the opposite of COOP PLAY. It's an all-out free-for-all where it's kill or be killed. 
(This is the default option.)

DIFFICULTY LEVEL indicates the toughness of the episode and level in COOP PLAY. SHIRT and PANTS are 
used to customize your Marine. If you're playing a TEAM PLAY game, players on your team must have 
exactly the same color pants as others on the team.

EXTRA COMMAND LINE PARAMETERS allows you to put in DOS command line stuff for special doohickies.
Check out the Quake DataSphere for complete details.

Just below the description box on the right are a list of TEN-supported Quake C SERVER MODS. These 
are nifty additions to your standard Quake game allowing you to fire missiles that look like zombies, 
wear a "skin" that looks like Mr. Bandwidth, or much more. (You can only play with one SERVER MOD at
a time.) If you want to play with a mod, pull it down from the list. The description will appear in the box
below.



Playing Shadow Warrior shareware
You drive like a baboon in heat! The Shadow Warrior Create Game box is pretty easy, but here are all
the steps laid out for you.

Bang out a name in the Name field then type a Description of your game in the field below. To the left of 
these entries, pick the maximum number of players you want in the game by clicking the up and 
down arrows in the Max Players box. Just below the Max Players box, you can choose the Player Color of 
your ninja. If you click the Ranked box just below that, your Shadow Warrior game will become a 
ranked game. Finally, at the bottom, choose one of the four shareware Levels available for play.

The four pull-down menus in the middle of the box set up how you can play your game:

On the left, the Game Type option allows you to play in either WangBang (Spawn or No Spawn) or 
Cooperative mode. The "Spawn" aspect sets whether items are regenerated or not. Monsters sets how 
hard and how many monsters (if any) will appear during your game. The default is "No Monsters".

On the right, Kill Limit sets how many frags you want to play for, while Time Limit sets a barrier for the 
amount of time you want to play any particular level (before it switches to another level). Both Kill Limit 
and Time Limit are defaulted off.

Finally, the check boxes at the bottom allow you to turn Team Play on or off. (When Team Play is on, you 
can use the Hurt Teammate check box to wax yer friends.) Markers checked on will display small icons to 
indicate where items will respawn. Finally, Play With Nuke gives you the option to "Drop the Big One" on 
your enemies.

Hit OK to launch the game!



Playing Shadow Warrior retail
I love the shuriken! The Shadow Warrior Create Game box is pretty easy, but here are all the steps 
laid out for you. For those of you familiar with Shadow Warrior shareware game creation, there's only 
a couple of differences.

Bang out a name in the Name field then type a Description of your game in the field below. To the left of 
these entries, pick the maximum number of players you want in the game by clicking the up and 
down arrows in the Max Players box. Just below the Max Players box, you can choose the Player Color of 
your ninja. If you click the Ranked box just below that, your Shadow Warrior game will become a 
ranked game. Finally, at the bottom, choose one of the four shareware Levels available for play.

The four pull-down menus in the middle of the box set up how you can play your game:

On the left, the Game Type option allows you to play in either WangBang (Spawn or No Spawn) or 
Cooperative mode. The "Spawn" aspect sets whether items are regenerated or not. Monsters sets how 
hard and how many monsters (if any) will appear during your game. The default is "No Monsters".

On the right, Kill Limit sets how many frags you want to play for, while Time Limit sets a barrier for the 
amount of time you want to play any particular level (before it switches to another level). Both Kill Limit 
and Time Limit are defaulted off.

Also, the check boxes at the bottom allow you to turn Team Play on or off. (When Team Play is on, you 
can use the Hurt Teammate check box to wax yer friends.) Markers checked on will display small icons to 
indicate where items will respawn. Finally, Play With Nuke gives you the option to "Drop the Big One" on 
your enemies.

Finally, clicking User Map will allow you to select a custom Shadow Warrior user map from the pull-
down box on the right. You must have your user maps in the root level of your Shadow Warrior 
directory and all players playing your game must have the map on their local computer.

Hit OK to launch the game!



Playing Total Annihilation
Total Mayhem. Total Strategy. Total Annihilation!

You want real-time strategy? You got it, pal. Creating a Total Annihilation game is remarkably easy, 
but here's the lowdown just in case.

Type out a name for your game in the Name field and type a Description of your challenge in the box 
below. Just to the right, use the arrows next to the Max. Players box to select the maximum number of 
players you want in your game.

Note: The below settings are entered by the game's creator as a courtesy to anyone thinking of 
joining the game (the settings will be shown in the Game Description). When the creator enters the 
Total Annihilation Battleroom, however, these settings must be manually inputted before the game 
begins.

First off, you'll need to set the amount of starting Metal and Energy for your game. Next, choose a game
Map to play on. The information following the map name displays the size (in screens) of the map as 
well as the amount of RAM you need on your computer to play that map.

Dead Commander has three settings: Ends (your game ends if your Commander dies), Continues (the 
game continues as normal if your Commander dies), and Deathmatch (you get a new Commander if 
your original Commander dies, but your forces start over).

Line of Sight provides three options: Circular (units see things within a certain radius—unobstructed by 
terrain), True (units see things within a certain radius, but terrain will block your vision), and 
Permanent (once an area of terrain is "seen", it will always be visible to check up on).

Locations allows you to determine your starting point, either in a Fixed position or Random. Finally, the 
Mapping option lets you view the map Mapped or Unmapped. Mapped shows you the entire playing 
area, terrain and all. Unmapped completely hides the terrain until scouted by your troops.

Finally, click the Password check box if you only want to restrict your game to certain people. Once you 
click the password check box, type in a password (up to 16 characters long). Each person joining a 
game must type in this exact password in this box to play your game.

Password tip: To let certain people know your password without announcing it to the entire Arena, 
right-click their name in the Who's Here part of the Arena (in the upper left) and select "Whisper." This'll 
put a "/w" in front of their name in the chat entry space. Now, go ahead and type in a private message
for them only.



Playing Twilight Lands
Twilight Lands is an online fantasy role-playing game that is exclusive to TEN. You can't play it 
anywhere else! The game was created by those design wizards at ICE Online who put a ton of effort 
into making it fun and rewarding for role-players everywhere.

Before you begin, you'll need to download the Twilight Lands software. It's available au gratis (FREE!)
from within TEN by going to the File menu and choosing "Download Files... " or from the Twilight 
Lands Web site at http://www.ten.net/twilight. That Web site is the key source of 
information about Twilight Lands on TEN—it includes how to play, where you can sign up for an e-
mail mailing list on the game and links on various game-related subjects.

When you enter the Twilight Lands Arena, you'll see a list of players on the right. This Arena is the 
staging area for the game and a good place to talk to people just arriving or departing from the 
Twilight Lands world.

Once you click the ENTER button, you'll launch the Twilight Lands game. (The first time you hit this 
button, you'll be instructed to locate the twilight.exe game file on your computer.) This will take 
you to the Twilight Lands main menu, where you'll have three options: "create new character", "enter 
world" and "exit".

If you don't have an existing Twilight Lands character, hit the "create new character" option. This easy
jaunt will guide you through the character creation process.

When you choose the "enter world" option, you'll be mystically transported into another realm. Keep 
your eyes open, your hand at your sword and enjoy!



Playing Wiz-War
Grab a tasty refreshment and a few salted munchies, fire up your computer and get ready to pay the 
funnest lil boardgame this side of the Pecos. Wiz-War is here and, yes, it's based on the popular mini-
boardgame you see at every gaming convention known to man. So, download the software, fire up 
TEN and launch those fireballs!

First, whack out a Name for your game in the top field and enter a Description in the box right below that.
Next, choose the Max Players you want to play with (from 2–4, including yourself). The Ranked Game 
checkbox, when checked, makes this game count toward your Wiz-War ranking.

Right below that, you can set a number of game-related options. Time Per Turn lets you choose how 
much time each player has to make their move before they forfeit their turn. Allow Watchers is a 
checkbox that lets other people not playing to view your game. If the Allow Joining After Launch box is 
checked, players who didn't join the game when it was initially created can jump in and play. Finally, 
Join as Watcher is a checkbox that lets you just jump in and observe without taking place in the action.

Hitting OK will launch the battle!



Playing EF2000 V2.0
Get your EF2000 V2.0 manual out, sim-heads, you're gonna need it! Remember that EF2000 V2.0 is 
a high-end flight simulation and requires a lot more thought and knowledge of flight simulation, air 
combat and the EF2000 V2.0 interface than can be discussed here. With this section, we're just 
gonna discuss the options on how to get it up and running. For more details on EF2000 V2.0 and its 
user-interface, please consult the EF2000 V2.0 manual.

To begin, type a name for your game in the Game name area Just to the right, use the up and down 
arrows to set the Max players you want in the game (from 2–8).

Next, type in a Description of your game in the middle box. Here's where you might want to let people 
know what flight scenario you plan to create once you get in the game.

Finally, click the Password check box if you only want to restrict your game to certain people. Once you 
click the password check box, type in a password (up to 16 characters long). Each person joining a 
game must type in this exact password in this box to play your game.

Password tip: To let certain people know your password without announcing it to the entire Arena, 
right-click their name in the Who's Here part of the Arena (in the upper left) and select "Whisper." This'll 
put a "/w" in front of their name in the chat entry space. Now, go ahead and type in a private message
for them only.

When you hit OK to create the game, you'll open up the pre-launch panel. Once you get the number of
players in your game that you want, hit the LAUNCH button and your game will begin.

Once you get within EF2000 V2.0...
...is another story. After the game creator hits LAUNCH from the pre-launch panel, EF2000 V2.0 will 
load up and all players will see a screen of "currently linked players." When everyone hooks up to the 
game, this screen will disappear and the EF2000 V2.0 main menu will appear.

On the main menu, the game creator gets to choose a number of game options. In the upper left, 
choose either Quick Combat or Simulator. Quick Combat is a free-for-all deathfest, where aircraft zip about. 
Team Play allows you to choose a color for your aircraft and play with your friends against a common 
enemy. Base Defense is exactly what it says.

In Simulator mode, you have a little more flexibility with the creation of your EF2000 game, but with the 
sacrifice that it's a little more complex to set up. First, choose the type of game you want to play 
(Basic Training and Weapons Training are disabled), and then choose a mission. You'll get a ton of 
options when selecting certain game types—please refer to the EF2000 V2.0 manual for any user-
interface questions.

After you have your mission set up (in either Quick Combat or Simulator), you'll be able to configure your 
weapons loadout. Once that's done, you're ready to take to the skies!

Important note: When you're setting up a mission, you'll have the option to put in a ton of friendly 
and enemy aircraft. Don't go wild. The more aircraft you add, the more bandwidth they take up and 
the worse performance you'll get. Try to keep it to a reasonable number for gameplay sake.



Joining a game
Find a game you want from the GAMES window and hit JOIN. As always, you can't enter any games 
with the  symbol, since they're all full. Games with the 

 have too stringent a bandwidth requirement for you to play. When you're joining a Duke game, check 
the GAME DESCRIPTION window to see if the creator is playing with a user-created level. If so, make sure 
you've got that level on your machine!

When you hit JOIN, you'll either go right into the game (if it's already started) or to the game pre-
launch panel where you go into a short holding pattern before the game starts.

If you think you have reached your connection rating in error, click Mr. Bandwidth for more info or call 
AAA for a jump start.



Welcome to the NASCAR Racing Online Series
Are you ready for some racing? You've come to the right place, bub. We'll give you all the drive-time 
excitement you can handle and plenty more.

The NASCAR Racing Online Series is the brainchild of Papyrus (the developers of NASCAR Racing 
2—the simulation you need to play NROS) and TEN. With a copy of NASCAR Racing 2 and the TEN 
software, you'll be able to race your stock car against other drivers from across North America.

Although NROS is fully integrated into the TEN software, players entering the NROS   Arena Selector   
and NROS   Game Arenas   will see some differences in the way these screens are set up. The Arena 
Selector is fairly straightforward, but the Game Arena has a number of additional features.

We highly recommend you use the >> button at the top of this Help file to cruise your way through all 
the NROS screens just to get a feel for what's new and what's changed. If you're fairly familiar with 
the TEN interface, you might want to just check out the NROS   Game Arena   screen and the section 
on creating an   NROS   race  .

One important thing to remember. Once you finish an NROS race, you'll need to click Leave Race to 
return to the main chat area. Got it? Now, floor it!



NROS Zones and Arenas
What the heck are Zones? Ethereally speaking, Zones are localized regions in cyberspace. They 
have nothing to do with physical geographic regions. You may be dialing from Seattle and get a better
connection through our router in the Midwest than through our California router.

Why are there so many Arenas, Zones and categories? Since there can be hundreds, if not 
thousands, of people on TEN at once, we needed to break up the traffic a bit. Think of Arenas and 
Zones as the equivalent of Internet traffic lights. Here's a run-down of the Zones on TEN based on 
how you connected to TEN:

· If you connected through a TEN local access number, Your Best Zone is more likely to be in 
Valhalla. If you're using your own Internet service provider, it's not worth even trying to use this 
Zone—you won't get the best results. But, you are welcome to go in and chat!

· If you're on the East Coast and are connected through your own Internet service provider 
(ISP), Your Best Zone is probably going to be in The Abyss.

· If you connected through your own ISP and are not on the East Coast, Your Best Zone should be 
in Pandemonium.

This isn't to say that all folks on the East Coast connecting with their own ISP will get a better 
connection through The Abyss (the reverse goes for Pandemonium), it depends on a number of 
factors: clean phone lines, a quality ISP, the stars aligning properly, etc.

Remember that players in one Zone won't be able to see (or play with!) players in another Zone. So, 
be sure to coordinate Zones with your pals before starting up.

TEN's Zone check
Once you enter the NROS   Arena Selector screen  , TEN will begin its flag-waving procedure as it sees 
how clean your connection is to the Internet as a whole.

The Zones
When the test finishes, all the Zones will appear from top to bottom from best to worst. Click on the 
stuff below for a description:

Your Best Zone

Playable Zones

Chat-only Zones

Help Zones

The Arenas
Now that you've got a handle on what the Zones are, here's a brief overview of the different kinds of 
Arenas:

Game Arenas

Help Arenas

Rookies' HQ

Special Arenas



NROS Arena Selector screen
Here's where TEN checks your connection quality so you can choose which Zone and Game Arena 
you want to play in. Arenas are the launching point for games on TEN.

Swipe at the screen below if you're curious about something. Otherwise, once our connection test is 
finished, just click an Arena (the text in green) and hit Go to Arena.

Arenas under the "Your Best Zone" rating are ones that you're more likely to have good gameplay in. 
If you choose to play in Arenas under the category "Playable Zones", you might not have quite as 
good a game. "Chat-only Zones" contain Arenas where all you can do is chat.

An Arena is full if it's got a  symbol displayed in front of it. Try another. There'll always be at least 
one open. "Simulation Arenas" are Arenas that use the NASCAR Racing 2 Simulation mode, while 
"Arcade Arenas" are ones that use a less-realistic arcade-style mode. Help Arenas are staffed with 
TENguides and are there in case you need some online help setting up a game.



Go to Arena
Once you've selected an Arena from the above list, click here to go, go, go!



NROS Game Arena screen
Finally! You've made it to the NASCAR Racing Online Series Arenas. Now the fun begins! Click on 
the graphic below for quick-and-dirty pop-up help on a particular area of the screen:

Once you enter a NROS Arena, TEN will fire up a test to see how good your connection is to this 
Arena. After the test is complete, you'll see your connection rating in the form of a racing flag (either 
green, blue, yellow or red). If you want more details, just click on the flag. This'll pull up your 
connection report.

There are two buttons in the upper left: News and Race. News shows a quick overview of the news or 
news headlines on the NROS Web Site. Race is where you can see all the races in progress. The 
default when you enter the Arena is News.

The list of players in this NROS Arena appear in the Who's Here list in the lower right. Want an 
explanation about the icons next to their names?  Each player's screen name will appear in this list.

When you're ready to play, just select a game from the list at the top and hit Join Race. The first time 
you hit Create Race or Join Race, you'll be prompted to browse your hard drive for the nros.exe game 
enabler (or nrosrend.exe for the Rendition version). And, if there aren't any races to your liking, 
create one of your own!



News
This brings up the news or news headlines from the NROS Web Site. This is the default whenever you enter a 
NROS Arena.



Race
Clicking this button allows you to see a window with all the races currently in progress or being formed.



Connection Rating flag
This flag shows your current connection rating. It'll be rated either EXCELLENT (green), GOOD (yellow), OK 
(blue) or FORGET IT (red).



NROS button bar
This list of buttons provides category information on the races listed below. Clicking one of the gray buttons will 
sort the races by that category. If you right-click on the button bar, you can customize which buttons you see 
here. The little black square in one of the buttons indicates that it is the currently sorted category.



Race list
The Race list displays which races are currently being formed or are already in progress. The races are sorted 
by the gray button bar directly above the list. If you right-click on a particular race, you can see who's currently in 
that race.



Create Race
If you don't see any races to your liking, hit this button to take you to the NROS Create Race screen.



Join Race
Hit this button to jump into an already-created race. It'll open up the Race Chat window for that race or simply 
launch you directly into the race.



Race Chat tab
Clicking this tab will allow you to chat with other people who have joined the race you're in.



Arena Chat tab
This tab will bring you to the general Arena chat area where you can chat with the masses. As the Arena gets 
fuller, additional "chat tabs" will open up, keeping the noise level down.



Chatting with other drivers
Looking for that stick shift maniac you talked to the other night? Need to crow about your latest 
glorious victory? The chat area's the place to do it.

It's as easy as pie. Just put your mouse cursor in the long black area to the left of the Send button and 
start pounding away at the keyboard. When you exhale and finish a thought, click the SEND button or 
just hit Enter. Your message will whiz through cyberspace faster than another Microsoft stock split. 
And there it is. In living green. Your message to the world on screen.

You'll notice that there may be more than one "chat tab" in the chat window. That's because once an 
NROS Arena gets too many folks rubbing shoulders with one another, it automagically creates a new 
chat window. People in one chat window won't be able to see chat in the other windows, FYI.

If you just want to talk to one person, you can Whisper them a message. Right-click on their name in 
the Who's Here window and choose "Whisper". This will put a "/w <name>" on the chat entry line 
(where <name> is the screen name of the person you will be whispering to). Type your message and 
click Send. No one will see it but them. Meet that special friend. Taunt the guy typing in ALL CAPS. 
Party hardy.

And if you get tired of listening to someone ramble on and on about the mating habits of Peruvian 
llamas, just Muzzle them and you won't hear any of their chat conversation. Right-click on their name 
in the WHO'S HERE window and choose "Muzzle". This sticks a  to the left of their name. Now, you 
can't hear them, and they can't Page or Locate you.



Creating an NROS race
Now comes the meaty stuff. Creating your first NASCAR Racing Online Series race is a piece of cake
if you're familiar with the NASCAR Racing 2 options. This screen basically replaces the first couple of 
screens you would see en route to creating a race in single player NASCAR Racing 2 mode.

At the top of the dialog box, the Style field displays what type of NROS Arena you're currently in (either
a Simulation Arena or Arcade Arena). The Password check box and field allows you to enter a secret 
password so that only people with that password can join your race.

Password tip: To let certain people know your password without announcing it to the entire Arena, 
right-click their name in the Who's Here part of the Arena (in the lower right) and select "Whisper." This'll
put a "/w" in front of their name in the chat entry space. Now, go ahead and type in a private message
for them only.

Track & Length
The Track pull down menu lets you choose which track you want to race on. Your Skill Level at this track 
displays how proficient you are on this particular track (the range goes up to 15, where 15 is the 
highest Skill Level you can attain for a track).

Race Length is a percentage of the total laps normally associated with the event for this track. For 
example, if you chose the Daytona track at 10%, you would have a 50 lap race (since Daytona is a 
500-lap event). Practice Length is the amount of time everyone has to practice before the race. Garage 
Time is the amount of tuning time between the practice and the actual race. Both Practice Length and 
Garage Time are measured in minutes.

Racers
Minimum Racers determines the smallest number of drivers that will allow the race to begin. Maximum 
Racers is the highest number of drivers allowed in this race. Minimum Skill Levels indicates the minimum 
skill level a driver must have to join this race. Maximum Skill Levels sets the highest skill level that can 
join this race.

Rules
Yellow Flags sets whether yellow flag laps are enabled or not. Pace Lap controls whether an initial pace 
lap will be run before the race starts. Night Race (only available on some tracks) determines if the race 
will be run in a darkened atmosphere. Player Breakdowns, when set, throws a random element into the 
mix allowing for potential random mechanical failures during a race.

The Damage setting is a realism setting. It'll either be Arcade (damage to a car will do very little to its 
performance), On (damage highly affects driving ability) or Off (no damage will occur to any car in the 
race).

Weather
Weather can be either Constant (set by the variables below) or Random (decided randomly by the 
simulation). For Constant weather, the following options apply:

Temperature determines how hot or cold the weather is (in degrees Fahrenheit).Wind Speed allows you to 
set the ferocity of wind at the track. Finally, Wind Direction lets you control the direction of any incoming 
breezes.

Ending a race
Once a race is over, you'll return to the NROS Game Arena. Remember, you have to click the Leave 
Race button in order to join or create a new race.



Checking race status
The Race window at the top of the screen shows all the races currently in progress or about to begin. 
There's a couple semi-hidden functions here when you use your mouse to right-click certain things.

There's a small black square in the upper right-hand corner of one of the buttons in the gray button 
bar. This indicates which race option the list of races is being sorted by. When you click a different 
button, that black square will switch to the new button you clicked.

Button bar
If you right-click the gray button bar at the top of this window, you'll be presented with three options: 
Sort Ascending, Sort Descending and Customize List.

Sort Ascending will sort races and race options in ascending alphabetical order. Sort Descending 
will do the reverse—sort races and race options in descending alphabetical order.

Customize List allows you to choose which race options are displayed in the Race window. You have 
the choice of any combination of the following options: Track/Status, Race Creator, Style, Race Length, Session, 
Number of Racers, Skill Level, Player's Skill Level, Damage, Practice Length, Garage Time, Weather, Temperature, Wind 
Speed, Wind Direction, Yellow Flags, Pace Lap, Night Race and Player Breakdowns. All these options are explained 
in the NROS   race creation dialog box  .

Race list
When you right-click on the Race list, you'll be shown a list of all the TEN members currently playing 
(or waiting) in that race.



Joining an NROS race
Ready to burn rubber? Just find a race you want from the Race window at the top and hit Join Race. As 
always, you can't enter any games with the  symbol, since they've reached their max capacity.

When you hit Join Race, you'll either go right into the race (if it's already started) the Race Chat window
where you go into a short holding pattern before the race starts. The creator of the race will launch it 
when he's good 'n' ready. Got your seatbelt fastened?



Leaving an NROS race
When you finally finish your NROS race, you'll be dropped back into the NROS   Game Arena  . 
However, instead of seeing the normal Create Race and Join Race options, you'll see a Leave Race button.

You must hit the Leave Race button to officially exit your last race before you can join a different NROS 
race.



NROS connection ratings
Each time you enter a new NROS Arena, TEN will run a little test to check the quality of your 
connection to this Arena and Zone. It changes from time to time due to a number of factors: storms on
the Internet, router glitches, or if your ISP is having a bad hair day.

When the rating's finished, you'll get one of the following:

EXCELLENT Wow! Premium motor oil. The best.
Normal for high-speed Internet connections (ISDNs, T1s and such).

GOOD Playable. Average. A little rubbing on the left rear.
Basic rating for modems with a good Internet service provider.

OK Not too bad. Could be better. Your tires low on pressure.
Weird. We've got suggestions to improve your connection.

FORGET IT Stinky. Blows chow. Major collision!
Ugh. Must be something wrong. Checked your cables lately?

If you need a more detailed information or want to check your latency history, click on that racing flag 
in the middle of the left side of the screen.



NROS connection report
Your NROS connection report shows a whole pit crew worth of useful data. Our words of advice 
appear at the top, telling you how many people can be involved in a game you CREATE or JOIN based 
on your connection to the Internet and the parameters of the game in question (this number includes 
you, by the way).

Just below that, we've has already kicked the tires and provided an NROS   connection rating   free of 
charge.

The two buttons at the bottom (Latency History and Diagnostics ) will pop up more detailed info if you 
really want to go that far.



NROS latency history
In this screen, you'll see a wonderful color-coded graph. The squiggle running along the bottom of the
graph is your latency over the past few minutes. In general, the lower it is on the graph, the better.

Along the left side of the graph is a colored bar which relates to your connection quality. If your 
average latency falls (without spikes) within the green area, you've got an Excellent connection. The 
higher your average latency is on the graph, the worse connection rating you've got. Zoom in and out 
of the graph with the + and - buttons in the lower left.

We've got more details on latency . You can also check out your NROS   diagnostics   or get more info 
on your NROS   connection rating   .



NROS diagnostics
Your diagnostic information is basically a breakdown of your connection rating.

Connection speed is how quick you can send and receive data—your latency. If you have a low 
reading here, you'll probably be experiencing more "lag" than usual.

Stability is how clean your connection is to the Internet. The higher the percentage is on this scale, 
the more scrubbed down your connection is and the less spikes you will receive that break up your 
game.

Maximum players is the largest number of players that can be in a game with you (including 
yourself). This maximum number will change from game to game and is directly related to your 
bandwidth.

Hope that helped! If not, you may want to try the latency or bandwidth help areas. Mr. Bandwidth 
might also be able to provide assistance with his little Internet tutorial.



Connection ratings
Each time you enter a new Arena, Mr. Bandwidth will run a little test to check the quality of your 
connection to this Arena and Zone. It changes from time to time due to a number of factors: storms on
the Internet, router glitches, or if Mr. B ate some bad fish and is feeling a little queasy.

When he's done, he'll pop up with one of four ratings:

EXCELLENT Wow! USDA Prime. The best.
Normal for high-speed Internet connections (ISDNs, T1s and such).

GOOD Playable. Average. Not too chunky.
Basic rating for modems with a good Internet service provider.

OK Not too bad. Could be better. Grade B-.
Weird. We've got suggestions to improve your connection.

FORGET IT Stinky. Blows chow. Get out of town!
Ugh. Must be something wrong. Checked your cables lately?

If you need a more detailed explanation or want to check your latency history, click on his 
luminescent head. He won't mind.



Mr. B's Connection Report
Your Connection Report shows a whole truckful of useful data. Mr. B's words of advice appear at the 
top, telling you how many people can be involved in a game you CREATE or JOIN based on your 
connection to the Internet and the parameters of the game in question (this number includes you, by 
the way).

Just below that, Mr. Bandwidth has already kicked the tires and provided a connection rating free of 
charge.

The two buttons at the bottom (LATENCY HISTORY and DIAGNOSTICS) will pop up more detailed info if 
you really want to go that far.



Latency History
Here you see a wonderful color-coded graph. The squiggle running along the bottom of the graph is 
your latency over the past few minutes. In general, the lower it is on the graph, the better.

Along the left side of the graph is a colored bar which relates to your connection quality. If your 
average latency falls (without spikes) within the green area, you've got an Excellent connection. The 
higher your average latency is on the graph, the worse connection rating you've got. Zoom in and out 
of the graph with the + and - buttons in the lower left.

There's more on latency. You can also check your Diagnostics or find out more about your 
Connection Rating.



Diagnostics
Your Diagnostic Information is basically a breakdown of your Connection Rating.

Connection speed is how quick you can send and receive data—your latency. If you have a low 
reading here, you'll probably be experiencing more "lag" than usual.

Stability is how clean your connection is to the Internet. The higher the percentage is on this scale, 
the more scrubbed down your connection is and the less spikes you will receive that break up your 
game.

Maximum players is the largest number of players that can be in a game with you (including 
yourself). This maximum number will change from game to game or may be gone altogether if not 
relevant to the game you're playing. This number is directly related to your bandwidth.

Hope that helped! If not, you may want to try the latency or bandwidth help areas. Mr. Bandwidth 
might also be able to provide assistance with his little Internet tutorial.



About Mr. B

Ah, yes. Mr. Bandwidth. The Master of Modems. The Lord of Latency. The Concierge of Connection. 
He comes from a land that latency forgot. Packets roaming free in the wild. The secret formula for 
Vernors whizzing by the secret formula for Bubble Up. We took Mr. Bandwidth away from all that fun 
and put him to work.

Now for the nitty gritty. Mr. Bandwidth is a strange little guy we hired to make sure everyone could 
connect to TEN. He can't actually fix your connection problems, you understand. But, he can give the 
boot to folks with lousy connections who would otherwise screw up everybody's fun.

So, Mr. B is your friend. Unless you're the one feeling his pointy foot on your butt.

We've tried to teach Mr. Bandwidth to moderate his usual savagery. Now, instead of just killing 
anyone with a crummy connection, he helps them make it better.

There are two important factors to playing fast-action games (like Duke Nukem 3D) across the 
Internet. The first is your Connection Rating which is determined by the latency of your connection. 
The second is the number of players you can join or create a game with, which is determined by 
your bandwidth.

You don't have to give a damn about this stuff if you don't want to. All you really have to know is what 
Mr. Bandwidth tells you when he checks your connection. Play games in Arenas within Your Best 
Zone and don't try to join games that are forbidden  due to your bandwidth.

Mr. B's got his own little Internet primer if you're interested.



Mr. Bandwidth explains the Internet
First, the bad news: the so-called information superhighway isn't really much like a highway. It's more 
like the road system in Outer Kazakhswana, complete with dead ends, switchbacks, washouts, cul-
de-sacs, corrupt officials in toll booths, and backwater hellholes where they still eat human flesh. 
Yikes.

Now, the worse news: playing fast-action games across the Internet is a lot like staging the Indy 500 
in Kazakhswana. It's difficult, dangerous and frankly, kinda stupid. Or to put it in the words of the first 
and last Kazakhswanan pit chief: "Ho, ho, ho! Many dead!"

But it can be done.

First, let's see what you already know about the Internet. Choose the metaphor below that, in your 
opinion, best represents the Net:

Model "I believe the Internet is"
The "Al Gore" A busy commuter highway, with lots of vista points and Stuckeys.

Wired "Infobahn" Trés chic. Cyber-sexy. Vinyl. Chrome. Coooooooool.

The Hose A really big hose, only for data instead of water and with a billion nozzles.

NetWarrior A brutal, desolate place where the strong rule and wimps die screaming.

An example (kinda)
One of the more curious aspects of the Internet is that long-range communication has a whole lot less
impact than in real life. It's all about the cleanliness of your connection, the time it takes for a small bit
of info to go back and forth (latency) and the amount of data you can pass back and forth 
(bandwidth).

Picture it like this. Say you're on a playground where one loud, obnoxious, fast-speaking kid is across
the park and a pudgy, laryngitis-ridden stutterer is staring you in the face only a few feet away. 
Following me so far?

If they both burst into "I Am the Walrus" at once, what's likely to happen (other than you running for 
the nearest exit)? The bellowing, quick speaker will probably communicate "koo koo ka joob" faster 
and cleaner than the wheezing, fat boy. Even if the portly kid is so close, that he's probably slobbering
on your new Reeboks. The talking speed of the fast speaker could be considered bandwidth, while 
his speech clarity (compared to the hoarse-throated stutterer) could be considered latency.

Didn't that clear things up? No? Ok, then check out the definitive answers under latency and 
bandwidth. Metaphors are tough work.

If you're having latency, bandwidth, or connection problems (ones that aren't a fault of the network), 
we can provide some pointers and helpful tips. Check out how to get even with Mr. Bandwidth.



The "Al Gore"
What?!? Get outta here!



Wired "Infobahn"
Not bloody likely.



The Hose
Nice try. You're getting warmer.



NetWarrior
Ah! The right answer. Now that we've removed any comforting illusions you may have held, let's continue.



Don't get mad at him, get even
Really, Mr. B isn't there to screw you or kick you out of games. Think of him as a camp counselor, 
making sure everyone has fun and plays fair.

There are ways you can get a more reliable connection without having to park your rear at your local 
phone company to get a high-priced, clean ISDN line.

Latency concerns
One way latency increases is due to the number of jumps you have to make before you connect to 
TEN. Minimizing latency means getting the most direct link to your target as humanly possible. TEN's 
preferred Internet providers are set up so that you should never have more than a couple of hops 
before you arrive here. Less robust providers may end up plowing through a dozen or more routers. 
With that kind of latency, you'll be lucky to play Parcheesi.

Latency can also be affected by other factors. General congestion on the Internet (primarily during 
peak surfing hours) or through your Internet provider can add significantly to your latency.

Bandwidth issues
Bandwidth is directly related to the overall speed of your connection. The faster the modem you have,
the better. Don't try to connect to TEN with your 300 baud acoustic coupler—it ain't gonna work.

Don't get overly pre-occupied with the speed of your modem, though. Even though you may have the 
be-all, end-all of 28.8 modems, you still may get a flaky connection if you use an Internet provider 
who runs his business out of some flooded Chicago basement on rat-eaten wires. To have the best 
gameplay, all players should have reliable, high-speed modems with squeaky-clean Internet 
providers.

General stuff
In the long run, if you have an Internet service provider that consistently gives you crappy results, you
may need to make a change to use TEN effectively. Dialing in through one of our local access 
numbers should improve your connection to TEN.

You might also have line difficulties or modem problems. Older modems tend to be less efficient, and 
can add significantly to your latency. Line problems are a little trickier to deal with. You could always 
try negotiating with Guido and Nunzio at the phone company, or make sure your cat's not chomping 
on the phone line.



What is latency?
To put it simply, latency is the time it takes for you to send a packet of info to a site and for the site's 
response to get back to you. Contacting really distant regions (like, on another continent) may take 
more time and sometimes even local sites can be hard to reach, because the road the data takes to 
get there is full of twists and turns.

Let's take an everyday, common Web task. Suppose you're connecting to the Net through Big Bob's 
Discount Web Hut in Los Angeles and heading for a German site with detailed instructions for building
a fusion bomb. Bob's Web Hut tries to find a route. First, it sends your signal through Chuck's big 
regional server. Chuck shunts you to a big hub in Detroit. Detroit plugs into a site in Germany ("where
there are no laws"), which then zips over to Gregor's regional server and finally waltzes up to Nuke-it-
Yourself (www.nukeemsilly.com).

Your signal has bounced between five different routers before reaching its destination. The amount of 
time it takes for the nuke site to bounce an information packet back to you is referred to as "latency," 
and is usually measured in milliseconds.

Suppose you have a relatively high latency—a second. Since you can wait an extra second for the 
first atomic-core blueprint to start rezzing, this is no big deal.

However, if you were instead trying to play a rousing round of Duke Nukem 3D, a one-second delay 
would send you straight to Chop City. A delay of one second between you hitting your fire button and 
that rocket whooshing off to roast your pal, is ugly. Way ugly.

In other words, latency is a fact of life on the Internet. Minimizing it is the hardest issue, but there are 
things you can do to help. Mr. Bandwidth has some entertaining notions of the topic of minimizing 
latency. Check him out.



What is bandwidth?
Now, latency has nothing to do with how fast your modem is. Bandwidth, on the other hand, has a 
whole lot to do with it. The Golden Rule of Bandwidth is this: the more people participating in 
something, the slower that something gets. Say you're playing Quake. When you fire off a missile,
that data has to be shot over to all other players. If there's just one other player, the info travels really 
quick. But, if you're in a six-player game, that same missile packet has to zip to all five other people 
so they can tell if they're suddenly paste or simply hit by the splatter. That takes more time.

Many greasy old cyber-relics will yap your ear off about how fast things used to be, back in hippie 
days when there were only 14 people who knew what the Internet was—but that was then, and this is
now.

Anyway, when it comes to games, the problem is this: every game has a "bandwidth budget." Each 
and every player who joins that game consumes part of the budget. The amount they use up varies 
for several reasons, but modem speed is the primary factor. A game that could support eight 28.8k 
modem users might only be able to support four 14.4k modemers—even if the 14.4 guys have the 
Lamborghini of all Net providers.

Think of it this way. There's only so much room in each game. The slower your modem, the fatter you 
get. A game that could fit eight slim 28.8k modem users might only be able to fit four pudgy 14.4k 
guys.

When you're on TEN, Mr. Bandwidth will analyze your connection to tell you how good your gameplay
quality will be (latency) and how many players you can be in a game with (bandwidth). But, 
sometimes the Net gets wacky. If your Excellent connection one day tells you to Forget It, don't panic.
Try retesting it first. You may have been caught in a brief spike.

If you're really having problems, there are some things you can do to increase your bandwidth. Mr. B 
will be happy to explain!



What the heck are you talking about?
Internet? Latency? ISP? Help! I ain't got a clue!

No prob.

The Internet and modems
Let's begin assuming you know absolutely nothing about the Internet. Start with a clean slate. 
Basically, the core of the Internet is a whole ton of computer networks around the globe that folks like 
us can connect to. They are all linked up so that people on one computer network can access data on
another network in the system. We can connect (or "sign on") to one of these networks either at the 
network computer's location or through our home computer.

To connect to these computers from our house, we have to have a computer, a phone line and a 
connection device called a modem. Now, modem stands for MOdulator/DEModulator and is a device 
to convert digital signals into tones so they can be sent over regular phone lines.

How does all this relate to the Internet and this World Wide Web?

The Web
The Internet is the massive linking of computer networks with a techie overtone. The World Wide Web
is simply a cosmetic makeover of all that raw data so that the average person can easily get the 
information—sometimes relevant, but generally completely irrelevant—about anything you do or don't
want to know. On the Web, it's sometimes hard to separate the wheat from the chaff. Especially if 
you're allergic to chaff.

You access the Web by using a computer program called a "browser." The most popular ones are 
made by Netscape and Microsoft. To connect to a location on the Web, you need to find its Universal 
Resource Locator or URL (pronounced "you-are-ell"). An example URL address would be 
www.ten.net. When typing this into your browser, it is preceded by the letters "http," a colon ":" and 
two forward slashes "//". So, when you're typing our address into your browser, it would appear as: 
http://www.ten.net. Now, you can finally see for yourself what all those TV ads are blaring when
they dropkick their URL at you.

Mail without stamps
One of the more handy features of the Internet is the ability to instantaneously shoot off an electronic 
mail message to a friend across town or across the country. Electronic mail (or e-mail, for short) can 
be sent to anyone that has an Internet account through school, work or home. You read an e-mail 
message either through your Web browser or via an e-mail program like Eudora Light.

You'll need to know their specialized e-mail address which looks something like 
gilmour@surfcity.com. gilmour is the person's name, surfcity is the computer service's 
name and com is the type of service the computer is. This last part can be one of the following: .org 
(organization), .com (commercial), .net (network), .edu (education) or .gov (government).

In conclusion (for now)
This is really only the tip of the snowcone. There's a lot more stuff out there about FTP (File Transfer 
Protocol) sites, Java and the overall lay of the Internet landscape. If you're really curious, pick up one 
of those "Dummies" books by IDG or just peruse your local bookstore. They've got racks and racks of
Internet tomes, one of which will be just your speed. We've also got some information on Mr. 
Bandwidth and the Internet, latency and bandwidth if you need it. There's also some hints on how to 
choose your own Internet service provider.

Good luck!



Where do I get the latest news and info about the TEN 
service?
Good thing you asked! Super-duper up-to-the-second information can be found in the TEN News 
Web pages. These pages are updated on a regular basis and is the best place to find out about news
and other kick butt events.

While we try to keep the Help file as up to date as possible, circumstances beyond our control 
prevent us from having a new Help file on a semi-regular basis. The best place to find out about any 
these frequently asked questions (FAQs), troubleshooting solutions and the like is by going to the 
Support menu and choosing "FAQ Web Site".

You can also check out TEN's home page at www.ten.net for general and corporate information, 
the File Factory  for shareware, patches, uploads, user-created Duke Nukem 3D levels and other 
chaos and the various DataSpheres for complete info on most of the games we support.



What times will TEN be down for maintenance?
We have regular network down time for maintenance and upgrades on Tuesdays, Thursdays and 
Saturdays between 6–8 AM Pacific Time. So, don't be surprised if you can't sign on during those 
times.

There may be other times where TEN is unavailable due to major overhauls and so forth, but we'll try 
to keep those to a minimum. We'll also try to warn you in advance of those times.



How do I cancel my TEN account?
This is a test

dfasdf



How do I connect to TEN?
With TEN's client software, you can connect to TEN though your own Internet connection or from one 
of TEN's local access numbers across the United States. (These local access numbers provide a 
PPP Internet connection). You can reach TEN through any Internet service provider (ISP) which 
provides a PPP or SLIP account.

Online services such as America Online, Prodigy and CompuServe all offer PPP connections to the 
Internet, but be warned. Your latencies will likely be quite high and may not be appropriate for fast-
action games like NASCAR Racing 2, Quake and the like. You should still be able to play turn-based 
games like Wiz-War and our role-playing games like Dark Sun Online.



How can I tell if my service provider is compatible with 
TEN?
In general, you can access TEN through any Internet service provider that gives you SLIP or PPP 
access. TIA and other SLIP emulators simply won't work properly.

You will need to determine if you TCP/IP protocol is properly configured, however.

To determine if your TCP/IP protocol is configured properly for TEN, try "pinging" a TEN site via its IP 
address. PING (Packet INternet Groper) is a diagnostic utility which sends packets of information to a
known IP address and waits for a reply. To ping our site, follow these steps:

1. Verify that you have the dialup adapter installed by going to Start --> Find --> Find Files or 
Folders. Once there, type ping.exe and press Enter. If you see ping.exe, things are cool and 
you can bop on over to Step 2.

If you don't see ping.exe here, then the dialup adapter is not installed or you are using an OEM 
version of Windows 95 which is missing these standard files. You'll need to have the Windows 96 
dialup adapter installed on your computer to properly use TEN.

2. Establish your Internet connection through your Internet service provider.

3. From the Start menu, select Programs --> MS-DOS Prompt. This will open a DOS prompt.

4. At the DOS prompt, type ping darkride.ten.net and press Enter. After you hit Enter, you'll 
get one of three possible responses to this ping:

a) Reply from 204.162.251.33: bytes=23 time=264ms TTL=251
You should get four rows of stuff that look similar to this. This is a goooood response and shows 
that you can communicate with TEN. If you get this, you should be A-OK.

b) Bad IP address darkride.ten.net
You should first verify that the ping line was entered correctly and try again. If you still get this 
response, you'll want to try the numeric address. Go back to the MS-DOS prompt and type ping
204.162.251.33 and press Enter. If you now receive a good response (as shown in response 
"a" above), you may have a DNS problem. Check out your DNS settings by following the 
instructions under the "DNS settings" header.

c) Destination host unreachable.
This typically means that Windows 95 doesn't realize you are connected to the Internet. Make 
sure the you are using the Windows 95 dialup adapter and not a different dialer or winsock. You 
may want to contact your Internet service provider for more information.

DNS settings
Follow these steps to check your DNS settings:

1. From the Start menu, select Settings --> Control Panel.

2. When this window opens, double-click the Network icon.

3. From the list of installed components, select "TCP/IP" and click the Properties button.

4. Select the DNS Configuration tab.

5. Be sure the Enable DNS radio button is selected.

6. If you are using a your own ISP, the DNS Server Search Order should reflect the address(es) 
given to you from your provider or system administrator in addition to this number. If you are 
using a TEN local access number for your Internet access, the DNS Server Search Order should 
be 204.162.251.2.

If no DNS addresses are present, contact your system administrator, call your ISP directly or refer



to the documentation provided by your ISP.

7. Keep clicking OK until you return to the Control Panel window.

If both pings are successful, you should be able to connect to TEN.

Remember, a successful connection to TEN does not guarantee a high-speed connection or low 
latency by any stretch of your vivid imagination.

tracert command
You can also try the same procedure above use the tracert (Trace Route) command to see how 
many hops you're going through to connect to TEN. (Example: from the DOS prompt, type tracert 
darkride.ten.net.)

More than 10 hops is getting dicey; more than 20 means you're probably dialing in from Mars. The 
number of hops does not necessarily create problems, but more hops increase the odds that a 
problem may occur.

If neither ping is successful, you are not configured properly to connect to TEN, or you do not have an
acceptable account type (you need a PPP, SLIP or direct connection).

Note: ping and tracert are utilities installed when Windows TCP/IP Network Protocol is installed.



Is TEN accessible from all existing online services?
No way! TEN is not accessible from independent online services such as America Online, Prodigy 
and CompuServe. If you have any questions regarding your Internet service provider account, we 
recommend that you contact your individual ISP.



I forgot my password. Hellllp!
Whoa! Don't panic. Call our Customer Service at 1-800-8040-TEN during regular business hours.



How do I disable call waiting?
Oh yes. It is 100% necessary to disable call waiting if you want to connect to TEN without 
interruption.

First, check with your local phone company to verify the call waiting disable code. *70 is very 
common with touch tone phones and 1170 is most often used with rotary phones. Within Windows 95,
you can disable call waiting under Dialing Properties.

The following steps will disable call waiting in Windows 95 (where *70 is the call waiting disable 
code):

1. From the Start menu, select Settings --> Control Panel.

2. When this window opens, double-click on the Modems icon.

3. Click the General tab.

4. On the General tab, click the Dialing Properties button.

5. Click the box in front of the "This location has call waiting. To disable it, dial" prompt. Then use 
the pull-down box to the right to select *70.

6. Keep clicking OK until you return to the Control Panel window.

Some communications software has additional locations where this option can be configured. In 
those cases, the software may override the Windows 95 settings. If this happens, consult your 
communications software reference manual or call the manufacturer to find out how to change the 
call waiting code.



How do I use TEN's local access numbers to connect to 
TEN?
After you finish installing TEN, launch TEN from the Start menu by selecting Programs -->
T E N and choosing Total Entertainment Network.

Once TEN has been launched and the Sign On screen appears, follow these directions:

1. Click the SETTINGS button. The Connection Settings window will open.

2. Choose the option "Select one of TEN's local access numbers" and click OK. The Select Local 
Access Number will open.

3. In this window, type the area code where you are dialing from to jump to that area or scroll 
through the list of numbers until you reach the nearest area code and phone number.

4. Once you pick a number, click the OK button to return to the Sign On screen.

Type in your screen name and password and you're connected.

Remember, if you use one of TEN's local access numbers to connect, you may incur additional 
charges to your account. Check out your billing report from the Support menu by choosing "Display 
Billing Report" for more details.



How do I use my own Internet service provider to connect
to TEN?
Before signing on to TEN, you'll need to connect to the Internet through your Internet service provider
using either a SLIP or PPP account. (If you've got a direct connection through school or work, go 
through your standard Internet connection procedure.) Remember, America Online, Prodigy and 
CompuServe don't have SLIP/PPP accounts, so you can't use them to connect. Also TIA and shell 
accounts are not compatible with TEN.

Once you've got an Internet connection established, launch TEN from the Start menu by selecting 
Programs --> TEN and choosing Total Entertainment Network. When the Sign On screen appears, 
follow these instructions:

1. Click the SETTINGS button. The Connection Settings window will open.

2. Make sure that the "Use my direct Internet connection" option is checked, then click OK.

When you type your screen name and password, you're connected.



How do I choose an Internet service provider?
Not all Internet service providers (ISPs) are created equal. It's not as simple as selecting a telephone 
long-distance carrier. For the most part, all long-distance phone companies have roughly the same 
quality connection and service. They have to, wouldn't they? Otherwise they'd be out of business!

Choosing an ISP is more akin to selecting an airline to travel on. Some may be cheaper overall, but 
will skimp on the peanuts and constantly overbook. The more expensive ones may cost a ton more, 
but provide warm hand towels after meals. ISPs are the same way. Not all cheap ISPs are the best 
buy, nor are all expensive ISPs the bee's knees.

The best way to find a service provider is to ask your friends which ones they're using. They have the 
most experience with their particular ISP and can tell you if it bites or rules. Barring the advice of your 
buds, here are some questions you can ask the ISP sales reps themselves:

Q: What types of connections are available? SLIP, TIA, PPP?
Remember, only SLIP and PPP accounts will be able to connect to TEN.

Q: Will I be able to connect within my local calling area?
If there isn't a local number within your calling area, you'll be paying toll charges. And, boy, can 
they add up quickly!

Q: How much will the service cost?
This is the biggie. ISP costs can vary wildly. Generally, ISPs charge a base monthly rate, some 
will add on a per hour charge after a specified number of hours. Some ISPs offer both types. 
Depending on how much time you plan to be logged on, you can choose which type of account 
you want. For instance, if you plan to spend a great deal of time logged on, you might want to 
consider a flat monthly rate account which gives you unlimited hours of time per month. If you 
don't plan on spending a great deal of time logged on, you may be able to find an account with a 
lower monthly rate that includes a limited amount of hours per month (any time over your 
specified number of hours will be billed at a per hour rate). It's a matter of shopping around.

Q: How many subscribers does the ISP have, and how fast have they been growing?
Not only is the Internet expanding, but the number of people jumping on is growing like kudzu. 
Good ISPs gain subscribers quickly, but sometimes growth can overwhelm their systems. Ask 
about peak periods of use and the frequency of busy signals when dialing in.

Q: What is the ratio of subscribers to modems?
When you dial into your ISP, your modem connects to theirs. Busy signals mean the ISP's 
modems are all in use. A ratio of 15 to 1 or 20 to 1 could mean a lot of busy signals.

Q: What support options are provided?
When will someone be able to answer technical questions? If you are planning this account for 
your home, will there be someone available to help you when you need it, or just during business 
hours? Are there e-mail representatives online? How often do they respond to their e-mail? 
Questions on these lines could save you headaches in the future.

Q: What services does the ISP offer?
Some ISPs only offer the basic services, like e-mail, 1 megabyte storage space on their server, 
and a limited number of newsgroups to name a few. Others will let you design and post your own 
Web site and provide you with some software. Make sure that the ISP offers the services you are 
interested in and doesn't go overboard on services you couldn't care less about.

Q: Does the ISP offer a fast Internet connection?
Online time costs money. Why run the risk of extra charges or suffer the wait of slow downloads? 
In the end, faster connections enhance all your Internet activities. Also, faster Internet 



connections will enhance your experience on TEN!

These may seem like tough questions to ask, but you'll definitely find it worth it in the long run. If an 
ISP sales rep balks at answering some of these questions, well…

There are other Web sites you may want to investigate for more information on Internet service 
providers:

http://www.thelist.com Fairly comprehensive list of ISPs in the USA and International
http://www.hugelist.com Another large list of ISPs and Internet services
http://www.yahoo.com Check out Computer / Internet / Internet Access Providers



What is a UART and what kind do I need?
A chip known as a Universal Asynchronous Transmitter and Receiver (UART) is fundamental to serial
data communications. In short, this device converts parallel data (e.g., 8-bit bytes) into a serial data 
stream which can be transmitted over a telephone line.

So, what does that mean to you?

Internal modems are equipped with their own UARTs. External modems, however, utilize the UART 
incorporated into your computer's COM port. If you are using an external modem, it is essential that 
you understand what type of UART your COM port is using. If you use an internal modem, there's a 
good chance that the device will be equipped with a suitable UART. Nevertheless, you should check it
to confirm.

Older UARTs (8250 and 16450 UART) were typically designed before high-speed modems and 
simply do a poor job at high data rates. This means that the older UART will not give you a good 
performance from your external modem. Though your modem might connect at 28.8k bps, your 
computer and modem will talk at a slower speed. Since many of TEN's services are dependent on a 
high-speed connection, we require that you own a modem with a high-speed UART (16550 UART).



How do I tell what kind of UART I have?
Windows 95 will test your UART for you and let you know what kind you have. Follow these steps:

1. From the Start menu, select Settings --> Control Panel.

2. When the window opens, double-click on the Modems icon.

3. Choose the Diagnostics tab.

4. Click the line that shows your modem in the "installed" column.

5. Click the "More Info" button.

There'll be a line with the word UART on it. That will display your modem's UART.



Why can't I resize the Game Arena screen?
The Game Arena screen is set at a fixed size. If your resolution is set too low (640 x 480), the Game 
Arena will fill the entire screen and obscure the Windows task bar. Changing your resolution to 800 x 
600 or higher will make the Game Arena window smaller, allowing you access to the desktop and 
task bar.

Here's how to change your resolution:

1. From the Start menu, select Settings --> Control Panel.

2. When the window opens up, double-click the Display icon.

3. Click the Settings tab.

4. In the Desktop Area section, drag the indicator (the down-pointing arrow) to the 800 x 600 
selection.

5. Click OK. A dialog box will then appear that your computer must be restarted for the resolution 
change to take effect.

6. Click Yes. Your computer will then restart with the new screen resolution.

You can also switch between TEN and other open applications by hitting Alt–Tab. If you try this during
a hot and heavy game of Duke (or some other fast-action game), you'll be sorry. Not only will you get 
wasted on the battlefield, but you may crash the game.

Note: not all video cards support the 800 x 600 screen resolution. Check out the manual of your 
video card before attempting this switch.



Does TEN support international accounts?
That's a toughie. The answer is both "yes" and "no". A select handful of our free games (like Magic: 
The Gathering) that don't have tough latency requirements are more easily played outside the 
continental U.S. and Canada, but many of our fast-action games (like Quake) probably won't be 
playable from overseas.

If you're in Australia, we have a partnership with Multiplay (http://www.multiplay.com.au). 
Check there for the best Net games in Australia!

Finally, technical and customer support are only available within the continental U.S. and Canada.



I tried to create or join a game and I got a message that I 
need to close all other applications. What gives?
First rule of TEN: games are memory-chomping pigs. They suck up RAM and spit it out like rusty 
nails. Better if you exit all open applications before running TEN. If not, you may get a nasty-looking 
Mr. Bandwidth spouting some unmentionables in a dialog box.

CLOSE removes this dialog box and doesn't allow you to join or create. Selecting an application and 
hitting KILL makes that application beat a hasty retreat. Hope you weren't still working on that 
spreadsheet!



Send us a support question
If you've got a specific technical or billing question, you'll need to submit that question to us via our 
Web site. It's really easy and we'll get back to you in a jiffy once you submit the form. Here's how it 
works:

From within TEN, go to the Support menu and choose "Send Support Question Via Web" This will 
launch your Web browser and take you to our Web site where you can submit your question to us. 
We'll get right on it and return your request pronto. That's it!



Talk to us LIVE (Humans!)
Yes, there are humans on the other end of the phone if you need that personal touch. We are pretty 
good about responding to e-mail and faxes, so try those options first if you don't have a really, really 
urgent problem. Otherwise, move those fingers and punch us up:

Customer Support
Perfect for your billing queries, account questions, or any other TEN ponderings. If you're having 
problems creating a TEN account, we'll help you set it up!

Remember, technical questions must be directed to our Technical Support people through our Web 
site. You can submit a technical or billing question by going to the Support menu and choosing "Send 
Support Question Via Web"

· 1-800-8040-TEN
· 9 AM to 7 PM Pacific time

· 7 days a week



Talk to our machine (TENFONE)
If you've got a pretty basic question and don't feel the need to talk to us, try the TENFONE Automated
Voice Response System:

TENFONE (General and Technical information)
· 1-800-8040-TEN
· 24 hours a day

· 7 days a week



Zap us a fax
If you feel the urge, you can fire on over a fax. That's perfect if you have some funky problem you 
don't think you can explain properly. Just screen capture it, print it out and send it by:

· (415) 778-3514
· 24 hours a day

· 7 days a week



Surf our Web sites
Oh, baby. Do we got Web site support, or what!

General info and company stuff
If you want to find out more about TEN, its philosophies, employees and employment info, check out 
this site:
· www.ten.net

TEN's News
Want the latest scoop on what's going on at TEN or what wacky stuff is coming up? Check out the 
TEN News pages on our Web site. It's updated constantly and can be found from the Go menu by 
choosing "News@TEN Web Site". You can also click on the MORE NEWS button from the Game 
Selector screen.

TEN's DataSpheres
Our DataSpheres have superb info on the games we support: news and updates, upgrade 
information, rankings, custom levels and even some software. Yowsa! Go to 'em from the Go menu 
by choosing "DataSpheres Web Site".

TEN's File Factory
The File Factory  has truckloads of shareware games, upgrades and patches to popular software 
titles, user-created levels for Duke Nukem 3D and other games, as well as the tippy-top downloads 
on the Web. Keep yer shirt on! It's all there from the Go menu by choosing "File Factory Web Site".

TEN Customer Service
There's even a spot on the Web for referencing the Frequently Asked Questions (FAQ) list or to find 
out other cool support info. It's only a hop, skip and surf away! To get to the FAQ, pull down the 
Support menu and choose "FAQ Web Site." If you want the general support site, go to the Support 
menu and choose "Support Web Site".



Chat with TENguides
What are TENguides? Actually, the question should be who are TENguides. TENguides are friendly 
members of the TEN community that out of the goodness of their heart will try to assist you while 
you're connected to TEN. They're online greeters, jacks-of-all-trades. Identifiable by the word "Guide" 
in front of their name (e.g., GuideJoe, GuideBob, GuideGuido and so on).

If you're online and having difficulties with part of the system or the game you're playing, feel free to 
ask any TENguide in the vicinity for some help. They can generally be found skulking about Help 
Arenas or in the general chat areas of individual games.



I've got a general question
If you just have a basic question about the service or want some non-technical information about 
TEN, send off a mail to:
· customersupport@ten.net
Don't forget to include your TEN screen name with your question!



I've got a technical question
When you feel that urge to get techie and have the burning desire to know more about technical 
aspects of TEN, mail our gurus at:
· technicalsupport@ten.net
Your TEN screen name is important, so please include it along with your question.

You can also submit a detailed question through our Web form by pulling down the Support menu and
choosing "Send Support Question Via Web "This is the best way to contact us, but you can use the e-
mail address if you must.



What's the deal with my bill?
Think you're overcharged? Undercharged? Confused about the billing scheme of life? You might want
to check your billing report from the Support menu under "Display Billing Report...." But, if that don't 
work, send your questions to the professionals:
· billing@ten.net
If your social life is going to hell 'cause of TEN and you have to quit, check out the information on 
terminating your membership. And don't forget your TEN screen name!



I found a bug!
Well, you probably just ruined some TEN programmer's day, but we gotta know. Defects in the 
system must be eradicated! Send that offending insect (and how you found it) along with your 
computer and software information to:
· bugs@ten.net
We'll get straight on it! Fire us your TEN screen name with your report and we might make you 
famous!



I've got this great idea
Think you can design better than the designers? Feel that TEN is lacking in some features, or have a 
better way to implement some aspect of the service. All suggestions are highly encouraged. Type 'em
up and let us know at:
· suggestions@ten.net
Our design team gives you its heartfelt thanks. No cash, just thanks. Send us your TEN screen name 
for the credit you deserve.



You guys rule!
Omigod! If you think we're the best thing since the advent of the "X-Files," scented toilet paper or the 
solar-powered water weenie, give us a shout. Our egos can't be stroked enough.
· kudos@ten.net
Your TEN screen name is important, so don't forget to include it.



You guys suck!
This dusty, old mailbox sees little use, but we do check it once in a blue moon. If we really offended 
you in some way, keep it to yourself. No, seriously. Here's where to tell us:
· complaints@ten.net
We like to know who's got us on their hit list, so include your TEN screen name and we'll keep an eye
out for you!



How do I find out about my billing info?
You can check your billing info online (including changing billing rate plans) by going to the Support 
menu and choosing either "Display Billing Report..." (for your current bill status), "Change Payment 
Method..." (to change your credit card info) or "Change Address... " (to adjust your snail mail and e-
mail addresses).



Put a fork in me, I gotta cancel my TEN account
Think you've had enough, eh? Won't you reconsider? Oh well.

If you absolutely, positively have to cancel your TEN membership, just visit our Web site at 
http://www.ten.net/support and click the "How do I Cancel" link and we'll put a stop to all 
that nonsense. Your account will remain in dormancy for six months, after which your screen name 
will be released to the pool for anyone to fish out and use.

You can also cancel your account by mail. Just write our Customer Service people at:

Total Entertainment Network
P.O. Box 194447
San Francisco, CA    94119

We won't yell at you. Really. 



Lists the games you've played on TEN.



Displays the game's .exe or the game enabler TEN needs to run the game.



Displays the location of the game's .exe or game enabler.



Click this to search for the game's .exe or game enabler in other drives or in other folders.



Allows other TEN members to page and locate you.



Filters obscenities (on your computer only) that are typed in Arenas or in paging.



Clicking this displays Arena announcements whenever a TEN members enters or exits your current Arena.



Type your Arena entry announcement here. All TEN members (in the same Arena as you) will see this message when you enter that
Arena.



Type your Arena exit announcement here. All TEN members (in the same Arena as you) will see message when you exit that Arena.



Enables sound effects on TEN. When this box is selected, you will hear TEN-specific sounds for each particular event.



Lists all events on TEN that have a sound associated with them.



Plays the selected sound from the Events list.



Resets the sounds in the Events list to TEN's default sounds.



Displays the location of the sound for the selected Event.



Click this to search for the TEN sound or an alternate sound on other drives or in other folders.



Uses your selected Web browser to read your TEN e-mail.



Uses a mail reader other than your Web browser to read your TEN e-mail.



Lists the location of the mail reader you will be using to read and send e-mail from your TEN account.



Describes how to set up your mail reader to access your TEN mail account.



Downloads Eudora Light, a mail program, that you can use to read and send e-mail from your TEN account.



Click this to search on other drives or in other folders for the mail reader you want to use.



Enables your specified mail reader to access your TEN e-mail account.



Determines the frequency in which your mail reader checks your TEN e-mail account for new mail.



Uses your selected Web browser to read TEN-specific newsgroups.



Uses a news reader other than your selected Web browser to read TEN-specific newsgroups.



Displays the location of the news reader you will be using to access TEN-specific newsgroups from within TEN.



Describes how to set up your news reader to read TEN-specific newsgroups from within TEN.



Click this to search on other drives or in other folders for the news reader you want to use.



Selects Netscape Navigator as your default Web browser through which you will view Web links from within TEN.



Displays the location of Netscape Navigator on your hard drive.



Downloads Netscape Navigator.



Click this to search on other drives or in other folders for Netscape Navigator.



Selects Internet Explorer as your default Web browser through which you will view Web links from within TEN.



Lists all the TEN members you currently have muzzled. Anyone who appears in the Muzzle List cannot page you or join any games 
you create. You will also not see any chat text from them in an Arena.



Removes someone from your Muzzle List, restoring their ability to page you and join games you create. You will also be able to see 
any chat text from them in an Arena.



Displays your current billing report.



Click this to close this dialog box.



Provides a space for you to type your screen name. This is your alias on TEN.



Provides a space for you to type your password. For security, asterisks will appear as you type.



Closes the Sign On screen and connects you to TEN.



Get more detailed help about the Sign On screen.



Determines how you will connect to TEN.

You can either choose one of TEN's local access numbers or use your direct Internet connection.



Begins the new user registration process. Click here if you are new to TEN and want to set up an account.



Takes you back to the Chat Arena Selector screen.



Launches your specified mail reader. Click this to read and send e-mail from your TEN account.



Opens the TEN pager, allowing you to chat privately with another TEN member.



Launches your specified Web browser and displays a list of TEN's DataSpheres. From there, you can get files, strategies, rankings, 
news and more for TEN-supported games.



Lists all the TEN members currently in this Arena. The icon to the left of each name indicates their current status. Double-click on a 
name to get that member's profile. Right-click on a name to page, muzzle or whisper.



Displays the chat text in this Arena.



Type your chat text here.



Click this to send your chat text. You can also select the Enter key on your keyboard to send the text.



Launches your specified mail reader. Click this to read and send e-mail from your TEN account.



Opens the TEN pager, allowing you to chat privately with another TEN member.



Lists all the TEN members currently in this Arena. The icon to the left of each name indicates their current status. Double-click on a 
name to get that member's profile. Right-click on a name to page, muzzle or whisper.



Displays the chat text in this Arena.



Type your chat text here.



Click this to send your chat text. You can also select the Enter key on your keyboard to send the text.



Takes you back to the Dark Sun Arena Selector screen.



Click this to enter and play Dark Sun: Crimson Sands.



Signs you off and exits TEN.



Closes this dialog box without making any changes to your connection to TEN.



Displays information about this game.



Click this to launch the game you created. This button will blink when the set maximum number of players have joined your game.



Click this to destroy the game you created.



Click this to minimize or maximize the Pre-launch Panel.



Select a player's name in the Who's Joined list and click this button to dismiss this player from your game.



Lists all the players who have joined your game. The icon to the left of each name indicates their current latency. Double-click on a 
name to get that member's profile. Right-click on    a name to page, muzzle or whisper.



Displays the settings and description for this game.



Displays chat text. The creator of this game and the players who joined are the only ones who can see this text.



Type your chat text here.



Click this to send your chat text. You can also select the Enter key on your keyboard to send the text.



Takes you back to the Arena Selector for this game.



Launches your specified mail program. Click this to read and send e-mail from your TEN account.



Opens the TEN pager, allowing you to chat privately with another TEN member.



Launches your specified Web browser and displays this game's DataSphere. From there, you can get files, strategies, rankings, 
news and more for this TEN-supported game.



Lists all the players currently in this Arena. The icon to the left of each name indicates their current status. Double-click on a name to
get that member's profile. Right-click on a name to page, muzzle or whisper.



Displays chat text in this Arena.



Type your chat text here.



Click this to send your chat text. You can also hit the Enter key on your keyboard to send the text.



Click this to get Mr. Bandwidth's report on your connection to TEN.



Displays a list of games being created or already in action in this Game Arena.



Click this to create a game.



Select a game that appears in the Games list above and click this button to join it.



Lists all the players waiting or playing in the game that is highlighted in the Games list.



Displays the settings and description for the game that is highlighted in the Games list.



The game you can play in this Arena.



Closes this dialog box.



Selects Visa as the type of credit card you will be using.



Selects MasterCard as the type of credit card you will be using.



Selects Discover as the type of credit card you will be using.



Selects American Express as the type of credit card you will be using.



Provides a space for you to type in your credit card number.



Provides a space for you to type in your credit card's expiration date.



Provides a space for you to type in your full name.

You must type in your name AS IT APPEARS ON YOUR CREDIT CARD.



Provides a space for you to type in the first line of your billing address.



Provides a space for you to type in the second line of your billing address.



Provides a space for you to type in your city.



Provides a space for you to type in your state or province.



Provides a space for you to type in your zip code.



Provides a space for you to type or select your country.



Click this to save the information above and close this dialog box.



Click this to delete and cancel all the information above and close this dialog box.



Displays information about TEN's current billing policy.



Click this to close this dialog box.



Displays TEN's current billing terms.



Click this to close this dialog box.



Click this to delete all information and cancel TEN's new user registration.



Click this to go back to TEN's new user registration.



Provides a space for you to enter your current password.



Provides a space for you to enter your new password.



Provides a space for you to confirm the new password you have just typed above.



Click this to save your password change and close this dialog box.



Click this to cancel your password change and close this dialog box.



Type or select a modem to use when you connect to TEN.



Click this to save your modem selection and close this dialog box.



Select this to connect to TEN via modem. You will be prompted to select a TEN local access number close to your location.



Select this to connect to TEN via an existing Internet connection.



Select this to connect to TEN via modem. You will be prompted to select a TEN local access number close to your location.



Click this to save your connection settings and close this dialog box.



Click this to cancel any change and close this dialog box.



Get more detailed help on what is the best way to connect to TEN.



Type in your area code. The list box below will automatically scroll to the local access numbers that use the same area code.



Select the closest local access number to your location. Your modem will dial the selected number to connect you to TEN.



Get more detailed help on selecting a local access number.



Click this to save your selection and close this dialog box.



Click this to cancel any selection you made and close this dialog box.



Provides space for you to type in your comments to TEN.



Check this if you would like TEN to send you an e-mail reply concerning your comments.



Provides space for you to type in your e-mail address.



Check this if you would like to send your system profile along with your comments to TEN.



Click this to send your comments or feedback to TEN.



Click this to delete your comments and close this dialog box.



Select your computer's operating system.



Click this to download the game enabler appropriate for your operating system.



You already have this game enabler. Click to help TEN locate it on your computer.



Click this to abort this process and close this dialog box.



Launches your specified mail reader. Click this to read and send e-mail from your TEN account.



Opens the TEN pager, allowing you to chat privately with another TEN member.



Launches your specified Web browser and displays a list of the TEN DataSpheres. From here, you can get files, strategies, 
rankings, news and more for TEN-supported games.



List of games available to play on TEN.



Click this to go the Arena Selector for the game highlighted above.



Enter a name for your game.



Select or type the maximum number of players you want in this game.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Click this to select advanced options for the game you are creating.



Creates the game and closes this dialog box.



Aborts the game creation process.



Check this box to select a custom user map for this game. Uncheck this box to turn off the user maps option.



Select a custom user map from this drop down list.



Get detailed help on using custom user maps on TEN.



Click this to accept the above options.



Click this to cancel the above options.



Enter a name for your Command & Conquer game.



Select a scenario (or map) from this drop down list.



Select your forces (either NOD or GDI).



Select or type the maximum number of players you want in this game.



Sets the starting cash for all players.



The starting cash for all players.



Select the number of units each player starts with.



The number of units each player starts with.



Selects the tech level of the game. More advanced units can only be built at higher tech levels.



The tech level of the game. More advanced units can only be built at higher tech levels.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Check to turn bases on, uncheck to turn them off. Without bases, no new units can be built. The default is on.



Check to turn random prize crates on, uncheck to turn them off. The default is off.



Check to turn on the "Capture the Flag" variant, uncheck to turn it off. The default is off.



Controls whether tiberium regrows over time. Check to turn it on, uncheck to turn it off. The default is on.



Controls whether computer players are in the game. Check to turn them on, uncheck to turn them off. The default is off.



Get more detailed help about the Command & Conquer create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a name for your Quake game.



Select or type the maximum number of players you want in this game.



Select an episode from this drop down list.



Select a level from this drop down list.



Check to turn on "No Joystick." Slightly enhances gameplay.



Select the number of frags the game can have (before the level ends).



The number of frags the game can have (before the level ends).



Select a time limit for the game in minutes (before the level ends).



The time limit for the game (before the level ends).



Controls the number of data packets sent per second. Slower connections may get more consistent gameplay at lower "server 
speeds." This does not control the CPU speed or bandwidth.



Displays the server speed.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Players with the same color pants cannot hurt each other.



Players can kill others with the same color pants and lose one frag.



Selecting this option turns off the exit from the level.



Check to allow monsters in the game. Players will respawn at the entrance of the level.



Check to play without monsters. Players will respawn at random respawn locations.



Set the quantity and nastiness of the monsters.



Select your shirt color from this drop down list.



Select your pants color from this drop down list.



Select a server mod (modification) for your game. You may be required to have the files for some of the mods on your hard drive.



Description of the server mod selected above.



Type in valid command line parameter(s) to alter various gameplay settings.



Get more detailed help about the Quake create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a name for your game.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Select or type the maximum number of players you want in this game.



Check this box to make your game password protected.



Enter the password for your game here. Only players who type in the same password can join your game.



Get more detailed help about the Diablo create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a name for your Diablo game.



Enter a name for your Red Alert game.



Select a scenario (or map) from this drop down list.



Select your forces (either Soviet or Allied).



Select or type the maximum number of players you want in this game.



Check if you are playing Red Alert for Windows.



Check if you are playing Red Alert for DOS.



Sets the starting cash for all players.



The starting cash for all players.



Select the number of units each player starts with.



The number of units each player starts with.



Selects the tech level of the game. More advanced units can only be built at higher tech levels.



The tech level of the game. More advanced units can only be built at higher tech levels.



Controls whether computer players are in the game. The default is off.



Shows whether computer players are in the game.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Check to turn bases on, uncheck to turn them off. Without bases, no new units can be built. The default is on.



Controls whether tiberium regrows over time. Check to turn it on, uncheck to turn it off. The default is on.



Check to turn random prize crates on, uncheck to turn them off. The default is off.



The mysterious Shroud!



Check to turn on the "Capture the Flag" variant, uncheck to turn it off. The default is off.



Get more detailed help about the Red Alert create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Information about hardware requirements needed to play this game.



Closes this dialog box.



This indicates how quick you can send and receive data (your latency). If you have a low reading here, you'll probably be 
experiencing more "lag" than usual.



Stability is how clean your connection is to the Internet. The higher the percentage is on this scale, the more scrubbed down your 
connection is and the less spikes you will receive that break up your game.



Maximum players is the largest number of players that can be in a game with you (including yourself).



Get more detailed help about Diagnostics.



Closes this dialog box.



Launches your specified mail reader. Click this to read and send e-mail from your TEN account.



Opens the TEN pager, allowing you to chat privately with another TEN member.



Launches your specified Web browser and displays this game's DataSphere. From here, you can get files, strategies, rankings, 
news and more from this TEN-supported game.



List of all the Game Arenas and the different Zones and categories that they fall under.



Shows information about the selected Zone or Game Arena highlighted above.



Takes you to the selected Game Arena highlighted above.



Takes you back to the Games List.



Indicates your status for playing games on TEN.



This colored bar relates to your connection quality. If your average latency falls (without spikes) within the green area, you’ve got an 
Excellent connection.



This graph shows your latency over the past few minutes. In general, the lower it is on the graph, the better.



Zoom into the latency graph.



Zoom out of the latency graph.



Get more detailed help about Latency History.



Closes this dialog box.



Mr. B’s words of advice, telling you how many people can be involved in a game you create or join (this number includes you, by the
way).



Your rating for each of the Zones on TEN.



Click to take a look at your Latency History.



Click to take a look at your Diagnostic Information.



Get more detailed help about the Latency Report.



Closes this dialog box.



Shows the location of the TEN member you tried to find.



Closes this dialog box.



Closes this dialog box and cancels TEN's new user registration, returning you to the Sign On screen.



Closes this dialog box without affecting TEN's new user registration.



Displays TEN's Terms of Service which must be accepted to create an account on TEN.



Accepts TEN's Terms of Service and allows you to continue through TEN's new user registration.



Declines TEN's Terms of Service and cancels TEN's new user registration.



Shows the name assigned to your race.



Shows whether this Arena is in Arcade or Simulation driving mode.



Shows your rank at the track you have selected.



Select to go through Practice, Qualify and Warmup rounds.



Select to skip preliminary rounds and jump straight to a race.



Selects the Track where you want to race.



Selects the amount, from 1% to 100%, of the actual event distance.



Sets the length of time between the Qualify and Race sessions.



Allows you to set the weather for the race.



Makes the weather be randomly selected for this race.



Sets the air temperature at the track.



Sets the wind speed at the track.



Sets the wind direction at the track.



Select to turn the yellow flags on.



Select to choose a night race on certain tracks.



Select to turn on the opening pace lap.



Select to turn on random player breakdowns.



Turns car damage off.



Turns car damage on.



Sets damage to Arcade mode.



Sets the minimum number of racers required to start a race.



Sets the maximum number of drivers allowed in a race.



Sets the minimum skill level allowed to join this race.



Sets the maximum skill level allowed to join this race.



Closes this dialog box, saving any changes you have made, and creates a race.



Closes this dialog box without saving any changes you have made, and does not create a race.



Sets the length of the race practice session.



Displays a list of all races being created or in progress. 



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made.



Displays the screen names of the TEN members that have joined this race.



Displays instructions for setting up a new TEN account.



Click this to read and accept TEN's Terms of Service



Click this to Enter your Name and Address.



Click this to Select a Billing Rate Plan and payment method.



Click this to Create a Screen Name and password.



After completing all four steps, click this to complete the registration process and proceed to TEN's Sign On screen.



Closes this dialog box and cancels TEN's new user registration.



Displays the screen name of the TEN member you want to locate. To select another TEN member to locate, choose one from this 
drop down list or type in a new screen name.



Closes this dialog box and returns the location of the requested TEN member.



Closes this dialog box without attempting to locate anyone.



Displays the screen name of the TEN member you want to page, locate or view the profile of. To select another TEN member, 
choose someone from this drop down list or type in a new screen name.



Closes this dialog box and executes your page, locate or profile request.



Closes this dialog box without doing anything.



Provides a space for you to type in your first name.



Provides a space for you to type in your middle initial.



Provides a space for you to type in your last name.



Provides a space for you to type in your street address.



Provides additional space for you to type in your address.



Provides a space for you to type the state you live in.



Provides a space for you to type in your zip code.



Lists countries for you to choose from to complete your address.



Provides a space for you to type in your daytime area code.



Provides a space for you to type in your daytime phone number.



Provides a space for you to type in your evening area code.



Provides a space for you to type in your evening phone number.



Provides a space for you to type in your electronic mail address.



Closes this dialog box, saving any changes you have made.



Closes this dialog box without saving any changes you have made.



Displays TEN's new user registration instructions.



Specifies that you want to use TEN's toll-free registration number to set up your account online.



Specifies that you want to use your existing Internet connection to set up your account online.



Get more detailed help about TEN's new user registration process.



Closes this dialog box without saving any changes you have made.



Closes this dialog box and saves any changes you have made, taking you to the next step in new user registration.



Provides a space for you to type in the URL you want to view.



Launches your specified Web browser and opens up your chosen URL.



Closes this dialog box without launching a Web browser.



Displays any pages you currently have active.



Click this to initiate a new page.



Click this to dismiss a TEN member from your active pages, and end that specific page.



Displays the chat text for the current page.



Provides a space for you to type your chat text.



Sends your chat text to the chat area for both TEN members in this page to see.



Closes the dialog box and ends all active pages.



Provides a space for you to type your screen name.

It must be between 3 and 10 characters and can only contain letters, numbers, hyphens and underscores.



Provides a space for you to type your password.

It must be between 6 and 10 characters. And, remember that it is case-sensitive. For security, asterisks will appear as you type your 
password.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made.



Displays instructions from Mr. Bandwidth on how to close applications in the list below before you can play a game.



Displays a list of applications currently running that must be closed before you can play a game.



Get more detailed help about this dialog box.



Closes this dialog box without closing any of the applications listed.



Closes the above applications, enabling you to play a game.



Displays the screen name of this TEN member.



Click this to display this member's profile information below.



Click this to display this member's ranking information below.



Displays this member's profile or ranking information.



Click this to edit your profile information.



Closes this dialog box, saving any changes you have made.



Specifies whether you have this person muzzled. Click this box to turn muzzling on or off.



Provides a space for you to type in an Alias for other members to see when they view your profile.



Provides a space for you to type in the geographic Location where you're playing on TEN.



Provides a space for you to type in your Birthday.



Provides a space for you to type in your Gender.



Provides a space for you to type in your Relationship Status.



Provides a space for you to type in your Favorite URL.



Provides a space for you to type in any Miscellaneous information about yourself.



Closes this dialog box, saving any changes you have made.



Closes this dialog box without saving any changes you have made.



Provides a space for you to type in the screen name of the TEN member whose profile you want to view.



Closes this dialog box and opens the profile for this TEN member.



Closes this dialog box without opening a member profile.



Specifies the game for which you'd like to view rankings.



Displays the rankings for the specified game for everyone in the current Game Arena or Chat Arena.



Displays your rankings (plus or minus) 10 players.



Displays the rankings for the specified number of players, sorted by game-specific options.



Displays the rankings for the specified number of players, sorted by game-specific options.



Displays the rankings for the specified number of players, sorted by game-specific options.



Displays the rankings for the players specified in the space below.



Displays the rankings for the specified players in a victory matrix.

The victory matrix is a table showing the selected players and how many times they've killed each other. If you only select one 
person for a victory matrix, it will show you all the other players they've killed.



Provides a space for you to type in the screen names of the players whose rankings you want to view (separate screen names with 
commas).



Closes this dialog box, and inputs your ranking requests to TEN.



Closes this dialog box without checking any ranking information.



Displays the rankings you requested in the ranking selector.



Closes this dialog box.



Displays your rate plan for the current billing cycle.



Displays your rate plan for the next billing cycle.

If you change your rate plan, and return to this dialog box, the change will be reflected here.



Displays the currently available rate plans.



Displays the details of the available rate plans. Please read these carefully.



Closes this dialog box, saving any changes you have made.



Closes this dialog box without saving any changes you have made.



Describes the selected rate plan.



Click this to display TEN's Billing Policy to get more information before selecting a rate plan.



Displays the currently selected rate plan.



Provides a space for you to type in your new screen name.

Screen names must be between 3 and 10 characters.



Provides a space for you to type in your password.

Passwords must be between 6 and 10 characters. And remember that your password is case-sensitive. For security, asterisks will 
appear as you type your password.



Provides a space for you to retype your password for confirmation.



Get more detailed help about this dialog box.



Creates your new screen name and password, closing this dialog box.



Displays all files available to download, categorized by file type.



Displays information about the selected file, including where you should save it and how long the download will take.



Click this to download the selected file.



Closes this dialog box without downloading any other files.



Takes you to the Game Selector screen.



Launches your specified Web browser and shoots you to the News@TEN Web site. Here you can read the latest news about TEN 
and view a calendar of upcoming events.



Displays the most recent headlines for stories on the News@TEN Web site.



Allows you to get instant pop-up help on the next screen item you click.



Allows you to get instant pop-up help on the next screen item you click.



Allows you to get instant pop-up help on the next screen item you click.



Allows you to get instant pop-up help on the next screen item you click.



Launches your specified Web browser and displays the Dark Sun: Crimson Sands DataSphere. From here, you can get files, news 
and more about Dark Sun: Crimson Sands.



Allows you to get instant pop-up help on the next screen item you click.



It's the name of the game. Fantabulous!



It's the lovable Mr. Bandwidth! Click his head to pull up your Connection Report.

Below is your Connection Rating: Excellent, Good, OK or Forget It. When you first enter an Arena, Mr. B will throw up a progress 
indicator while he does his little check.



It's the lovable Mr. Bandwidth! Click his head to pull up your Connection Report.

Below is your Connection Rating: Excellent, Good, OK or Forget It. When you first enter an Arena, Mr. B will throw up a progress 
indicator while he does his little check.



It's the lovable Mr. Bandwidth! Click his head to pull up your Connection Report.

Below is your Connection Rating: Excellent, Good, OK or Forget It. When you first enter an Arena, Mr. B will throw up a progress 
indicator while he does his little check.



Enter a name for your Blood game.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Select the maximum number of players you want in this game.



Select the maximum number of players you want in this game.



Check to make this game a ranked game. Scores from this game will affect your Blood ranking.



Select a Game Type from this drop down list.



Select an Episode from this drop down list.



Select a Level from this drop down list.



Select the Difficulty of monsters from this drop down list. If you have Monsters set to "None", this option does nothing.



Select the frequency of Monsters from this drop down list.



Select how Weapons are respawned from this drop down list.



Select how Items (other than weapons) are respawned from this drop down list.



Check this box to use a custom User Map for this game.



Select a custom User Map from this drop down list. User maps must be on your hard drive in your Blood directory.



Get more detailed help about the Blood create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a name for your Shadow Warrior game. 



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Check to make this game a ranked game. Scores from this game will affect your Shadow Warrior ranking. 



Check to display Markers for items that have been recently grabbed. 



Check to enable Team Play mode. 



Check to allow teammates to be hurt by stray shots (only available when Team Play or Cooperative mode are selected). 



Check to allow players to use the Nuke weapon. 



Check this box to use a custom User Map for this game. 



Select a custom User Map from this drop down list. User maps must be on your hard drive in your Shadow Warrior directory. 



Select a Level from this drop down list. 



Select a Game Type from this drop down list. 



Select whether Monsters are enabled (and their ferocity) from this drop down list. 



Select a Color for your ninja from this drop down list. 



Select the maximum number of players you want in this game. 



Select the maximum number of players you want in this game. 



Select the Kill Limit you want for this game. 



Select the Kill Limit you want for this game. 



Select the Time Limit you want for this game. 



Select the Time Limit you want for this game. 



Get more detailed help about the Shadow Warrior create game dialog box. 



Creates the game and closes this dialog box. 



Aborts the game creation process. 



Enter a name for your EF2000 V2.0 game. 



Select the maximum number of players you want in this game. 



Select the maximum number of players you want in this game. 



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Check to make your game password protected. 



Enter the password for your game here. Only players who type in the same password can join your game. 



Get more detailed help about the EF2000 V2.0 create game dialog box. 



Creates the game and closes this dialog box. 



Aborts the game creation process. 



Launches your specified mail reader. Click this to read and send e-mail from your TEN account. 



Opens the TEN pager, allowing you to chat privately with another TEN member. 



Lists all the TEN members currently in this Arena. The icon to the left of each name indicates their current status. Double-click on a 
name to get that member's profile. Right-click on a name to page, muzzle or whisper. 



Displays the chat text in this Arena. 



Type your chat text here. 



Click this to send your chat text. You can also select the Enter key on your keyboard to send the text. 



Takes you back to the Twilight Lands Arena Selector screen. 



Click this to enter and play Twilight Lands. 



Allows you to get instant pop-up help on the next screen item you click. 



Launches your specified Web browser and displays this game's DataSphere. From there, you can get files, strategies, rankings, 
news and more for this TEN-supported game.



Enter a name for your Total Annihilation game.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Select the maximum number of players you want in this game.



Select the maximum number of players you want in this game.



Select the starting amount of Metal you want for this game.



Select the starting amount of Metal you want for this game.



Select the starting amount of Energy you want for this game.



Select the starting amount of Energy you want for this game.



Select the Map you want to play in this game from this drop down list (remember, some maps require your computer to have 32 or 
more MB of RAM).



Select your Dead Commander result from this drop down list.



Select your starting Location option from this drop down list.



Select the Line of Sight option for this game from this drop down list.



Select your Mapping option from this drop down list.



Check to make your game password protected.



Enter the password for your game here. Only players who type in the same password can join your game.



Get more detailed help about the Total Annihilation create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a name for your Myth game.



Enter a description of your game here. Be very specific in what map and scenario you want to play so people know what type of 
game you plan to set up.



Select the maximum number of players you want in this game.



Select the maximum number of players you want in this game.



Select the color scheme you want for your Coat of Arms.



Enter the password for your game here. Only players who type in the same password can join your game.



Check to make your game password protected.



Enter the name for your team here.



Select the primary color for your team.



Select the secondary color for your team.



Get more detailed help about the Myth create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Enter a name for your Wiz-War game.



Enter a description of your game (e.g., "10-minute game" or "Newbies Only").



Select the maximum number of players you want in this game.



Select the maximum number of players you want in this game.



Select the maximum amount of time you want players to have to make their turn.



Check to make this game a ranked game. Scores from this game will affect your Wiz-War ranking.



Check to allow people to observe your game without actually playing.



Check to allow people to join your game after you have launched it.



Check to allow people to join your game as an observer.



Get more detailed help about the Wiz-War create game dialog box.



Creates the game and closes this dialog box.



Aborts the game creation process.



Launches your specified mail reader. Click this to read and send e-mail from your TEN account.



Opens the TEN pager, allowing you to chat privately with another TEN member.



Lists all the TEN members currently in this Arena. The icon to the left of each name indicates their current status. Double-click on
a name to get that member's profile. Right-click on a name to page, muzzle or whisper.



Displays the chat text in this Arena.



Type your chat text here.



Click this to send your chat text. You can also select the Enter key on your keyboard to send the text.



Takes you back to the Magic: The Gathering Arena Selector screen.



Click this to launch ManaLink and play Magic: The Gathering.



Allows you to get instant pop-up help on the next screen item you click.



Launches your specified Web browser and displays this game's DataSphere. From there, you can get files, strategies, rankings, 
news and more for this TEN-supported game.



Click this button to watch this game in progress.




